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1 About This User Manual

1.1 APEX Il Systems for Chemical
Crystallography

Bruker AXS Kappa APEX Il and SMART APEX
Il systems are the newest members in the
Bruker AXS product line of instrumentation for
single crystal X-ray diffraction. These systems
provide the tools for complete small molecule
structure determination.

The APEX2 software features a redesigned
start-to-finish graphical user interface (GUI)
along with the optional Phase ID and
AutoStructure software modules. The Auto-
Structure module simplifies structure determina-
tion more than ever before.

The hardware features the APEX Il CCD
detector (with four-port readout of a 4096x4096
CCD chip), radiation safety enclosure system,
and a choice of two goniometers.

The Kappa APEX Il system features the Kappa
4-axis goniometer.

The SMART APEX Il system is an enhanced
version of the SMART APEX fixed-chi system.

This User Manual and associated YLID test data
are intended to provide you with a step-by-step
guide to data collection and processing using
the APEX2 software program.

The test data supplied was collected on a
Kappa APEX Il diffractometer with graphite-
monochromated molybdenum radiation from a
sealed tube generator. The high-quality (0.75 A
resolution) data allows easy refinement of the
hydrogen atom positions and determination of
the absolute structure of the crystal.
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1.2 Terms and Conventions Used
in this User Manual

Before using this User Manual, it is important to
understand the terms and typographical con-
ventions used. Certain kinds of formatting in the
User Manual’s text are used to identify special
kinds of information.

1.2.1 Typographical Conventions

Table 1.1 shows typographical conventions used
to help you quickly locate and identify informa-
tion in this User Manual.

Convention Usage

Software interface elements (such as
icons, menu items, and buttons) to be

boldface selected as part of the current proce-
dure.
. New terms and words requiring
italics )
emphasis.
Information read from or entered into a
monospace

command prompt.

Navigation through a hierarchical
menu. For example, “Select Start >
Programs > Bruker AXS > APEX2”
describes navigating Windows’ menus
from Start to Programs to Bruker
AXS to APEX2.

[square brackets] | Keyboard input.

Table 1.1 — Typographical conventions

1.2.2 Equivalent Terms

Frame/lmage

In this User Manual, the terms “frame” and
“‘image” are used interchangeably to describe
two-dimensional X-ray data, whether read from
the CCD camera or generated within APEX2.

Greek and Roman Text

This User Manual uses scientific terminology
that may be rendered in Greek text. However,
this User Manual follows a convention of using
Roman text to the greatest extent possible.

20 2-theta
64 thetatl
07 theta2
® omega
[0} phi

X chi

Y gamma

Table 1.2 — Greek and Roman text
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1.2.3 Warnings, Cautions, and Notes

This User Manual contains notices that you
must observe to ensure your own personal
safety, as well as to protect the product and con-
nected equipment. These notices are high-
lighted in the User Manual by a warning triangle
and are marked as follows according to the level
of danger.

The word “WARNING” alerts the reader to an
immediate or potential hazard that can result in
death, severe personal injury, or substantial
property damage.

The word “CAUTION?” alerts the reader to a
potential practice or condition that could result in
minor personal injury or damage to the product
or property.

NOTE: The word “NOTE” in bold capital letters
draws your attention to particularly
important information on the product or
handling of the product, or to a particular
part of the product documentation.

1.3 Referenced Documentation

Table 1.3 contains a list of documentation refer-
enced in this User Manual. It is recommended to
have this additional documentation available as
you work with this User Manual.

Documentation

Part Number LD

269-0175xx SAINT Software Reference
Manual

M86-Exx024 Mllcroscope Focus and Sample
Alignment

MB86-Exx043 BCP and BIS Installation Notes

M86-Exx045 RLATT User Manual

M86-Exx087 APEX2 gnd PROTEUM2
Installation Notes

M86-Exx092 User Manager User Manual

M88-Exx099 License Manager User Manual

Table 1.3 — Referenced Documentation
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1.4 X-ray Safety

X-ray equipment produces potentially harmful
radiation and can be dangerous to anyone in the
equipment’s vicinity unless safety precautions
are completely understood and implemented. All
persons designated to operate or perform
maintenance on this instrument need to be fully
trained on the nature of radiation, X-ray
generating equipment, and radiation safety. All
users of the X-ray equipment are required to
accurately monitor their exposure to X-rays by
proper use of X-ray dosimeters.

For safety issues related to operation and main-
tenance of your particular X-ray generator, dif-
fractometer, and shield enclosure, please refer
to the manufacturer’s operation manuals or to
your Radiation Safety Officer. The user is
responsible for compliance with local safety reg-
ulations.

1.5 APEX2 Help and Technical
Support

1.5.1 The “What’s This?” Function

Context-based help is available at any time
within APEX2 by simply clicking the “What’s
This?” icon:

L
Figure 1.1 — “What's This?” icon
After clicking the icon, click any window, control,

or field within APEX2 to obtain detailed help in a
pop-up window.
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1.5.2 Technical Support

Users are invited to contact Bruker AXS whenever there are problems or questions related to the sys-
tem. Before contacting Bruker AXS, please:

e [f there is a software problem, determine the version of the program.
* Record any error messages.

e Determine conditions and steps that recreate the problem.

If the instrument is in North America, contact our North American Service Center:

Bruker AXS Inc Phone No: +1 (608) 276-3087

Customer Support Toll-free: 1 (800) 234-9729

5465 E Cheryl Pkwy Fax No: +1 (608) 276-3015

Madison, WI 53711-5373 E-mail: Customer.Service @ bruker-axs.com
U.S.A. Internet: www.bruker-axs.com

If the instrument is outside North America, contact your local Bruker AXS Service Center.
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2 Hardware Overview

APEX Il systems share common hardware com-
ponents with other Bruker AXS products. Other
members of this new generation of instruments
include the D8 ADVANCE, D8 DISCOVER, and
D8 GADDS systems for general diffraction. Doc-
umentation on some of these common hard-
ware and software components is available in
the User Manuals for the D8 family of instru-
ments.

The two hardware platforms for the APEX |l sys-
tems are the Kappa APEX Il (the four-axis
advanced research instrument) and the SMART
APEX Il (the three-axis laboratory instrument).
Software functionality is essentially the same for
both platforms.

21 System Components

The system (Figure 2.1 and Figure 2.2) consists
of the following basic components.

e APEX Il CCD detector
e 4-axis Kappa or 3-axis SMART goniometer
¢ K780 X-ray generator

* Radiation safety enclosure with interlocks
and warning lights

¢ D8 controller
* Refrigerated recirculator for the detector

e Instrument control (BIS) and crystallo-
graphic software (APEX2) computer

¢ Video microscope

e Optional Accessories (low- and high-
temperature devices)

M86-E01078
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Single Computer

For both SMART APEX Il and Kappa APEX Il systems, this
external computer runs BIS, APEX2Server and APEX2,
combining Client and Server functionality into a single computer.

L

TCP/IP hub TCP/IP hub
[THI 1 [THI 1
APEX I APEX I
| — CCD Detector CCD Detector
7
Kappa D85
Goniometer Goniometer
(4-axis) (3-axis)
= - : s - :
Detector v | Detector T |
Power Supply B | | ! Power Supply B | | !
e = e
........... lz=z=zz=zzzzzz22 ————=======,|z===z=z=zz=zzz:z:2
I [l ! . . I " !
| Generator 11 i Refrigerated Refrigerated | Generator 11 i
' N ! Recirculator Recirculator ' N !
i T ' : i '
------------ | 1 ————————————, 1
____________ ! i I i
| :E D8 Controller | | ' D8 Controller |
| i : : H :
! N ' ! N '
| 1 : | § :
e 4 | i e 4 | i
J ] J ]
Figure 2.1 — Kappa APEX Il system Figure 2.2 — SMART APEX Il system
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2.1.1 APEX Il Detector

The APEX Il detector is specific to this system.
Status lamps on the top of the detector housing
indicate when the detector is on (green) and off
(red).

On Kappa APEX Il systems, the detector is
mounted on a motorized DX track. The camera
distance is computer-controlled (a typical dis-
tance for the camera is 60 mm).

On SMART APEX Il systems, the detector is
mounted on a DX dovetail track. The track has a
scale that is calibrated in mm to indicate the dis-
tance from the crystal to the detector face (a typ-
ical distance is 60 mm). The detector distance
has to be changed manually.

An optional motorized DX track is available for
the SMART APEX II.

2.1.2 Goniometer

The goniometer module and APEX Il detector
make up the unique hardware of the system.
This is the part of the instrument that actually
performs the experiment.

Several components make up the goniometer
module with APEX Il detector:

* Goniometer (3-axis or 4-axis)
* APEX Il detector

*  X-ray source (including shielded X-ray tube,
X-ray safety shutter, and graphite crystal
monochromator)

e K780 X-ray generator

Timing shutter and incident beam collimator
(with beamstop)

e Video microscope
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Kappa APEX Il Goniometer

The Kappa APEX Il system uses a horizontally-
oriented Kappa goniometer with 2-theta,
omega, kappa and phi drives and a motorized
DX track for setting the detector distance. It
includes mounting points for the video micro-
scope and for optional attachments such as the
optional low-temperature attachment.

Timing  |peigent  Beamstop
Shutter  goom
Safety Collimator Goniometer
Sealed X-ray  gputier
Tube

1 APEX I
Detector

Monochromator

Kappa
Goniometer

Figure 2.3 — Kappa 4-axis goniometer components

With the kappa angle, the crystal can be ori-
ented at chi from -92° to 92°. This leaves the top
of the instrument open for easy access. Kappa
can be positioned so that the phi drive, which
has unlimited rotation, can be swung under the
incident beam collimator, allowing free rotation
in omega.
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SMART APEX Il Goniometer

The SMART APEX Il system uses a
horizontally-oriented D8 goniometer base with
2-theta, omega and phi drives, dovetail tracks
for the X-ray source and detector, and an addi-
tional mounting ring for accessories such as the
video microscope and optional low-temperature
attachment.

The 3-axis system incorporates a fixed-chi
stage with a chi angle of approximately 54.74°
and a phi drive with 360° rotation, which is so
compact that it swings under the incident beam
collimator, allowing free rotation in omega.

Beamsto

P Rotary Shutter
IncidentBeam  and Attenuator

Collimator Assembly Safety
Shutter

Fixed Chi Goniometer
Stage Head

APEX Il
Detector

Sealed X-ray
Tube

Monochromator

D8 .
Goniometer

 E—  E— |

Figure 2.4 — SMART goniometer components
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X-ray Source

Three components make up the X-ray source: a
shielded X-ray tube, an X-ray safety shutter, and
a graphite crystal monochromator.

The sealed-tube X-ray source produces the X-
ray beam used by the system.

The X-ray safety shutter is built into the X-ray
tube shield. The shutter opens upon initiation of
a set of exposures and closes upon the end of
collection. Status lamps on the shutter housing
indicate when the shutter is open (red) or closed
(green). The shutter is also interfaced to the
controller and to the safety interlocks.

A tunable graphite crystal monochromator;
selects only the K, line (A4,g = 0.710730 A for

Mo radiation, 4y = 1.541838 A for Cu radia-

tion) emitted from the X-ray source and passes
it down the collimator system.

K780 X-ray Generator

The K780 X-ray generator is a high-frequency,
solid-state X-ray generator that provides a sta-
ble source of power for operations up to 60 kilo-
volts (kV) and 50 milliamps (mA).

Typical maximum power settings for the APEX I
system with a fine focus tube are:

e 50 kV, 40 mA for Mo radiation
e 40 kV, 30 mA for Cu radiation

Either copper or molybdenum tubes may be
used on APEX Il systems. For both types of
tubes, the kV setting should not exceed 50 kV
and the power (kV x mA) should not exceed the
power rating given on the tube cap.

Because the generator is interfaced to the con-
troller, the power settings can be adjusted within
the APEX2 software. This is usually not neces-
sary as the software automatically increases the
power to the user-defined values at the begin-
ning of an experiment and lowers them when
the instrument is inactive.
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Timing Shutter and Collimator

On SMART APEX Il systems, the monochro-
matic X-ray beam then passes through the laby-
rinth, the timing shutter, and the incident beam
collimator before striking the crystal.

On Kappa APEX Il systems, the monochromatic
X-ray beam passes through a small labyrinth,
the timing shutter, a secondary labyrinth and the
incident beam collimator before illuminating the
crystal.

* The labyrinth is a device that ensures that
the collimator and shutter are tightly con-
nected to prevent X-ray leakage.

* The timing shutter is a device which pre-
cisely controls the exposure time for each
frame during data collection. Its status
lamps indicate when the shutter is open
(ON) and closed (OFF). For SMART APEX
Il systems, this assembly also houses an
automatic attenuator. Kappa APEX Il sys-
tems do not have an attenuator.

e The incident beam collimator is equipped
with pinholes in both the front (near the
crystal) and rear (near the source). These
pinholes help to define the size and shape
of the incident X-ray beam that strikes the
crystal. (Collimators are available in a vari-
ety of sizes, depending on your application.)

e The beamstop catches the remainder of the
direct beam after it has passed the crystal.
The beamstop has been aligned to minimize
scattered X-rays and to prevent the direct
beam from hitting the detector. The entire
collimator assembly is supported by a colli-
mator support assembly that has been pre-
cisely aligned to guarantee that the X-ray
beam passes through the center of the goni-
ometer.

Video Microscope

The video microscope, an essential part of the
system, allows you to visualize the crystal to
optically align it in the X-ray beam. It also allows
you to measure the crystal’s dimensions and
index crystal faces with APEX2’s Face Indexing
feature. The microscope is interfaced to the
computer and is operated through the VIDEO
program. The VIDEO program includes several
computer-generated reticles and scales to make
it easy to center and measure the crystal’s phys-
ical dimensions.
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2.1.3 Radiation Safety Enclosure with
Interlocks and Warning Lights

A common component of all systems in the D8
family is the radiation safety enclosure. This new
design is fully leaded (i.e., leaded windows,
leaded metal sides and panels) to protect you
from stray radiation. The enclosure also
includes warning lamps (a government require-
ment) that alert you when X-rays are being gen-
erated. As a special feature, the enclosure also
incorporates interlocks for both hardware and
software: an automatic system-interruption
device that senses when the doors and panels
are open and prevents data collection and use
of the shutter until you close the doors.

2.1.4 D8 Controller

The D8 controller is an electronic module
enclosed in the rack behind the front panel of
the instrument. It contains all of the electronics
and firmware for controlling the generator, open-
ing the X-ray shutters, and monitoring other
instrument functions such as safety interlocks,
generator status, and detector status.

The goniometer is controlled by the D8
controller.

2.1.5 Refrigerated Recirculator for the
Detector

To minimize dark current in the APEX I
detector, dual Peltier devices are used to cool
the CCD chip to approximately -58°F (-50°C).
The refrigerated recirculator uses an ethylene
glycol/water mixture to absorb the heat from the
Peltier devices.

2.1.6 Computer(s)

The SMART or Kappa APEX Il system uses a
single computer for control of the experiment,
storage of raw frame data, integration of the
data, and solution and refinement of the struc-
ture.

An additional client computer can be set up to
improve the performance of the system.

The computer or computers are often attached
to a network of similarly configured computers
with access to local and/or network printers.

NOTE: Connection to the external network must
be done with care. Consult with local
security experts.
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2.1.7 Accessories

Various devices can be mounted on the goniom-
eter base. These include optional low- and high-
temperature attachments. Both instruments can
be used with diamond-anvil cells.
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3 Software Overview

This section presents an outline of the APEX2
software, including a brief description of the soft-
ware layout as well as the graphical user inter-
face (GUI).

From a software and operational viewpoint, the
APEX Il systems use the GUI of the APEX2
software program to control all operations from
crystal screening to report generation for a typi-
cal crystallography study. This is a complete
departure from the command-driven, function-
ally separate modules of SMART, SAINTPLUS
and SHELXTL. Enhanced versions of the
proven and widely-accepted programs used by
these modules (e.g., SAINT, SADABS, XPREP,
XS, XM, XL, etc.) underlie the APEX2 GUI and
provide powerful tools.

3.1 Introduction to Client and
Server Functions

The various programs within the APEX2 Suite
have a client/server relationship (Figure 3.1), in
which the server program (BIS) executes com-
mands given by one of several client programs
(APEX2, APEX2Server, or BCP).
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Client Functions | APEX2

| APEX2Server

BCP

Server Functions

Instrument

Figure 3.1 — APEX2 software relationships

BIS

AN
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3.2 Server Functions
3.2.1 APEX2Server

APEX2Server is operated on the computer that
controls the instrument. It provides functionality
for quickly centering a crystal and determining
its diffraction quality.

APEX2Server contains two main modules:
Align Crystal and Simple Scans (see Figure
3.2). APEX2Server is covered in more detail in
Chapter 5.
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Figure 3.2 — APEX2Server’s Simple Scans window
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3.2.2 Bruker Instrument Service (BIS)

BIS acts as a server to the client programs
APEX2Server, APEX2, and BCP, providing a
link between the hardware and software. Once a
connection is established, BIS executes hard-
ware commands sent by the client programs.
BIS can also be used as a service tool, display-
ing diagnostic messages during operation.

BIS: Bruker Instrument Servi -Dec-2005

Phi de-icing

@O e L) sefeyshultr Natwork e |
= = ™ Activate auto de-ice feah

} Timing shutter 1 connected clients bt Al Sendto
@ e ) Atternator Interval fime Help

]

™ Use version 12 BIS frame headers

Monitor instrument | Debug instument | Connections

Messages received by BIS

YES /CID=52] ﬂ i Debug levels
Gettxeslimits /Distance=50.000000 /CID=53 ]

GETAXESLIMITS_YES /CID=53]

Getdxeslimits ADistance=51. 000000 /CID=54 | Debuglevel [0~

GETAXESLIMITS_YES /CID=54]

GetbxesLimits ADistance=52, 000000 ACID=55 ] Detector 0 -
GETARESLIMITS_YES /CID=55]

Getbxeslimits /Distance=53.000000 /CID=56 ] = Goniometer [0 -
4] _'I_| I —
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I Filter CHECK. and

I—I = NOOP commands
q 3
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Hard abart
Soft abort
Manual mode
Pause queue

Mezsages sent by BIS
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Figure 3.3 — BIS main window
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3.3 Client Functions
3.3.1 APEX2 Program

The APEX2 program is a GUI with multiple plug-
ins, or modules, for different aspects of an
experiment. The APEX2 program includes a
sample database that stores relevant data from
each step in the experiment. Details of the func-
tions available in the GUI will be explained in
more detail later in this User Manual.

3.3.2 Bruker Configuration Program (BCP)

BCP is used to configure BIS, as well as to pro-
vide instrument control and alignment tools.

From the BCP menu (see Figure 3.4), default
parameters for specific hardware elements can
be updated. BCP writes these values to the file
Brukerlnstrument.ini, which is read by BIS.
When changes are saved in BCP, BIS automati-
cally reads in the new values. See M86-Exx043
BCP and BIS Installation Notes, in addition to
the online help within BCP, for more information.
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Ele Edit View Inoks Help
DwdliErR|a e 8
L Conrolk
0 ‘ @ Lsit C Ven  Right Goriometet  [PHOENK,  L7]|cOml =]
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Figure 3.4 — BCP main window (Configuration screen)
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3.3.3 The Sample Database

The sample database is used for the storage of
data generated by the APEX2 Suite. It is
designed to transparently handle data from all of
the APEX2 modules without intervention from
the user.

The sample database is used internally by the
APEX2 Suite and is not available for user cus-
tomization or manipulation. It is automatically
started on computer startup, and it is automati-
cally stopped before the computer is shut down.

Structure of the Sample Database

The tables in the database are divided into four
categories.

First, there are tables with users’ data, such as
user names, passwords, and contact informa-
tion. These tables provide information about a
user's working group and information about for
whom the sample is scanned. The administrator
assigns each user to a working group or groups
(See M86-Exx092 User Manager User Manual
for more information).

The second set of tables contains data about
the sample. These tables contain all of the sam-
ple data required by APEX2’s various modules.
Data with a single value per sample are con-
tained in a table called “samples.” Preliminary
information about the sample, such as the
name, ID, and color, are stored in the “samples”
table as well. Data with multiple values per sam-
ple are contained in other tables linked to the
“samples” table.

A third set of tables contains the values of
standard crystallographic data, such as Laue
classes, space groups, and point groups. These
tables are referenced by the sample data and
are not modified in any way by the user.

Finally, there are a few miscellaneous tables
dealing with audit trails, version control of the
database, and other assorted functions.
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3.4 The APEX2 GUI

The APEX2 graphical user interface (GUI) has
one main window (see Figure 3.5).

This window is divided into five sections:

e Title Bar

e Menu Bar

e Tool Icon Bar

e Task Bar

e Task Display Area

Title Bar

Menu Bar

Eﬁnp:xz ¥2.1-RC5 - User: (guest) - Sample: Example - Licensed to Eric Amble at Bruker AXS

Sample Instrument Windows Help

ToollconBar —{ Gz H[|0 @ x|%

Sefin i

Center Crystal

Task Bar

Evaluats
Collect

Inteqrate

Scale

Exannine Data
Solve Stucture
Fiefine Stucture

Report

Instrument

Figure 3.5 — APEX2 GUI

Task
Display
Area
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NOTE: Throughout the APEX2 user interface,
input fields with pink backgrounds indi-
cate invalid entries. Disabled (greyed-
out) fields indicate that a feature is not
available, i.e., not supported or depen-
dent upon the instrument configuration.

3.4.1 Title Bar

The Title Bar displays the name and version of
the software, user name, sample name, license
type, and option currently selected in the Task
Bar. The right edge of the Title Bar also contains

the three buttons used by Windows for
minimizing, restoring, and closing the APEX2
main window.

3.4.2 Menu Bar

The Menu Bar provides drop-down menus for a
variety of file operations, image tools, and help
files.

An icon for the currently active window appears
on the left side of the Menu Bar. Clicking on this
icon allows you to minimize, restore, resize,
close, or move the currently active window.
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Sample Menu

4| Sample Instrument Windows Help

Lagir...
Lagauk
Mew, ..

Open...

(np T

Save
Close
Archive  »
Impork  »
Expork  »

Exit

Sample menu

Description
Command P
Opens a dialog window for logging into
Login... the Sample Database using your user-
name and password.
Logout Logs out of the Sample Database.
Lets you create a new sample in the
New...
Sample Database.
Open Opens a previously saved sample.
Save Saves the current sample.
Close Closes the current sample.
Opens a dialog for archiving samples in
. the Sample Database (to CD or .zip
Archive . - .
files). Previously archived samples can
also be restored using this dialog.
Allows you to import crystal information
Import contained in a .p4p or .spin file into the
Sample Database.
Allows you to export crystal data for the
Export )
current sample as a .p4p file.
Exits the application. This menu item
Exit has the same function as the but-

ton in the corner of the Title Bar.

Table 3.1 — Sample menu commands
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Instrument Menu

Instrument

menu Description
tSampIe Inskrument  Windows  Help p

Command

Conneckion. ..

Opens a connection to a server com-
Status... Connection... puter running BIS. If connected

Toogle Shutter already, select this menu to disconnect.

Abart. .. Opens a window showing a summary
Status... of the current status of the instrument
and your connection to it.

Instructs BIS to send a shutter open or
close command to the instrument. If all
interlocks and safety circuits are satis-
fied, the shutter will open and close.

Toggle Shutter

Abort... Stops a currently-running data set.

Table 3.2 — Instrument menu commands

Windows Menu

Windows
menu Description
iample  Instrument | Windows Help Command
| Describe Displays allist of active windows. Any
; Window selection of these windows may be brought to
2 Experiment the front by clicking its title in the
|T 3 Structure Solution Windows menu.
Table 3.3 — Windows menu commands
Help Menu
Help menu Ar
P Description
' Command
istrument  wWindows | Help

Displays version and copyright infor-
about e, | ABOULAPEX2.... | mation for APEX2.

Table 3.4 — Help menu commands
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3.4.3 Tool Ilcon Bar

Some icons on the Tool Icon Bar provide short-
cuts to the options available through the Menu
Bar.

Icon Description

EI Create a new entry in the sample database.

Other icons on the Tool Icon Bar are visible only
when a frame is displayed.

Icon Description

3 = Open a frame.

Select the first frame in a run.

Select previous frame.

Open an existing entry in the sample data-
base.

Save the current information to the sample
database.

Open the dialog for restoring a previously
archived sample.

Open the dialog for archiving the current
sample.

A ® @ O %

Delete samples from the database.

k? “What'’s this?” Context-sensitive help.

Table 3.5 — Tool Icon Bar: Menu Bar shortcuts

Sequentially display frames in reverse as a
movie.

If displaying frames as a movie, stop the
movie.

Sequentially display frames as a movie.

Select next frame.

Select the last frame in a run.

Iﬁvgmﬁéﬁ

Adjust the rate of display when viewing
foeeen | frames as a movie.

Go down one run.

Go up one run.

Draw a resolution circle.

Draw a plotting line.

Change the part of the frame displayed while
zoomed in.

B 372 0D <

Select a region of the frame.

Table 3.6 — Tool Icon Bar: displayed frame controls
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3.4.4 Task Bar

The Task Bar provides menus for all of the
functions available in the APEX2 Suite.

NOTE: If the Task Bar cannot be seen, there is
no open sample. Click Sample > New...
or Sample > Open... to open or create a
new sample.

Describe — Specify crystal size, color,
shape, etc.

Center Crystal — Perform crystal centering
functions.

Table 3.7 — Setup

Determine Unit Cell — Determine unit cell
and Bravais lattice type.

[

-

Transform Unit Cell — Transform a unit cell.

Table 3.8 — Evaluate

Reciprocal Lattice Viewer — 3D visualization
of the lattice projected in reciprocal space.

&

View Images — View and analyze diffraction
images.

Collect

Table 3.8 — Evaluate

Data Collection Strategy — Simulate data
collection and determine strategy.

Experiment — Sequence editor for data
collection experiments.

-

Oriented Scans — Measure diffraction
frames with the crystal aligned along axes.

Table 3.9 — Collect

Integrate

Integrate Images — Integrate diffraction
data.

Table 3.10 — Integrate
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100
Crystal Faces — Determine Miller indices
and distances of single-crystal faces.

Scale — Scale intensities and perform
absorption correction.

Table 3.11 — Scale

Examine

Data
: Phase ID (optional) — Display and integrate
single and multiple frames.

Space Groups and Statistics — Determine
the space group.

Compare Unit Cells — Compare unit cells to
find twin laws.

Precession Images — Create precession
images based on measured frames.

Examine
DE]E:]

Find a Reflection — Find a reflection in
measured frames.

Table 3.12 — Examine Data

Solve
Structure

AutoStructure (optional) — Automatic solu-
tion and refinement with minimum user
a input.

Structure Solution — Solve the structure.

View Molecule — Visualize the molecule in
3D.

Table 3.13 — Solve Structure

Refine

Structure

. Structure Refinement — Run XP, XL, or
o XSHELL.

Space Group Determination — Run XPREP.
prEp

Table 3.12 — Examine Data

Table 3.14 — Refine Structure
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Generate Report — Run XCIF to generate a
report.

System Calibration — Make calibration
measurements.

L T
w Unwarp and convert images — Convert

frames between formats.

Play Tic Tac Toe — Play a game of
Tic Tac Toe!

| |
D

> |

Table 3.16 — Instrument

M86-E01078



APEX2 User Manual

Software Overview

Stack Bar And Tree View

Right-click in the Task Bar to choose one of two
views: Stack Bar or Tree View.

Sample Instrument Windows  Help

ID =z ®]lo a x[[%]

Setup

Evaluate

Collect

Integrate

Scale

Examine Data

Solve Shucture

Auto-Stnicture

Structure Solution

@

Wiew Molecule

Refine Structure

Fieport

Instiument

Figure 3.6 — Stack Bar view

In Stack Bar view, click one of the Task Bar sec-
tions labeled Setup, Evaluate, Collect, Inte-
grate, Scale, Examine Data, Solve Structure,
Refine Structure, Report, or Instrument to
display only the icons belonging to that section.
All other Task Bar icons will be hidden.

Sample Instrument  Windows  Help

ID=w[loa x|
- Setup -

&

Describe

4

Center Crystal

£ Evaluate CrarkBa
Determine Unit Cell E

Transform unit cell

»
2
»

SR

]
3 @

s
N,

Reciprocal Lattice Viewer

& . Y -

El Collect
T
6" Data Collection Strategy

2 % Experiment

fiented Seans

[ Integrate

b % Integrate Images

Figure 3.7 — Tree View

In Tree view, sections may be expanded to dis-
play their Task Bar icons by clicking the plus or
minus sign next to the section name.
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3.4.5 Task Display Area

The Task Display Area is the main area for
tasks, user input, and selected output. This area
displays images, the reflections used in index-
ing, and observed and predicted diffraction pat-
terns. It also displays the runs for data collection

NOTE: In APEX2 Version 2, XShell refinement
and XCIF report generation do not use
the Task Display Area; they open in new
windows. All other modules open in the
Task Display Area of APEX2’s Main Win-

dow.
and solution and refinement.
& File Dnstrument Windows Yiew =
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cale 1
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Figure 3.8 — Task Display area showing the Data Collection
Strategy module
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4 Program Startup and Shutdown

As discussed in Chapter 3, the APEX2 Suite is
composed of several programs. All of the pro-
grams are started in a similar fashion. For ease
of use there is usually a desktop icon for the
folder containing these programs, and desktop
shortcuts linked directly to these programs.
However, the Start > Programs > Bruker AXS
path is always available. This more explicit
method will be used in this discussion.
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4.1 Access to BCP and APEX2

Bruker software allows different user accounts
to have different levels of access to the instru-
ment:

e Service

e  Security

e  Administrator
e User

* Non-user

NOTE: You need Bruker Instrument Administra-
tor rights to run BCP and Bruker Instru-
ment User rights to run APEX2.
Typically, your system administrator will
already have your user account config-
ured or you will be using the default
accounts as provided by Bruker AXS.

4.2 Online and Offline Operation

APEX2 can operate in either online or offline
mode.

In online mode, APEX2 is connected to BIS in
order to communicate with the instrument for
performing experiments. To use APEX2 in
online mode, you must start BIS, APEX2, and
optionally, VIDEO.

In offline mode, APEX2 is not connected to the
instrument, but is still able to analyze and inter-
pret existing data. To use APEX2 in offline
mode, you only need to start APEX2.
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4.3 Startup

4.3.1 Starting Bruker Instrument Service
(BIS)

BIS is the link between the hardware and the
APEX2 software. The BIS software executes
hardware commands issued by APEX2.

1. To start BIS, select Start > Programs >
Bruker AXS > Administration > BIS (Fig-
ure 4.1).
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Figure 4.1 — Starting BIS from the Start menu

2. Once the BIS window appears, you may be
asked to confirm the detector distance.

4.3.2 Starting APEX2

APEX2 is used to set up crystallographic experi-
ments and to process crystallographic data.

1. To start APEX2, select Start > Programs >
Bruker AXS > APEX2.

£ Riooo Eaey £ and DVD Crostor §
o St
D) St chae Smcurty

a
a
g
]
:
i

o Welu
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8 Iresent Explerer

W Merncdt onn
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W Windows Cohedeg

Qmm

Figure 4.2 — Starting APEX2 from the Start menu
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2. The Login window appears automatically

when you start APEX2. At the Login win- NOTE: By editing the “bn-config.py” configura-
dow, enter your user name and password. tion file, APEX2 may be configured to
As shipped by Bruker AXS, the default start without displaying the Instrument
account is “guest” with password “guest” Connection window. In this mode,
Click OK. APEX2 automatically connects to the

user-specified IP address or DNS name
of a computer running BIS. More infor-
halLogin 7] %] mation about the bn-config.py file may
be found in M86-Exx087 APEX2 and
PROTEUM2 Installation Notes and in
Appendix D.

Uszer: |guest

xxxxx

Pasgword; I

You are now ready to begin using APEX2.
0] LCancel

Figure 4.3 — Login dialog

3. For online operation within APEX2, select
Instrument > Connection.... In the Instru-
ment Connection window, enter the instru-
ment host name. The window shows the
default host. Click Connect.

@ Instrument Connection

Host Marne: IM

Connect I Cahcel

Figure 4.4 — Instrument connection dialog
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4.4 License Considerations

You need a software license to activate your pur-
chased software packages, options, and/or fea-
tures.

APEX2 requires a valid license file to operate.
This file, “bn-license.dat”, must be present in the
root directory of drive C:\ for the software to start
properly.

If the license file is not present or has expired,
an error window will appear when you try to start
APEX2. This window prompts you to run the
License Manager application to obtain a valid
license for APEX2.

For more information on licenses and License
Manager, refer to M88-Exx099 License Man-
ager User Manual.

Il Error!

Mo walid license is available bo run APE=Z2.
Please use the License Manager to order a license,

Figure 4.5 — “No valid license” window
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4.5 Shutdown
4.5.1 Shutting Down APEX2

1.  First, log out of the sample database by
going to Sample > Logout within APEX2.
In the “Closing Sample” window, select
whether to save or discard the changes to
the sample database.

Ei[lnsing Sample

\ié) what should happen to your changes to this sample?

Discard |

Figure 4.6 — “Closing Sample” window

NOTE: The “Closing Sample” window appears
even if no apparent changes were made
to the sample database because the
date and time of the last access are held
in the sample database and differ from
the current date and time.

2. Within APEX2, select Sample > Exit.
APEX2 closes.

4.5.2 Shutting Down BIS

1.

To stop BIS, click the Exit button in the
upper right-hand corner of the BIS window.
You may be asked to place the generator
into Standby mode.

At the confirmation dialog, click OK. BIS
closes.
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We are now ready to begin the process of data
collection with the instrument. It is assumed that
your system administrator has set up the system
properly and that all system default parameters
have been set appropriately.

The data collection process is divided into five
steps, which will be covered in Chapter 5 and
Chapter 6.

The steps in Chapter 5 are performed using the
APEX2Server software on the computer control-
ling the instrument (i.e., the Server in a dual-
computer setup).

The steps in Chapter 6 are performed using the
APEX2 program (on the Client computer in a
dual-computer setup).

See Chapter 5 for:

¢ Centering the crystal on the diffractometer
(using APEX2Server’'s Center Crystal mod-
ule)

e Crystal quality check (using APEX2Server’s
Simple Scans module)

See Chapter 6 for:

e Cell determination (using APEX2’s
Determine Unit Cell module)

e Data collection setup (using APEX2’s Data
Collection Strategy module)

e Data collection (using APEX2’s Experiment
module)

5.1 Start APEX2Server

1. If APEX2Server is not running on the com-
puter controlling the instrument, start it by
going to Start > Programs > Bruker AXS
> APEX2Server.
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2. Ensure that APEX2Server is connected to
the instrument by checking the Instrument Fiarual SRR
> Status... menu.

5.2 Mount the Goniometer Head
on the Instrument

1. Open the enclosure doors by pushing
either of the rectangular green Open Door Spin Phi 90
buttons on the enclosure’s side posts. This
releases the door locks for approximately
five seconds. While the door locks are
released, pull outward on one or both of the
handles to physically open the doors.

Spin Phi 180

Figure 5.1 — D8 Enclosure Open Door button

2. Under Setup in APEX2Server’s Task Bar,
click Center Crystal. The centering buttons Mownt |
(Figure 5.2) appear and the VIDEO program
window opens.

Left | Top | Right
Center |

Figure 5.2 — Centering buttons
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NOTE: If the VIDEO window does not stay on
top of the APEX2Server window, select
Grab > On top from the VIDEO program
Menu Bar.

The bottom five buttons in Figure 5.2, Mount,
Left, Top, Right, and Center, drive the goniom-
eter to various pre-defined positions that are
designed to simplify crystal centering. The two
large square buttons rotate phi by either 90 or
180 degrees.

3. Click Mount to drive the goniometer to a
convenient position for mounting the goni-
ometer head.

4. Carefully remove the goniometer head
containing the crystal from its case.

Use extreme care when handling the
goniometer head to prevent damage to the
crystal on the end of the small glass fiber.

Place the goniometer head onto its base on
the phi drive. Line up the slot on the bottom
of the goniometer head with the pin on the
mounting base (see Figure 5.3).

Line up this slot with the
pin on the goniometer’s
mounting base.

Figure 5.3 — View of the bottom of the goniometer head

6. Screw the goniometer head collar to the

base so that the head does not move. Do
not overtighten it (finger-tighten only).

M86-E01078



Crystal Centering and Screening APEX2 User Manual

Crystal
Sample
mounting
screw
Sample
mounting .
collar Z-axis lock
Locking collar
Y-axis lock Z-axis
adjustment
screw
Y-axis
X-axis adjustment
adjustment screw
screw
X-axis lock

Goniometer head collar

Figure 5.4 — Huber goniometer head in detail
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Crystal

Sample
mounting

screw Locking collar

Z-axis
adjustment Z-axis lock
collar
Y-axis
X-axis adjustment
screw

adjustment
screw

Goniometer head collar

Figure 5.5 — Nonius goniometer head in detail
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5.3 Center the Crystal

To obtain accurate unit cell dimensions and col-
lect good quality data, position the crystal in the
center of the X-ray beam and maintain this posi-
tion for the entire experiment.

Your video microscope should be aligned so that
the reticle of the video microscope coincides
with the center of the goniometer and the center
of the X-ray beam (for instructions on aligning
the microscope to the center of the instrument,
see M86-Exx024 Microscope Focus and Sam-
ple Alignment).

If the microscope is not centered, you can still
center the crystal. A successfully centered crys-
tal stays in the same place in the microscope’s
field of view in all orientations.

To center the crystal on a Kappa APEX Il sys-
tem, see Section 5.3.1.

To center the crystal on a SMART APEX Il sys-
tem, see Section 5.3.2.

NOTE: Use the thin end of the goniometer
wrench to unlock the X, Y and Z locks at
the beginning of the centering process
and to lock them at the end. Locking
needs only a very slight touch. The other
end of the wrench is used to move the
adjustment sleds. Do not overtighten the
locks.

NOTE: Centering is often easier if the crystal is
rotated to give a good view before the
actual centering process is started (e.g.,
down an edge for a plate). To do this,
click Center to drive to the initial center-
ing position, loosen the crystal mounting
screw, rotate the crystal to a suitable ori-
entation, and then tighten the screw
again.
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5.3.1 For Kappa APEX Il Systems

1. Click the Center button. The goniometer
head drives so that its Y and Z translation
axes are positioned perpendicular to the
microscope. The Y- and Z-axis adjustment
screws should be facing the front of the dif-
fractometer. If they are not, click Spin Phi
180.

Figure 5.7 — Crystal initially mounted

2. Center the crystal in the video microscope
reticle by making adjustments to the Y- and
Z-axis adjustment screws.

Figure 5.6 — Center position, Y- and Z-axis adjustment
screws

Figure 5.8 — Centered crystal after Y- and Z-axis
adjustments
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3. Click Spin Phi 180 and check that, after
rotating 180°, the crystal appears in the
same position in the microscope reticle. If
the crystal does not appear in the same Crystal displaced
position: approx. 2 ticks to

3.1 Use the adjustment screw
facing you to remove half of
the difference shown in the
reticle (Figures 5.9 and
5.10).

3.2 Click Spin Phi 180.

3.3 Repeat steps 3.1 and 3.2
until you are satisfied that ;
the crystal remains in the Figure 5.9 — Example: error in Y-axis
same position in the micro-
scope reticle when rotated

by 180°.
After removing
half the error,
NOTE: If the crystal consistently fails to appear crystal displaced
in the same position when rotated by approx. 1 tick to
180°, the position of the microscope the left.

reticle may need adjustment. For more
information, refer to M86-Exx024 Micro-
scope Focus and Sample Alignment.

Figure 5.10 — Example: error removed by half
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4. Click Spin Phi 90. Phi rotates so that the X-
axis adjustment is facing forward. Any error
in the crystal’s position along the X-axis will
now appear in the microscope.

Figure 5.12 — X-axis error after spinning phi 90°

5. Center the crystal in the video microscope
reticle by making adjustments to the X-axis
adjustment screw.

Figure 5.11 — Center position, X-axis adjustment screw

Figure 5.13 — Centered crystal after X-axis adjustments
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6. Alternately click Spin Phi 180 and Spin
Phi 90 to verify that the crystal stays in the
same place in the microscope reticle
through all motions of phi. If the crystal fails
to stay in the same position as phi is
rotated, make adjustments to the axes by
repeatedly removing half the error as in
step 3.

7. Click the Left button. The goniometer
drives to place the fiber horizontal and to
the left. Note the height of the crystal in the
video microscope reticle.

Figure 5.15 — Crystal in left position

Figure 5.14 — Left position
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8. Click the Right button. The goniometer
drives to place the fiber horizontal and to
the right.

Figure 5.17 — Crystal in right position

9. Check that the crystal height is the same as
the height you noted in step 7.

9.1 If the height is the same,
proceed to step 10.

Figure 5.16 — Right position 9.2 If the height is not in the
same place, adjust to
remove half of the difference,
click Spin Phi 180, and
repeat steps 7 to 9.
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10. Click the Top button. The goniometer
drives so that the phi axis is pointing
directly into the microscope.

Figure 5.19 — Crystal in top position

11. Click Spin Phi 180 a few times to verify that
the crystal stays in the same position as Phi
rotates. If the crystal does not remain cen-
tered, go back to step 1.

12. Click Center to drive the goniometer back to
the center position.

Figure 5.18 — Top position

The crystal is now centered on the instrument.
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5.3.2 For SMART APEX Il Systems

NOTE: If the image of the crystal is difficult to
see, illuminate the crystal with a high-
intensity lamp and/or temporarily place a
light-colored piece of paper on the front
of the detector.

1. Click the Right button. The crystal and
goniometer head drive to a position per-
pendicular to the microscope. To center the
crystal, make adjustments to the height
with the Z-axis adjustment.

Figure 5.21 — Initial mounted crystal

Figure 5.20 — Right position, Z-axis adjustment screw
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2. Click the Center button. Move the crystal
so that it is centered in the microscope reti-
cle by adjusting the X- or Y- axis translation
adjustment screw that is perpendicular to
the microscope axis and facing you (see
Figure 5.4 and Figure 5.5).

Figure 5.23 — Initial center position before X- or Y-axis
adjustment

Figure 5.22 — Center position, Y and Z adjustments

D
4
E
3
r
H
E

£
E
3

Figure 5.24 — Crystal after X- or Y- adjustments
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3. Click Spin Phi 90. Remove half of the dif-
ference with the adjustment screw that is
facing you.

After removing
half the error,
crystal displaced
approx. 1 tick to
the left.

Crystal displaced
approx. 2 ticks to
the left.

g
.

<
§

. Figure 5.26 — Example: error removed by half
Figure 5.25 — Example: error in X-axis 4. Click Spin Phi 180. Remove half of the dif-
ference with the adjustment screw that is
facing you.

5.  Click Spin Phi 180 again.
6. If the crystal is centered, click Spin Phi 90.

7. If the crystal is not centered, adjust to
remove half of the difference and click Spin
Phi 180. Repeat until the crystal is cen-
tered. Click Spin Phi 90.

8. If centered, adjust the height. If not cen-
tered, repeat steps 3 through 7 until it is
centered.
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9. Click the Left button. Adjust to remove half
of the difference. Adjust the height.

N
v

&
=

Figure 5.27 — Height adjusted

Figure 5.28 — Left position

Figure 5.29 — Check height in left position
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10. Click the Right button. Adjust the height. 11. If a height adjustment was made in step 6

Adjust to remove half of the difference. or 7, repeat those steps to check the
height. If the height is adjusted, repeat
steps 2 to 5 to check the centering. If no
height adjustment was made, the crystal is
centered.

The crystal is now centered on the instrument.

Figure 5.30 — Right position

Figure 5.31 — Check height in right position
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5.4 Simple Scans

APEX2Server’s Simple Scans software module
provides tools for rapid screening of the crystal
to check crystal quality. It allows you to quickly
set up scans to measure a 360° phi rotation as
well as thin (0.5°) and thick (2.0°) still images.

1. Under Setup in APEX2Server’s Task Bar,
click Simple Scans. The menu shown in
Figure 5.32 opens.

Distance [mm]: |45 3: "J—

2Theta: 19 H—

Omega: 1o - '_J_

Phi: [ & —}+——

Chi [e d—F—
Zem Currett |
Phi=n | Phi+s) |
zerd | zer 2 |
zer 3 | [zer 4 |

Scan Asi

’75’ Phi " Omega

Scan Range: I

Image ‘width: I

E xposure Time:

I‘ID ;I Isecs.-’image ;I

[ Conelate 2 images [ Mew dark image

"Scan Ophionz

sl | BOPH |
Norow(05) | widseo) |
Figure 5.32 — Simple Scans menu
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The sliders and data boxes at the top can be
used to position the detector.

The buttons in the middle provide easy access
to common movements.

There are four possible user-defined buttons.

The Drive button initiates the requested move-
ment. If it is gray, an impossible movement has
been requested.

The buttons and boxes at the bottom set up
scans. In Figure 5.32, the Drive + Scan button
is grey and therefore inactive because no scan
has been requested.

1. Click Zero and then Drive.
2. Set the distance.

2.1  On Kappa APEX Il systems,
check that the moveable
beamstop is pushed in and
set the desired position (typi-
cally 45 mm) for Distance in
the data window.

2.2 On SMART APEX Il systems
with movable DX, set the
desired position (typically 50
mm) for Distance in the data
window.

2.3 On SMART APEX Il systems
with fixed DX, check that the
distance displayed is the
same as the actual distance
in mm on the detector arm.

Click 360° Phi and set the desired expo-
sure time. The default of 15 seconds is usu-
ally sufficient.

Click Drive + Scan. Since these are evalu-
ation scans, there is no need to request
correlated images or new darks. The shut-
ter opens and the phi scan begins. The
resulting Phi 360° image is shown in Figure
5.33. The crystal diffracts nicely with lots of
sharp spots. Figure 5.37 shows a Phi 360°
scan with a bad crystal.

Figure 5.33 — A 360° Phi scan on a good quality crystal

Click Wide (2.0). The phi scan range
changes to 2°. An exposure time of 5to 15
seconds is usually sufficient for a wide scan.
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6. Click Drive + Scan. The resulting 2° scan 7.  Click Phi + 90 in the middle row of boxes.
is shown in Figure 5.34. The spots are
sharp and clean. There are no peaks that
are very close together. Figure 5.38 shows
a 2° scan with a bad crystal.

8. Click Drive + Scan. The resulting 2° scan
is shown in Figure 5.35. This image is mea-
sured 90° from the previous one, giving a
view of the diffraction pattern from a differ-
ent (perpendicular) direction. Figure 5.39
gives a similar view for the poor crystal.

Figure 5.34 — A 2° phi scan on a good quality crystal. The
spots’ shapes are well-defined and the spots
are well-separated.

Figure 5.35 — A 2° phi scan at phi = +90° on a good quality
crystal. The spots’ shapes are well-defined and
the spots are well-separated.
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9. Set 2-theta to -30°. This will allow evaluation
of the diffraction at higher angles.

10. Click Drive + Scan. The resulting image is
shown in Figure 5.36.

|
1

]
10

O Curser
Position [pixels] ¥ WS
Irtensity [counts] £
HEL index wa i T
Resolution [4] 093 o T TU
2Theta '] 4497 1 i 100 1000 10000 100000 1000

Image Header h Tool Editor A Cursor Pasition

Figure 5.36 — A 2° phi scan on a good quality crystal at 2-
theta = -30°. The cursor is pointing to an area
between the two reflections shown in the 3D
View window. The cursor position tab at the
bottom left shows that the resolution is 0.93A
and 2-theta is 45°.
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5.5 Examples of Poor Quality
Crystals

RY 7 77 R N T Y

~-sll§|~.li;

Figure 5.37 — A 360° phi scan on what is likely a poor quality Figure 5.38 — A 2° phi scan on a poor quality crystal. The
crystal. The spot shape is poor and the spots spot shape is poor and some spots seem split.
tend to run together. The obvious bands on the
image suggest that the crystal is nearly aligned
along an axis; however, spots will always
apparently run together in a nearly aligned
crystal mounting. Figure 5.38 is much more
convincing proof of a poor quality crystal.
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Figure 5.39 — A 2° phi scan on a poor quality crystal at plus Figure 5.40 — A 360° phi scan on a small crystal. The
90 in phi. The spot shape is poor and the spots diffraction power of the crystal is small, but with
are very close together. longer exposure times this is clearly a

reasonable candidate for data collection.
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6 Data Collection

The data collection process is carried out on the
client computer using APEX2. Once data collec-
tion is started, exit APEX2 (optional). Data col-
lection will continue regardless.
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6.1 Create a New Sample

1. After starting APEX2 and logging in, select
Sample > New....

2. In the window that appears, enter the
sample name. APEX2 will automatically
create a directory for data storage.

B@hew Sample [ 7]
Marne: Iyl\d_example
Group: IUSEIS LI
Falder: IC “Frameshguestiylid_example EI
Cancel

Figure 6.1 — New Sample window

3. Click OK. The Task Bar appears with the
Setup section open.

4. Click Describe.

5. Enter the requested information into the
Describe window.
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;iAPExz v2.1-RC7 - User: (guest) - Sample: ylid_example - Licensed to Applications Lab at Bruker AXS - [Describe]
4 sample Instrument ‘Windows Help =la] x|
ID=zd]oe x|
Setup
Hame: [oid_esemple

Compound:: |YLID
Forula: | BECIEES]
Appeaance Intensity Primary Color Secondary Color
Crystal Color.
/ ¢ |nfa | |nfa | Juellon | |nfa a|
Certer Crystal
Ciystal Dimension: [0.3 «[03 w03 [mm]

Crpstal Shape; |5pha.ica|

This is an example YLID for the APEX2 Version 2 User Manual.

Motes:

Figure 6.2 — Describe window

6. Close the Describe module by clicking the

X button on the right-hand side of the
Menu Bar. APEX2 will automatically save
the data to the sample database.

M86-E01078 6-3



Data Collection

APEX2 User Manual

6.2 Determine the Unit Cell

Unit cell determination is performed in several
steps:

e Data collection

e Harvesting of reflections from collected
frames

* Indexing of harvested reflections
e Bravais lattice type determination
¢ Refinement

In APEX2 Version 2, these steps are integrated
in the Determine Unit Cell module (located in
APEX2’s “Evaluate” category), which also con-
tains a one-click solution for fully-automated unit
cell determination.

The upper right-hand corner of the Determine
Unit Cell module contains two sections:

e Automatic Mode - for fully-automated unit
cell determination (Section 6.2.1).

¢ Manual Mode - for unit cell determination
with user-defined parameters (Section
6.2.2).

NOTE: The Determine Unit Cell module auto-
matically determines crystal mosaicity
and provides a table of exposure time
versus diffraction limit (Figure 6.3, lower
right-hand corner).

This table is strictly informational and its
contents are not used when determining
exposure times for a data collection
strategy. However, you can use the infor-
mation in the table to manually set expo-
sure times for your maximum desired
resolution.

For more information on the Data
Collection Strategy module, refer to Sec-
tion 6.3.
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User: {guest) - Sample: |_example - Licensed to Single Crystal App-lab at Bruker-AXS - [Determine Unit Cell]
4 Sample  Instrument indows =18 x|
Insaloa x|l de(mawdw b /v 2[osg]k]
Setup
Evaluate —Automatic Mod Manual Mod

280 Start at: Collect Data X @ Collect Data
@ Stop after. | Refine - ® Harvest Spots
260
Fun L B[ie=7
R 240 W Bravais
0 W Hefine

200 Unit cels:

e Edi...
o o et 180

Delete

Trarsform unit cell

Reciprocal Lattice

Ll

Wiewer Delete All
e
FRieflections:
Edi..
Delete
Delete All
1,
T R
0 3 a8 389 5833 93399 939359 Erpecteih sl
Callect Exposure time [{ Resolution [4]
Intearate ~Pasition T 1 200n/a
Scale Positian [pixels] 2 E0.0n/a
Examine Data Intensity [counts] 3 1200/ n/a
Sahve s HEE ek 4 6000/
divarstuctile Fiesalution [4]
Refine Structure - 2Theta ']
Repart Crystal Mosaicity [ 0,40

Image Header A Tool Editor A Cursor Position

Instrument

Figure 6.3 — Determine Unit Cell module
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6.2.1 Automatic Mode

1. Inthe Task Bar, click Evaluate and then
Determine Unit Cell. The Determine Unit
Cell module appears (Figure 6.3).

2. From the Start At: pull-down menu, select
the step at which you want APEX2 to begin
automatic unit cell determination (useful if
you want to find a unit cell from frames that
have already been collected).

3. From the Stop After: pull-down menu,
select the step at which you want APEX2 to
stop automatic unit cell determination.

4. Click Run. Automatic data collection begins
and collected frames appear in the Infor-
mation Display Area. The area containing
the Automatic and Manual mode options
changes to a list showing APEX2’s
progress through the steps of unit cell
determination.

[Task Comment -
[ Collect Data Data calection started

m Manitar D ata Collection

O Harvest Spots

O index

O Choose Solution

O Refine

[ Bravais

O Refine =

Close |

Figure 6.4 — Automatic Mode progress list

When automatic unit cell determination is
complete, the progress list will show a
check mark and comments for each com-
pleted step (Figure 6.5).

Comment | -

[ACollect Data  'Data collection started

A Monitor Data Collection 36 images collected

EHarvest Spots Harvested 270 reflectionfs) from 36 image(s)
Hindex Selected 270 reflectionls] for indezing

i Choose Solution Indexed 158 out of 270 reflections.

H Refine F.B3 B.88 18,24 50,00 8314 B3 51

A Brawais Found Bravais lattice type Othothombic P

HFRefine £.00 9,03 18.47 90.00 90.00 30,00 Jod|

Clase

Figure 6.5 — Completed progress list

6.

Click the Close button to close the
progress list and return to the main Deter-
mine Unit Cell window. The right-hand side
of the window displays the unit cell parame-
ters obtained by APEX2, along with options
to edit or delete the unit cell and reflection
list if you wish to perform additional opera-
tions in Manual Mode (more information on
Manual Mode operations is given in Section
6.2.2).
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6.2.2 Manual Mode

The Determine Unit Cell Module’s Manual Mode
functions allow you a great degree of control
over unit cell determination. Manual Mode con-
sists of five sections, each with its own menu,
corresponding to the five stages of unit cell
determination:

Collect Data
Harvest Spots
Index

Bravais

Refine
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Collect Data

Menu ltem Function

Image Location:

Location where collected frames will be
saved.

Image Lecation:  [CFrameshauestgld_svample = Image Base Text string that is appended to each
: frame’s filename and is used to identify
Image Base Mame: Imalnx Name: frames by their filenames
First Rur: 1 3: ’
Choose which run number will be the
Dittance [rm}: ~ [400 3 First Run: first run; useful for adding runs without

Expasure Time:

10.0 3: Isec;‘\mage -

Image ‘Width [deg]: [0.5 3:

overwriting previous ones.

Distance [mm]:

Detector distance.

Detector Fomat: | 5126612 = Exposure Time: | Duration, in seconds, of each frame.
Conelate Frames. [yer 2] Image width Distance, in degrees, that the scan axis
[deg%' travels over the course of a single

R B

Figure 6.6 — Collect Data menu

Collect... Cancel

exposure.

Detector Format:

Resolution of the frames collected by
the detector.

Correlate
Frames:

Two frames are taken (each with half
the duration of the overall Exposure
Time), to correct for spurious events
appearing on individual frames.

4| left arrow]

Go to the previous step in the unit cell
determination process.

b Iright arrow]

Go to the next step in the unit cell
determination process.

Finish

Finish the sequence of steps in the unit
cell determination process, beginning
with the current step. Perform any
tasks that are necessary.

Collect...

Proceed with data collection according
to the options set in the preceding
menu items.

Cancel

Leave Manual Mode and return to the
initial Unit Cell Determination page,
performing no operations and ignoring
any changes made to menu items.

Table 6.1 — Collect Data menu items
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Harvest Spots

) Select the first image in the group of
First Image: . -
images to be examined for spots.
First Image: I\Flames\guest\p\idﬁexample\matlixfm70001 shm & |
Wumberof Furs: [2 2] Images per Run [[2 o Number of Runs: | Number of runs to be examined.
Go to lmage: IC:\Frames\guest\y\idﬁexample\matrixfm70001.sllm ;I i Number of images to be examined in
Images Per Run: each run
More Spots Fewer Spots )
Min lsigmally [l362 — ———— & Select a frame filename from this drop-
1 s g Go to Image: down menu to display the frame in the
Image Information Area.
From [8] | Ta (] | add. |
1.90 192 . . .
222 2m Edi. | Adjust the criterion for harvesting a
R Deee | spot based on its pixels’ intensity ver-
Excluded Shells | . . sus their standard deviation. Slide the
R Min. I/sigma(l): slider between “More Spots” and
“Fewer Spots” to vary the minimum 1/
sigma(l).
Store I Group U: 270 reflections | A Gaussian filter is applied to the
I | Gave orlyiefiestions Hiat span imag=s frames prior to harvesting, which
reduces the noise and eliminates
Smooth images | falsely harvested pixels. For very weak
data, however, the Smooth images
function can interfere with successful
harvesting.

Table 6.2 — Harvest Spots menu items

il LI Finish Harvest Cancel |

Figure 6.7 — Harvest Spots menu
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Menu ltem Function

Excluded shells:

Add, edit, or delete resolution shells to
be excluded from the harvesting pro-
cess, for example in the case of rings
caused by ice or amorphous diffractors
(the three inner resolution shells for
water ice appear as defaults).
Excluded shells are defined by their
starting and ending resolution (which
may be found by placing the mouse
cursor on a displayed frame and refer-
ring to the Resolution [A] field in the
Cursor Position Tab).

The Reflection Group Combo Box
shows a list of reflection groups to
choose from. For each group, the
group name and number of reflections
in the group are displayed.

If, instead of the number of reflections,
an entry is labeled empty, this indicates

Store an unassigned entry. Choosing the
(Reflection Group | empty entry creates a new group
Combo Box): instead of appending to the current
one.
A color is associated with each reflec-
tion group. The color is displayed in the
box to the left of the group name. The
color helps in recognizing a group
while navigating through the software.
Right-click to edit or clear groups.
Save only With this checkbox enabled, a spot is
reflections that only harvested if it is found on multiple
span images contiguous frames.

4| left arrow]

Go to the previous step in the unit cell
determination process.

Table 6.2 — Harvest Spots menu items

Menu ltem Function

b | Iright arrow]

Go to the next step in the unit cell
determination process.

Finish

Finish the sequence of steps in the unit
cell determination process, beginning
with the current step. Perform any
tasks that are necessary.

Harvest

Proceed with harvesting according to
the options set in the preceding menu
items.

Cancel

Leave Manual Mode and return to the
initial Unit Cell Determination page,
performing no operations and ignoring
any changes made to menu items.

Table 6.2 — Harvest Spots menu items

M86-E01078



APEX2 User Manual Data Collection

Index
Menu ltem Function
Reflections: | Group 0 270 reflections =] Opens the Reflection Group Combo

Go to Image: IC:\Flamas\guest\yhd_example\mallix_m_0001 sfrm LI

More Reflections Fewer Reflections

f
Min. [/sigma(l): |14.88 . . . )I . . . .
FRiesalution [] IBBSS.UD - 0.7

¥ Reflections must be isolated

I™ Reflections must span images

I™ FReilections must be whole

270 Reflections zelected for Indexing

=5 955, b=9 024, o=18.364
Stare =30.00°, =30.00°, y=30.00° -
=03682, Othorhambic P
Conections: ¢ From store @ From last harvest © Manual

Distarce [mm]: 0.00 Fitet [7]: |0.00
» Beam Center [mm]: |0.78 R[] |0.00
v Bearn Center [mm]: |0.34 aw [ (000

Methods: ¥ Difference Vectors
¥ Fast Fourier Transform

I~ | Least Sauares

| b Fisn

Figure 6.8 — Index menu

Reflections:

Box to allow you to select a certain
group of reflections for indexing.

Go to Image:

Select a frame filename from this drop-
down menu to display the frame in the
Image Display Area.

Min I/sigma(l):

Adjust the criterion for indexing a
reflection based on its integrated inten-
sity versus its standard deviation. Slide
the slider between “More Spots” and
“Fewer Spots” to vary the minimum I/
sigma(l) needed for a reflection to
qualify for indexing.

Resolution(A):

Set the resolution range from which
spots will be used to index the unit cell.

Reflections must
be isolated

If this checkbox is active, overlapping
spots will not be used for indexing.

Reflections must
span images

If this checkbox is active, only spots
which registered on at least two adja-
cent images will be used for indexing.

Inde, Cancel |

Reflections must
be whole

If this checkbox is active, spots that
have only partially registered on the
first and last images of the range from
which they are harvested will not be
used for indexing.

Table 6.3 — Index menu items
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Menu ltem Function Menu ltem Function

The Unit Cell Combo Box shows a list Finish the sequence of steps in the unit
of unit cells to choose from. For each Finish cgll determination process, beginning
unit cell, the unit cell parameters are with the current step. Perform any

displayed, as is the unit cell volume tasks that are necessary.

and, optionally, the Bravais lattice type.

Proceed with indexing according to the

Index options set in the preceding menu
If, instead of the unit cell parameters, itgms. P 9

an entry is labeled empty, this indicates
an unassigned entry. Choosing the Leave Manual Mode and return to the
empty entry creates a new unit cell Cancel initial Unit Cell Determination page,
instead of replacing the current one. performing no operations and ignoring
any changes made to menu items.

Store (Unit Cell
Combo Box):

A color is associated with each unit
cell. The color is displayed in the box to Table 6.3 — Index menu items
the left of the unit cell. The color helps
in recognizing a unit cell while navigat-
ing through the software. It is also used
in the image display to color the overlay
and indicate the unit cell that was used
to calculate the overlay.

Right-click to edit or clear unit cells.

Select corrections to detector parame-
ters. Corrections are available from the
Corrections: stored parameters (i.e., BIS’ configura-
tion file), from the last harvest, or from
manual input.

Select methods employed in indexing:
Methods: difference vectors, fast fourier trans-
form, or least squares.

left Go to the previous step in the unit cell
il fleft arrow] determination process.

iaht Go to the next step in the unit cell
il [right arrow] determination process.

Table 6.3 — Index menu items
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Bravais

Initial Unit Cell o=30.00", p=90.00", y=00.00"

|:| a=5.954, b=9.028, c=19.364
=386%, Orthorhombic P

Initial Unit Cell:

Menu ltem Function

Use the Unit Cell Combo Box to select
a unit cell to which to assign a Bravais
lattice type.

Bravais Lattice |FEIM Ia[ﬂ] |b[§] |c[§] |\J["] |B['] IY[“] I

Cubic F 0M 2131 2131 21.31]129.90 60.96147.57
Cubic | 0.0 19.20 10.81 2045 65.40 31.37 80.23
Cubic P 000 555 9.02 183§ 90.00 90.00 90.00
Hexagonal P 0.1 555 9.02 183§ 90.00 30.00 S0.00
Rhombohedral R | 0.01) 555 710.81 5613 94.35 96.08123.41
Tetragonal | 0. 585 502 3828 7E37 81.06 50.00
Tetragonal P 0.0 555 5.02 1838 90.00 30.00 50.00
Oithorhombic F 002 555 15.00 3720 87.13 99.20108.25
Oithorhombic | 002 535 502 332870363 35.94 90.00

Oithorhombic C

585 37.20 802 90.00 30.00 33.20
g 3 i0.00 50.00

0 90.00 80.80

0.04]
0.03
1.00
1.00

Monaclinic C . .
Monoclinic P 16.36 90.00 90.00 50.00
Triclinic P 18.36 90.00 90.00 90.00

| b Fisn

Figure 6.9 — Bravais menu

Accept Cancel |

Bravais Lattice:

This list shows the 14 Bravais lattice
types for the selected unit cell parame-
ters. For each entry, the list contains
(from left to right) the Bravais lattice
type, the figure of merit (ranging from
0.0 to 1.0, with 1.0 being perfect agree-
ment), and the six unconstrained unit
cell parameters for that Bravais lattice
type.

Bravais lattices that are in agreement
with the unit cell are displayed in green,
which those that do not are displayed in
red. The most likely Bravais lattice type
is chosen automatically. If necessary,
you may override the program’s deci-
sion by clicking on a different entry.

Go to the previous step in the unit cell

il [left arrow] determination process.
right arr Go to the next step in the unit cell deter-
3'[ ight arrow] mination process.
Finish the sequence of steps in the unit
Finish cell determination process, beginning
with the current step. Perform any tasks
that are necessary.
Accent Accept the choice of Bravais lattice type
P given in the menu items above.
Leave Manual Mode and return to the
Cancel initial Unit Cell Determination page,

performing no operations and ignoring
any changes made to menu items.

Table 6.4 — Bravais menu items

M86-E01078
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Refine

a=5.954, b=9.024, c=16.364
Unit Cell o=90.00°, p=80.00°, y=90.00° -
=986%7, Orthorhombic P

Unit cell

|+

5.95
9.02
1836
a0.00 —
a0.00

F a0.00

Ly 18] 985

O Domain translation

b x [mm] 0.00

Fey [mm] 0.00 |

Parameters:

Reflections: | Graup 0: 270 reflections ;I

Go to Image: IC.\Frames\gusst\y\id_sxampls\malrix_m_0001 sfim ;I

More Reflections Fewer Reflections

Tolerance:  [2.78 }

2658 Reflections selected for Refinement

¢ Show selected Reflections

' Show predicted Reflections

RMS Y [mm]: nta RMS angle [} n'a

Toals: Refine Histograms... Transformations...

il LI Finish | Accept Cancel

Figure 6.10 — Refine menu

Menu ltem Function

Unit Cell:

Use the Unit Cell Combo Box to select
a unit cell to refine.

Parameters:

Within the Parameters window, several
areas are available for refinement: Unit
Cell, Domain Translation, Domain Ori-
entation, Detector Translation, Beam
Center, Detector Orientation, and Goni-
ometer Zeros. By activating or deacti-
vating the checkbox on the left, the
parameters in this group are selected
for refinement or are constrained to
their current values during the refine-
ment.

Reflections:

Use the Reflection Group Combo Box
to the select a group of reflections for
refinement.

Go to Image:

Select a frame filename from this drop-
down menu to display the frame in the
Image Display Area.

Tolerance:

Upon startup, the Refine dialog deter-

mines a useful value for the tolerance.

this may take a few seconds depending
on the number of reflections.

Show selected
reflections

In the Image Display Area, reflections
selected for refinement are marked
with circles.

Show predicted
reflections

In the Image Display Area, predicted
reflections are marked with circles.

Table 6.5 — Refine menu items
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Menu ltem Function

RMS XY [mm],
angle [°]:

The root mean square of the deviation
between observed and predicted spot
positions in the XY image plane and
along the trajectory of the spot while it
passed through the Ewald sphere.

Tools:

Refine — Refine the unit cell using the
selected parameters.

Histograms... — Displays histograms of
reflections’ variances in H, K, L, detec-
tor X, detector Y, and rotation angle.
Transformations... — Opens a dialog for
transforming the unit cell.

4| left arrow]

Go to the previous step in the unit cell
determination process.

b | Iright arrow]

Go to the next step in the unit cell
determination process.

Finish

Finish the sequence of steps in the unit
cell determination process, beginning
with the current step. Perform any
tasks that are necessary.

Accept

Accept the options set in the preceding
menu items, and proceed with a single
cycle of least-squares refinement.

The Refine dialog has a built-in safety
which checks whether enough
reflections are available for the refine-
ment. If the number of reflections is
critically low, a warning is displayed
with the option to override.

Cancel

Leave Manual Mode and return to the
initial Unit Cell Determination page,
performing no operations and ignoring
any changes made to menu items.

Table 6.5 — Refine menu items
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6.3 Determine the Data Collection
Strategy

APEX2 includes a powerful algorithm for deter-
mining an efficient strategy that fully utilizes the
flexibility of your instrument.

6.3.1 Operation and Initial Settings

1.  Under Collect in APEX2’s Task Bar, click
Data Collection Strategy. The Data Col-
lection Strategy module opens in the Main
Window (Figure 6.11).

The Data Collection Strategy module uses
information from the Determine Unit Cell module
(Section 6.2) to set defaults. However, you can
modify the suggested values.

2. Check the inputs for defining the data
collection.

2.1 Set the data collection distance.
For SMART APEX Il systems, this
should be set to the actual detector
distance. For Kappa APEX Il sys-
tems, the distance is variable and
will default to the shortest reason-
able distance. For the APEX I
detector, the distance in millimeters
should generally be about the
same as the longest cell dimension
in angstroms. Typically, distances
ranging from 35 mm to 45 mm are
reasonable.

2.2 Set the exposure time and press
[Enter]. For normal crystals and an
APEX Il detector, five seconds is a
reasonable time.

2.3 Click Same to set all of the times to
be the same.

NOTE: If the “Same” feature is not chosen, the
times for shells can be set to collect
high-angle data with longer exposures
than inner shell data.

2.4 Setthe desired resolution (0.75A is
a reasonable value).

2.5 Check the other values (Laue
class, Lattice, etc.).

2.6 Each time a value is changed, the
Data Collection Strategy module
recalculates the statistics for the
runs. The results are displayed in
the column labeled Current.

NOTE: The rescanning of runs can be inter-
rupted by pressing [Esc]. No statistics
will be displayed.

M86-E01078
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ser: {guest) - Sampl

(1! Sample Instrument Windows View

icensed to Single Crystal App-lab at Bruker-AXS - [Data Collection Strategy]
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=
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o
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Aouepunpay

a
=)

Distance [mm]: |37.50 d[A] 0.75
Mosaicity '] [0.68 2Theta [°]: |56.57
Image Width [} [0.50 sinft) [174]: [0E7

Linit Cell

Bijwoet Pairs: | merged hd
Laue Class: | mmm hd
Lattice Type: | P -

Total Reflections: 9716 Unique: 1434

Runs: 96 Images: 37500

Fieg. Disk 5pace: 9741 ME

Exposure Times [5]
Int & 1.374 0714 0504 0.414 0374 0.384

o 30 E0° a0 120° 150° 180°

000/ 0364 0F0A 0934 1224 1384 1414

F 2F =AF =2F AF AF FF 3

same | Ewerd | Redwe | Reset |
Curtent Target Priority
Completeness [ 100,00 [100.00 [1o0 -
Redundancy 184.36 [4.00 EZ |
Tirme ] 1,60 [24.00 J |5 =
Stralegy [ Custam |

Execute: | Refine Strategy

L]

Ston |

Figure 6.11 — Data Collection Strategy module
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6.3.2 Refining the Strategy

At this point, if all of the runs available were col-
lected it would take 91.60 hours and the data
would have a redundancy of 184.36. Of course,
this is not desirable.

1.

Execute:

Below the “Target” and “Priority” columns is
a pull-down menu with several different
strategies. Choose the one that best meets
the needs of the experiment (for the YLID
example, Best in 2 hours was selected).
The “Target” column changes to reflect
your choice.

Click in the Execute: field. A list of options
appears. Click Refine Strategy. The strat-
egy begins to refine, approaching the target
Completeness, Redundancy, and Time set
in step 1.

3 I Refine Strategy

e

ar Completeness

Figure 6.12 — Click Refine Strategy

3.

When you are satisfied with the Complete-
ness, Redundancy, and Time displayed in
the “Current” column (whether the module
is finished refining or not), click Stop. It is
neither necessary nor advisable to wait
until the refinement reaches 100%.

NOTE: When refining the strategy, the objective
is to get good completion (98% or better)
with high redundancy in a reasonable
amount of time. When the Data Collec-
tion Strategy module is first started, it will
tell you the Completeness, Redun-
dancy, and Time for all of the available
runs.

It is almost never necessary to let the
Data Collection Strategy module run to
completion. Typically, it should be
stopped when completion is greater than
99% and the time is close to what is
desired.
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100 —f@
] Lo
T L
£ Fa
Py
2 2
[++] [=8
c c
5 2
5 g
g. 2
E 2
S
4 [z
1L Y L

1.6 1.4 1.2 1 0.8
Resolution [A]
 Redundancy

Completeness [%]
Asuepunpay

Time [h]
Figure 6.13 — Completeness and Redundancy chart
In the YLID example shown in Figure 6.14, the

Completeness is 99.76% and the Time is
approximately 2.33 hours.

NOTE: Time estimates are approximate. They
depend on the number of rescans, gen-
eral instrument overhead, backlash com-
pensation, etc. If estimated times are
consistently longer or shorter, modify the
COSMO hardware profile.

Current Target Pricrity
Completeness (%] 10000 [100.00 [1o0 El
Redundancy: F 44 ISDDD— m
Tirme [h} 200 [200 J [0 El
Shralegy [Bestin 2 howrs |

Figure 6.14 — Strategy Status and Priority control

4. Click in the Execute: field. A list of options
appears. Click Sort Runs for Complete-
ness.

Execute: I Refine Strategy

Figure 6.15 — Click “Sort Runs for Completeness”
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— ) NOTE: If for some reason it is necessary to start
] Lo over, change the distance slightly (by
BO | L 0.02 for example) and press [Enter]. The
£ . Data Collection Strategy module will
g = g8 reload all of the possible runs.
E 2
&}
] T,
B L

1.6 14 1.2 1 0.8
Resolution [A]
# Recundancy

Completeness [%]
Aouepunpay

Time [h]

Figure 6.16 — Completeness and Redundancy charts after
sorting for completeness
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6.3.3 Looking at the Current Strategy

1. To look at the actual runs chosen, select
View > Detailed Strategy.

This opens a window that shows the runs to be
collected (see Figure 6.17).

:ﬁturrent Strategy

Scan Type | CCD | 2Theta | Omega | Phi | Chi |Ams |Widlh | Hlmages | Sweep | Time: |
1 |Experiment 3780 +45.50 -288.43 477 -22.88 Phi +0.50 713 35950 128
2| Experiment 3780 700 -156.24 +27.83 +39.23 Omega +0.50 64 3200 128
3_ Experiment 3750 -4350 37948 147,44 -20.99 Omega +0.50 84 42.00 138
I Experiment 3780 +36.00 -304.81 .54 -28.52 Phi +0.50 473 23650 138
5 |Ewperiment 3780 +40.50 -328.49 -340.58 +43.25 Phi +0.50 713 353.50 138
& | .
7|
e
El
10|
(11|
[z |
13 |
ETHIE

Figure 6.17 — Current Strétegy window

Each line in this list represents one run. It is
specified by:

e Origin

¢ Crystal-to-detector distance

* Angular positions of the goniometer axes
* Name of the scan axis

* Image width

e Number of Images

¢ Total Sweep

e Exposure time + overhead
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Each run is displayed in a color that indicates its
behavior during the strategy refinement:

Black runs are permanent and always active
during the refinement process. They are not
altered during the refinement. This options is
intended for runs that have already been col-
lected and therefore definitively contribute to the
data set.

Red runs are considered as-is and, unlike the
permanent runs, can be disabled by the refine-
ment algorithm. However, the configuration of
such a run remains unchanged (i.e., the scan
range will not change).

Blue runs can change their scan range during
the course of the refinement. They are therefore
called partial runs. This is the default option for
all runs from the basis set, because it provides
the refinement algorithm with the highest flexibil-
ity in finding a strategy that fulfills the criteria for
the data set completeness, its redundancy, and
the total data collection time.

Gray runs are disabled and are not taken into
account at any time during the strategy refine-
ment.

To change the behavior of a run:

1. Place the Data Collection Strategy algo-
rithm in idle mode, i.e., make sure that it is
not calculating the reflection list, refining a
strategy, or sorting the run list.

2. Select the run or runs you wish to change
by clicking inside the Current Strategy win-
dow or by dragging the mouse while hold-
ing down the left mouse button.

3. Right-click inside the Current Strategy win-
dow to open the contextual menu.

4. Select the desired behavior (permanent,
as-is, partial, or disabled). The Current
Strategy window and the contents of the
Main Window will then be updated.

You are now ready to perform the experiment
using the optimum strategy.
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Data Collection/Run
Experiment

1.  Under Collect in APEX2’s Task Bar, select
Experiment. The Experiment module
opens.

6.4

First Rur: 1 T

n
E Copy n Yes
£ (B Paste n Yes
T Clear n ez

Figure 6.18 — Deleting the matrix runs

:iAPEXZ ¥2.0-2 - User: (guest) - Sample: ylid_example - Temporary license {78 days remaining) - [Experiment]

mgamp\e Instrument  Windows

2. Click Append Strategy. The runs deter-

mined in Section 6.3 appear in the list of
operations to be performed.

3. APEX2 changes the filename to the name
of the current sample (in this example,
“ylid_example”).

NOTE: You can load and save your own experi-
ments (in *.exp format) by using the
Load Table... and Save Table... buttons
at the bottom of the Setup Experiment
tab.

D e a x|

de(mdamdmf v [0S e

Setup

e Setup Experiment I Monitor Experiment

Collect

Image location: |E “Frameshguestyylid_example

Filename ar prefis: Iyl\dﬁexample

i

3

Detault time: |1EIIJEII] [sec/trame] vl
Detault width: IU 500 [dearees] 'I

[ Attenuate if topped

¥ Correlate Frames

Figure 6.19 — Experiment view with strategy appended

First Run: 1 = ™ Generate new Dark Images Detector Format: lm
Dperation [Active [ Distance mm] [ 2Theta [deg] Omega[dea] | Phi[deg] Chi[deg] Time [sec] Width [deg] Sweep [deg] Direclion -

1 [NoOperation  [ves |

2 |Omega Scan |ves | 37.500 -7.000) -1 58.24Ui 27.830 99.230 10.000 0.500 32.000) positive
Epeiiment 3 |Omega Scan ‘Yas | 37.500 -49.500) -379.480] -141.440 -20.990 10.000 0.500 42.000) positive

4 |PhiScan |ves | 37.500 38.000] -304.81 Eli -3.540 -28.520 10.000 0.500 236,500 positive

5 |PhiScan ‘Yas | 37.500 40,500/ -328.430] -340.580 43.250 10.000 0.500 359.500) positive:

& |MoOperation  |Yes | |
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NOTE: At the top of the Setup Experiment tab

are controls for data collection. Usually,
the default values are correct. For data
collection times of less than five sec-

onds, correlation can usually be turned

off. If new dark frames are required, BIS

will automatically collect them. Check-
ing “Generate New Darks” forces the
collection of darks before every run. In
Figure 6.19, the time and width are
explicitly set for each run, so changing
the default width and time will have no
effect. If the explicit time or width for a
run is deleted so that the box is empty,
the word “default” appears and the
default values at the top right will be
used.

5. To begin the experiment, click Execute.
APEX2 shifts to the Monitor Experiment tab
and diffraction images begin to appear.
This may take a minute or two if new darks
are being collected, or if the generator is
being ramped up from a low-power state.

NOTE: If resuming after a data collection inter-
ruption, APEX2 will automatically skip
images that were previously collected
with matching angles and generator set-
tings. Otherwise, APEX2 will ask if you
want to overwrite the images.

If you choose to enter your own runs, click
Validate to test the strategy for illegal
movements by the goniometer. If all
motions are valid, the “All operations are
valid” window will appear (Figure 6.20).

NOTE: After data collection is started, the
Experiment window can be closed and
APEX2 can be stopped. The Server
computer must be left on; in a single-
computer setup, BIS must be left run-
ning. If communications are lost
between the Client and the Server,
frames will be stored on the Server. Typi-
cally, they will be in the directory
C:\frames\. They should be copied into

Falnfo []

\i‘) All operations are valid,

Figure 6.20 — Operations valid window

the correct project directory before start-
ing integration.
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:ﬁnPEXZ ¥2.0-2 - User: {guest) - Sample:

|_example - Temporary license (78 days remal

AU sample Instrument  Windows

=181

JJ R = |l|@ & K ‘HIC:\F|ames\guest\pl\dﬁexample\ylidﬁexamp\efmJDUS.slrm = [ [ O I R e W[ T A ‘ @ S, @M k?|

Oriented Scans

Setup Experiment

Manitor Experiment

| | [RNHEN IT‘IIHH‘ g [ AT Lo
o 4 99 933 9939 99333 599333
O Cursar
Integrate ++ Position [mm] 3060 2E7E
E Position [pivsls] 511 473
T ntsn.sily [counts] 46
HEL index am 8.54 5.29
Solve Stucture i Resolution [4] 0.83
Refine Stiucture - 2Theta['] 50.63
Report Imane Header A Tool Editor A Cursor Position
Inistiument

Evaluste
Collect Unit celt
a=6.9%%, b=9.104, c=18504
280 a=50.00°, B=90.00°, y=90.00° »
W=100882, Orthorhombic P
260
240
220
Experiment
200
180

Figure 6.21 — Monitor Experiment tab
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7 Data Integration and Scaling

Before the data can be used to solve and refine
the crystal structure, it is necessary to convert
the information recorded on the frames into a
set of integrated intensities, and to scale all of
the data.
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7.1  Integration

1. Under Integrate in the Task Bar, click
Integrate Images. The initial integration
window opens.

& APEX2 v2.0-2 - User: (quest) - Sample: ylid_example - Temporary license (74 days remaining) - [Integrate Images]

By Sample Instrument Chart Windows

IDza]loa x|w

Setup | Setup

Evaluate

Starting Image Filsname Images_| Output Filename

Collect

Riesolution Limit [&], [0.622

Integiate

Unit Cells:

2=5.934, b=9.104, c=18.504
u

V=10084%, Ortharhombic P

Fefinement Options. .

Integralion Optiors... |

Find Runs...

Scale k1|

E xamine Data 32

Impt Funs from Epeiment

Solve Stucture 33

Refine Stucture 34

Freport 35

| Start Integration

Instiument

o=30.00", B=80.00", v=30.00°

Figure 7.1 — Initial integration window
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2. The Resolution Limit parameter in the
upper right sets the upper limit of resolution
for integration. The APEX2 Suite suggests
a resolution cutoff. In this case, we will
change the selected value to 0.75A.

Riesolution Limit [3]. |0.750

Figure 7.2 — Resolution Limit parameter

3. On the right-hand side of the window are
two buttons for defining the data collection
runs to be integrated.

Refinement Dptions |
Integration Optians: |

Find Runs. |

Import Runs from Expanmantl

Start Integration. .

Figure 7.3 — Find Runs and Import Runs from Experiment
buttons

The Find Runs... button is used to browse to
the set of runs to be integrated. This button is
normally used when the data collection is fin-
ished.

The Import Runs from Experiment button
determines the runs to be integrated from the
experiment that has just been submitted. Using
this button allows you to start integration while
the data is still being collected.

NOTE: When integrating while collecting data,
the SAINT integration module will inte-
grate all of the data currently measured
and then wait for the next image, inte-
grate that, wait for the next, etc.

4. Click Find Runs. The Find Runs window
(Figure 7.4) opens. Usually, the Find Runs
window has the correct directory and base
name as the defaults. If these are not cor-
rect, then use the Browse button to find the
runs for the experiment of interest.

The window pane on the right side displays
all of the runs available in the current direc-
tory. Any combination of runs may be
selected by simply checking the check-
boxes next to the groups and clicking OK.
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:ipythnn

Loak if: | 3 C:#Frames/guest/ylid_example’

=l GmEek

L4

) @ matrix_01_0011.sfrm

Run

@ matrix_01_0001. sfrm @ matrix_01_001 Z.sfim
@ matrix_01_0002. sfrrn @ matriv_02_0007. sfrrn
&) matix_01_0003 sfm [ &) matrix_02_0002 sfim
@ miatrix_01_0004. sfrrn @ matrix_02_0003.sfrrn
@ matrix_01_0005. sfrrn @ matriv_02_0004. sfrrn
&) matix_D1_000G sfm ] matrix_02_D005 sfim
@ matrix_01_0007. sfrmn @ matrix_02_0006. sfrrn
@ matris_01_0008. sfrrn @ matriv_02_0007. <frrn
[ matix_01_0009 sfm [ matrix_02_D00B shim
@ matrix_01_0010.sfrrn @ matrix_02_0009.frrn

L matrie_01_fHH## (1 -12)

O matrie_02_fHH## (1 -12)

[ matris_03_fHH#t# (1-12)
viid_example_01_#tHEH (1 - 64)
vlid_example_02_ it (1 - 84)
vlid_example_03_#H#H (1 - 473)
vlid_example_04_###H (1 -719)

Directary: |

File type: I Ditectaries

=l Cancel

4

Figure 7.4 — Find Runs window

5. Both the Import Runs from Experiment
and the Find Runs buttons generate a list
of runs as in Figure 7.5.

IEET
Starling Image Filename Images | Output Filename
C:\Frameshguestiylid_exampledylid_example_01_0007 sfrm 64| C:AFrameshguestiylid_exam
C:\Frameshguestiylid_exampleylid_example_02_0001. sfm 84 C:\Frameshguestiylid_exam
C:\Frameshguestiylid_examplewlid_example_03_0001.sfrm 473 C:AFrameshguestiylid_exam
C:A\Frameshguestiylid_exampleylid_example_04_0001 sfrm 719 C:\Frameshguestiylid_exam

@ |]mfo]e]o]a]=

Figure 7.5 — Runs list with runs imported

NOTE: To integrate runs from a CD or DVD,
browse to the device and find the runs to
be integrated. APEX2 will automatically
write the result in the work directory for
the current project.

Figure 7.6 shows a run list entry being modified.
(A) shows the original run information. (B)
shows the run with the starting image number
changed to 51. (C) shows the number of frames
to process changed to 111.

Double-click any of the fields in this list to open
up the value for editing.

A C:hetruchguestidata_manualbyid_manoalswlid_manua 4
manualylid_manualyhd_manual_04_0007 sfm| =

B  Cihstuchguestidata_manualwid_manualylid_manua w4
_manuaI'\_I.JIid_manuaI&ylid_manual_[l{@DE'l .@m =
S
C %\struu:\.gue3t'~.data_manuaI\.}llid_manual\._l,llid_manua
Chatruchguesthdata_manuallid_manualslid_manua 111

Figure 7.6 — Example of manually editing a run list
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7.1.1  Check the Refinement Defaults

Two buttons on the right-hand side of the initial
integration window are used to change the
default options for refinement and integration.

Refinement Options, |

Integration Optiohs... |

Find Rung. |
Impart Runs from Experimentl

Start Integration.

Figure 7.7 — Refinement and Integration Options buttons

The default values are generally very good.
There is seldom any need to change the values
in the Refinement Options window.

*“{"Refinemant Options

—PerImags Refinement

[7]x]

[V Enable Box Size Refinement

Iritial 52 Bow Size [T |0.529 0.529 0.909

Damping Factor: [1.000

—Periodic Refinement

[¥ Enable Periodic Refinement

I¥ Enable Initial Pas:

Frequency Images]: |50 3:

Canstrain Metiic Symmetry of Unit Cell to,
& Oitherhambic:

€ Copstal Systemn: [ Trichiie -

i~ Gilobal F
[¥ Enable Global Refinement

Max. Number of Reflections: |3333 3:

Constiain Metric: Symmetiy of Uit Cell to
& Oithathombic

" Crystal System: Triclinic X

Refinemznt Parameters

Refinement Parameters

O Detector
Horizontal Beam Center
WVettical Beam Center
Distance

Pitch

Rl

Yaw

Unit Cell

Aues

B Ao

=

O Detector
Horizontal Beam Center
Wettical Beam Center
Distance
Fitch
Rl
Vaw
O Unit Cell
Anes

R Ao

Cormponert Constraints

Component Constraints

[ Twin Component 2
Q' Unit Cell as Companert 1
QO 4l ss Companent 1
® Refine separately

[ Twin Component 3
Q Unit Cell as Componert 1
QO 4l 53 Companent 1
® Refine separately

[ Twin Component 2
QO Unit Cell as Companert 1
QO 4l as Companent 1
® Refine separately

[ Twin Comporent 3
QO Unit Cell as Componert 1
QO 4l 53 Companent 1

® Refine separately

|

Figure 7.8 — Refinement Options window
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7.1.2 Check the Integration Options

1. The Integration Options window has a few
values that are changed more frequently.
We will change the default options for inte-
gration in the Integration Options window.

"7 Inteqration Options

- Mixded Protbes
¥ Enabla LS Protie Fitrg

™ Blend Pacfiles from AN Detecioe Regions | |
g Qs

Uit S
Fiction of Model Pochle Masirum ot Svols SumMaak: [ D050
Iensty/Sima Upes Lind for LS Model Protie Fi [ 0.000
Lirvess Flmeoskden Livd o LS Mol Prdie FJA) [ i

Pt X2 Hwiahe [ 4 [ [ 4

[Fcee Do |

il 3
- Backgriud Updain

Background Lipdate Scalng Factor 1.000

Activt Imige Dusue Hatwidh fnsgeit [7 |

~Bram Montor

I™ Enable Boam Monkor Nomalzation
gl :

I

5" Inteqration Options
il Profies
¥ Enabis LS Probin Fitng
™ Blend Profles feom A} Distectos Pregicns

Fimction of Modal Profle Masionm o Simpls Sum Mtk I [l

L5 I B0 |

Limose Flnsoksion Liss ber LS Mol Pretin Fi 8] [ s
Prois vtk [ 4 [0 [ 4

Atre Mask.
= Geraigte Masic

Fractionsl Loves Limé of Avrsags iriensiy: [ [T

T Usn Pan E st Wik

Backgurd Uidate:
Bockgpound Updste Sceing Factor | 1,000

- bnage Guman

Actree b Dusesss Hatwickh mages] [7 E

Bram Mondn:
™ Erabls Baam Monton Homakizahon
ol

Twin Oyerag Detemination

Mirwrm Comimon Yokese [%] I A
Seomaton Factee | 1.000
Masrrem Hange: | 130

I =]

1% Llzn Namow Finme Algosthm
= Uze'Wide Fiame Algodhm

- Dutga £

I Germaln Dhagrosts: Flal Fies
™ ¥eep Temporary Fley

[T Append Listing Filss

I~ e Lo Wrdow

Figure 7.9 — Integration Options window

2. Click the More Options button. This results
in an expanded window (see Figure 7.10)
and gives access to several other useful
features, in particular Active Mask (see Fig-
ure 7.11), Algorithm (see Figure 7.12), and
Image Queue (see Figure 7.13).

Fiebereres Conrchon [Nalwn Detechn crky] Varbosky of Lisng Fie: [2 |
(= Conection Fr ¥ ||50 3
o _I Cancel

Figure 7.10 — Integration Options window (expanded)

Active Mask

Active Mask
(¢ Generate Mask:

Fractional Lower Limit of Awerage Intensity: I 0.000

= Use Pre-Existing Mask:

Lctive Mask File [7_am]: » |

Figure 7.11 — The Active Mask tool

The Active Mask is used to mask out areas that
are covered by the beamstop, low-temp nozzle,
or other obstructions. Typically a value of 0.7 is
good here. SAINT will determine an active mask
for each run.
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NOTE: If this option is set, you should examine
the active mask images that are written
into the work directory with the name
basename_am_##.sfrm. There is one
for each run. These images can be
opened with the image viewer. They
should be blank except for an area in a
different color showing the shape of the
obstruction, typically the beamstop.

Narrow/Wide Algorithm

Algorithm
T = Lze Namow Frame Algorithnn

% |lze Wide Frame Algarithm

Figure 7.12 — The Narrow/Wide Algorithm tool

The algorithm buttons are used to change from
narrow to wide frame integration. Frames col-
lected with narrow scan widths (less than 1.5°)
should be integrated as narrow frames. Those
greater than 1.5° should be integrated as wide
frames.

Image Queue

mage Queue
Active Image Queus Half\width [Images]: I? 3:

Figure 7.13 — The Image Queue tool

The Image Queue sets the number of frames
being used to determine profiles. For crystals
with high mosaic spread (i.e., large, wide reflec-
tions), increasing the queue size can improve
integration.

7.1.3 Start Integration

1. Click the Start Integration button on the
far right of the bottom row. This starts the
integration and opens the SaintChart win-
dow (discussed in Section 7.2) for monitor-
ing the integration.

2. Examine the output. Double-click any of the
output entries (in the “Output Filename”) for
one additional tool: the Is button at the far
right of the line (see Figure 7.14). The Is
button opens the SAINT listing file for that
integration run.

uaI'\_I,IIiu:l_manual\work\_l,llid_manual_m.raM ﬁ’-l 1s I

Figure 7.14 — The runs list’s ‘Is’ button
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7.2 SaintChart

SaintChart is a powerful tool for monitoring the

progress of the integration process and for

graphically presenting the results of the integra-

tion process.

B Sample Instrument Chart Windows

ample - Temporary license (4 days rem

egrate Images]

Io=a]loa x|

|l Setp Y Tntegration

Evaluate

Collect

Integrate

S

0.80

Average correlation
coefficient

BESpot Shape Correlation [x]
1.00

T T T T T
100 200 300

Image

T 1
400 500

® Comelation cosfficient

BriSpot Shape Profiles by Detector Region [x]

EAverage Spot Intensity and 1/Sigma(J) Yalues

Average spot intensity

100000.00

80000.00

60000.00

40000.00

20000.00

0.00

Image

= |/sigma

= Intensity

1400
1200
1000
80.00
E0.00
40,00
2000
0.00

0
i
0

(1Jewbigj) sbeloay

Scale

Examine Data

Solve Shucture

Fiefine Stiucture

Report

4

3.1482224003

3.12990=+003

0.49 2 [t}

New orientation is in C:“Frames>guest“ylid_e=xample~work ylid_0On.
End global unit cell refinement =

pdp
= 05/23-06 10:08:33

Instiument

5|

o

[ Integration Finished

[ & Components

O Progress Statistics
O Integration progress
[ Perlmage Statistics
Spot shape conelation
Spot intensity and |/Sigmaf)
[ % Spotintersity < 2 Sigmall]
O Mumber of reflections harvested
O Spot position overlay
®, 2 enor
O #.'7.Z RMS difference
O %7, Z spot size
O % Queue extent used
O Primary beam intensity
Feriodic Statistics
Prafile snapshots
O & ads+ESD
O B axis +ESD
O Cads+ESD
O Alpha angle + ESD
O Beta angle + ESD
[ Gamra angle + ESD
O Cell volume + ESD
O LS gondness-ofit
O LS Residuals
O .. Z ciystal tanslation
O %% beam center
O Distance conection
[ Pitch, Roll, Yaw corection
O Angle zeros
Coverage Statistics
0 Harvested reflections
10 Completensss and redundancy
O Bijvost pairs

o

(m]

Conneeted: ™ Integration in Progress: ™

Stop ntearation Close:

Figure 7.15 — SaintChart view
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7.2.1  Monitor the Progress of the
Integration

Change the text area by clicking and dragging
on the line between the text and image areas.
You can also expand the windows to fill the
available image area by clicking Chart > Tile

BE inthe Menu Bar.

To the right of the image area are a series of
checkboxes that select the displays. Click the
checkboxes to add or remove displays.

Average Difference

Errors in X, Y, and Z should be small (less than
1 pixel) and should not vary during the integra-
tion of a run. Large variations indicate problems
with slipping crystals, misalignment of the instru-
ment, or other problems.

Spot Shape Profiles by Detector Region

Look for spot shapes that are well-contained
within the box. Split spot shapes indicate diffrac-
tion from split crystals or twins.

Spot Shape Correlation

the Spot Shape Correlation graph is the best
indicator for a successful integration. After initial
passes during the actual integration, one
expects a high correlation factor at a constant
level, i.e., >90% for very good crystals and
>80% for good crystals. Correlation factors
below 40% indicate that the orientation matrix
does not describe the diffraction pattern cor-
rectly.

Integration Progress

1. Check Integration Progress to add the
new display seen in Figure 7.16. When the
integration is complete, the blue progress
bars will be full and the remaining time will
be zero.

Buf Integration Progress
Run Images | Progress | ETA (Remaining)
|vid_example_(01_0007.shm 64 (64 ANNEEN nta
|vid_example_02_00071.shm B4 (04 ANNEEN nta

lvlid_example_03 0007.shm 330 (473 AEEN 17:40:13 (00:00:17)
viid_example_04_0007.sfm  O[F19] 17:43:20 (00:03:24)

LAl 456 1340 AR 17:43:20 [00:02:24)

Figure 7.16 — Integration Progress display
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Spot Position Overlay

Check Spot Position Overlay (in the “Per-
Image Statistics” category) to add a window for
monitoring the progress and quality of the inte-
gration. Pull up on the Window Tool Bar for Inte-
grated Spots to display the entire window.

In this full view, the Integrated Spots window
looks much like the image viewer used previ-
ously. At the bottom of the window is an entry
box that can be used to change the display fre-
quency of the Integrated Spots images (the
default is to display every fifth image).

The shape of the overlay represents the reflec-
tions’ sizes and shapes determined during the
integration.

I Setup " Tntegration

ﬂC.\Flamss\gussl\y\id_sxamDls\y\id_sxampls_US_UUEBsfrm Bl == s B o I P P

Figure 7.17 — Spot Position Overlay
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7.2.2 Examine Final Results

At the end of integration, examine this text criti-
cally. In particular, look at the Overall Rsym, the
Coverage Statistics and the Unconstrained Unit
Cell refinement.

1. View the SAINT text output. At the bottom
of the SaintChart window is the scrolling
text window that displays text output from
SAINT. (This window can be expanded by
dragging the horizontal bar above the text.

2. Examine the final results.
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Overall Rgy, and Coverage Statistics

The overall Rgyp, is usually less than 8%.

Higher values may indicate problems with
absorption, twinning or poor crystal quality.

The coverage statistics are reported by resolu-
tion shells.

The values in the Rsym column give the
cumulative agreement of equivalent reflec-
tions.

The Rshel I values give agreement within a
particular shell. These change faster than
the Rsym values.

The %<2s column is useful for checking
where the weak data becomes predominant
(greater than 50 or 60%).

The #Sigma column gives the average I/
sigma for each shell. If that number is less
than 1.5 or 2, then little significant data is
being measured in that shell.

overall # Pairs Unig  Merg %<2s <Ix <#5igs <Bg>  Rsym
e elely] G853 12559 1400 6739 §.3 5521.86% 45,467 2.53 0,023 Overall
1.000 R
sym
centric # Pairs Unig  Merg %<2s <Ix <#5ige <Bg> Rsym
0, 000 1424 339 428 1370 13,3 7973.527 63.33 2,67 0.020
1.000
Coverage Statjstics for »19d Om.raw
....... shell......
angstrms  #0bs Theory %¥Compl Redund  Rsym Pairs %Pairs Rshell #Sigma %<2
to 1.615 175 180 90,44 F.27 0 0.019 178 OH.8% 0,010 103.49 3.6
1.283 332 332 100,00 .30 0,020 320 099,10 0.024 42.35 2.3
1.121 477 478 99,75 7.0l 00021 472 98.74  0.026 20081 2.2
1.01% a1y 613 90,84 .61 0.021 606 97,90 0,030 19.90 4.0 (30verage
0.946 768 769 09,87 6.18 0.021 745 95,88 0.037 15.78 7.2
0.8%0 909 o1l0 99,89 5.85 0.022 875 95.,15% 0.045 11.91 9.3
0,845 1044 1045 99,90 3.08 0 0.022 0o 94,83 0,030 0.1 9.2
0. 809 1152 1196 98,67 5.30 0.023 1118 93.48 0.060 8.08 12.0
0.778 1320 1328 99.40 5.08 0.023 1220 91.87 0.064 6.54 19.2
0,751 1400 1462 95,76 4.8% 0,023 125% 86,11 0.067 5.68 12.6

Figure 7.18 — Final SAINT Overall Rgy, and coverage
statistics
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Unconstrained Unit Cell Refinement

Check the angles in the unconstrained unit cell
refinement to get a quick confirmation that the
initial lattice determination was correct. In the
unconstrained refinement, angles that are
required to be 90° or 120° are allowed to refine.
If they differ considerably from the expected
value, then the data should be checked care-
fully.

Unconstrained global unit cell refinement ss=s=s========= 05,/30/06 18:17:01

performing final unit <ell least squares on file C:NFrameshguesthylid_exampledworksy1id_01. _ma
Input file contains 4325 reflections

refinement includes 1 sample
Sample 1 contains component 1

Global refinement for sample 1 of 1 —- single-component data...
Maximum allowed reflections = 9850
one reflection will be stored in memory per 1 reflection(s) read

orientation least squares, component 1 in sample, 1 9n dntegration (4325 input reflections)...
wavelength, relatiwve uncertainty: 0.7107300, 0.0000089%

reflection Summary:

'RLV.Exc1' are re¥1ectiuns excluded after cycle 1 because RLY error exceeded 0.0250:

Component Input RLV.ExcC] Used worstRes BestRes  Min.2Th  Max.2Th
4325 4] 4325 9.1954 0.7avs 4.430 535,184

orientation ('UB') matrix:
Q.0005223  -0,0652480 -0.0430134
-0.1290715 -0.0572444 0. 0203780
-0, 1071459 0. 0686201 -0.0247583

A B [ Alpha Beta Gamma wviol
5. 96508 5, 0378 18,3000 B89, 097 Elelpeleni G0, 002 SO0, 76
0.0005 O, gooy 0.0014 0,00l 0,00l 0,001 0.23
orrected for goodness of fit:
0.0002 [ elelekt [ eleler egelele] el elele] 0,000 0.11
Crystal system constraint: ofunconstrained)
Parameter constraint mask:
Eulerian angles: 65.108 117. 084 -134.154
Figure 7.19 — Unconstrained unit cell refinement (YLID unit

cell shown)
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7.3
The

Scale Data

scaling process uses the SADABS program

to put all of the measured data on the same

scale. This process involves five steps:

e Setup input files

e Parameter refinement

e Error model refinement

* Display diagnostics

e Exit

7.3.1  Set Up Input Files

1. Under Scale in the Task Bar, click Scale.
the initial Scale window appears. Figure
7.20 shows the right-hand portion of the
Setup tab. The defaults and file names are
typically correct.

2. Check that the defaults are correct. Gener-
ally, the Absorption Correction Type is the
only value that might be changed. Numeri-
cal Absorption Correction requires indexed
faces. Face indexing is discussed in
Appendix B.

3. Click Next.

I Base | ylid_example

" Dutput bkl file

[vid hi

Diagnaostic Plats File Mame Ipl\dﬁexamplem.eps

Title of Diagnostic Plots — [viid_example

Log File Iyl\d_axamplem.abs

¥ Use only centrosymmetiic point groups

Point Graup I mmm LI
[T Additional Spherical Absorption Comection

Mu’r of Equivilant Sphere I
W Lambda/2 Comection

Comection Factor |[I oos

Allaw for crystal decomposition
by B-value refinement I Nere ;I

Extra Linear Eorection to be Appled =
tc Each Reflectan [ene B

-Abzoiption Comection Typ

& Muliscan Absorption Correction

™ Numerical Absorption Correction [from Face Indices)

PAP il [Nane

Hext |

Finish

Figure 7.20 — Initial Scale window: Setup tab
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IEI oon
ID.UUU

|55.51
IEI 1072

7.3.2 Parameter Refinement
1. Click Refine. Figure 7.21 shows a typical
refinement result. The R-values are
reduced and the Mean Weight increases.
Typical final values are 3—4% for the R-val-
ues and 0.95-0.98 for the Mean Weight.
Setup, Murmerical Absorption Carectian Farameter Refinement Errar Madel Diagnostics
300 af —Direction Cosin
250 _f __________________________________________________________________________ Mean enor
3 ] b aximum error
5 200 bl Rl
6]
bl (CPRIEELPITRUPRIPEE EETEURRY TRRRCLE EUCPRTCECPPTETPRRFETOPRRTERRPEEORRes
= ]
1009k, -------------- - R —Data Statistic:
j I Masimum 28[° |
50 ——— — — | "'I"" | ""I"' I““luul - 1 - ) Wavelength (2 ]
1 2 3 4 5 g 7 8 9+ Feflections  [6853
Redundancy Unique [1400

Data per frame  [4.17

Approzimate Unit Cell (from direction cosines)

High resolution threshold

Fiestraint esd for scale factors
Absoiption Type:

MNumber of refinement cycles:

a b c ) B ¥

[5.961 [ao37  [18380  [edsel  [s0007  [e0.014
—Input of Diat

tean |/all) threshald 30 -

Factor g for inilial weighting scheme

0

:

0.04 -

0.005 'I
Medium Absorber 'I
50

- |

Figure 7.21 — Scale window after refinement

Finish |
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7.3.3 Error Model Refinement

1. Click Next to proceed to the Error Model
tab, and click Determine Error Model. Fig-
ure 7.22 shows typical Error Model results.

- ~Reflections after Qutlier Rejection

£
=
=
&z
T T T T T T T T
1 2 3 4 1 2 3 4
Batch Batch
I T
BOOD -+ --==-=wmmemmmmm s 4
7 L EOREPRRERPPPRSIPRRERN
@ BO00 —{f-- oo mmne oo -
c
5 | i
8
B = [ | I
=
@
o 7 i
1 T e =
S | 0A—--1 -
o
E 2000l eemeemneecenas = g
=
7 02db--1 - R
1000 - --mmmeeememnamees e
JM R AN
T T T T T T T T
1 2 3 4 1 2 3 4
Batch Batch

Figure 7.22 — Error Model results

Initial Reflectior

Tatdl 7289
Urique T4

—Outlier Rejecti

High reslution fimit

]
[1-<1> su ratio for lm—‘
rejection
grvalue: 0.0400

Totd [EC
% Rejacted IF
Uriaue sz
% Refested 00

—Enor Model gvalle——————————

Suggested [D0296
Use 0.0256

Include the following batches:

Betches [ 2Theta |Riing [Incid factors [ Diffr factors [K [ Total [1>2sial

T 70 00229 0048 0575 093 1047 070610 6%

2 435 00215 0303-0.33 0947 -1.031 0592741 686

3 0 Q0N7 0907-0.9E5 0940 -1.032 DE444355 4095

4 405 0022 0O10-0564 0.9% -1.032 D6395532 1M

| |
Determine Enor ol | Fiepeat Parameter Refiement | £ Frish |

NOTE: If the R-values in one run are signifi-

cantly higher than the others, you can

repeat the entire scaling calculation with
that run omitted. Uncheck the checkbox
next to the “bad” run and then click
Repeat Parameter Refinement.
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7.3.4 Examine Diagnostics

1. Click Finish to produce a series of diag-
nostic plots. Some of these are reviews of
the plots that have already been displayed.

The diagnostics provide valuable insight
into the quality of the data and possible
problems with the data. Click the tabs at the
bottom of the screen to view the diagnostic
data.

The Scale Variations plot (Figure 7.23) shows
the overall variation in Scale and R(int) for the
individual frames. The Scale plot should be flat
(for highly absorbing, irregularly shaped crystals
it will probably be sinusoidal) and the R(int) plot
should not show large variations (more than
2%).

Orverall seale and Riint) vanations for ylid_example

T el - = TG S S S—

Normalized Scale Factor

) /
o i~ e e WP o N
o NN \"_'"v'\.,\ 7N N NSNS b= A

Smoothed Riint )%

Run/Frame —>

Figure 7.23 — Overall Scale and R(int) variations
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The Intensity Statistics plots look at R(int) and

IE-11 as a function of resolution. Typical plots of
R(int) versus resolution increase to the right as

seen in Figure 7.24. An |IE2-1| plot should have a

constant value. IE2-1| is a strong indicator for
centric and acentric space groups. The two hori-
zontal lines indicate the expected values for cen-
tric (top) and acentric (bottom) space groups.
This plot clearly suggests an acentric space

group.

Intensity statistics for ylid_example
R(int) blue, Risigrna) red

3 /
74
&
= 67
gl
2
5 - /
g 4l
CE ___,_// /
T /___/
L I
4.0 2.1 L.6 L3 L.L LO 0.9 0.8
Resolution d[A]
1.2
% 1.0
|
EI::n o8
/——--.,_\_/_
£ 46 T
g
B g4
0.2
4.0 2.1 1.6 L3 L.l Lo 0.9 0.8

Resolution d[A]

Figure 7.24 — Intensity Statistics

The plots of Chi-Squared values for the data as
a function of resolution and intensity should be
mostly flat. The plots shown in Figure 7.25 are
typical.

Chi—squared distributions for ylid_example
Chi-squared = Mean of | N-Sum[l—<I>]? / (N-1)-Sum[su1)] } (N equivalents)

5 -
4
i
3
g
ok
81
N
o ——— ey
40 21 L.6 L3 L.l Lo 0.9 0.8
Resolution d[ﬁ\]
5
4
B
o 34
o
U 24
L-__,‘-'-—"—-_._—/\\_.‘-—‘——"'_—_‘_‘—'———__/

T T T T T
0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9
Intensity quantiles

Figure 7.25 — Chi-squared
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The Spatial Distribution plots are generated
for each data collection run. They indicate spots
that were either stronger or weaker than
expected with a deviation from the mean inten-
sity larger than three standard uncertainties.
Figure 7.26 shows two spatial distribution plots
side by side. This is the way they are typically
output by the scaling process.

Scan L, detector 2-theta -2 2007, [l—<ll 30050 (red+, Bhae-], emors (black) Scan L detector 2-eta -3 200%, M-—<b =3 00w {red+, blee- ), exon (black)
- -
4504 . ’ oL 450+
<0 2004
3504 1504
3004 3004
50 2504
2040+ 204
ELE _' : ! - 1904
et 1001
50+ 504
50 100 150 00 WO 00 350 M0 £ X 50 100 150 00 50 00 ¥O M0 450 X

Figure 7.26 — Spatial distribution plots

M86-E01078 7-19



Data Integration and Scaling

APEX2 User Manual

Figure 7.27 shows a single plot so that the dots
are easier to see. Note that the points of dis-
agreement are spread fairly evenly over the
entire detector face.

San L, dewecior I-theta -2L00°, -« »3.00w (red-+, blue— |, emom (blak)

] ] 150 0 50 W 50 w0 50 X -—=

Figure 7.27 — A single Spatial Distribution

If the spots are clustered in an area or if there
are significantly more spots of one color than
there are of another, then the data should be
examined critically. Figure 7.28 is from another
data set in which the Active Mask was not used
during integration. Consequently, the reflections
collected in that area are consistently weaker
than expected. This kind of problem may affect
the final results.

Scan 1, detector 2—theta —12.00°, ll—<I= =3.00su (red+, blue-), emors (black)

450+

4004

3504 N .

3004

2504 *

2004

1504

50

T T T T T T T T T
50 100 150 200 250 300 350 400 450 X-—>

Figure 7.28 — A Spatial Distribution plot showing a problem
area
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7.3.5 Exit

1. Click Exit AXScale to close the Scale
module.

Exit AXS:a\i\\!

Figure 7.29 — Exit AXScale
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8 Examine Data

In this step, the space group for the crystal is
determined and optional simulated precession
photographs are calculated to further evaluate
the overall quality of the data. APEX2 provides
two tools for this: Space Group Determination
(based on XPREP) and Precession Images for
looking at undistorted slices of reciprocal space.
This is the final step before beginning the struc-
ture solution and refinement process.

8.1 Space Group Determination
With XPREP

1. Under Examine Data in APEX2’s Task Bar,
click Space Group Determination.

2. Check that the two files in the pop-up win-
dow are correct (see Figure 8.1) and click
OK.

Fiﬁelett Files For XPrep

P4P file: |C \Frames\guest\yIid_examp\e\work\yhd_example_ﬂm.p4d =

HEL file: |C \Frames\guestylid_exampletwarkiplid. kil =

Figure 8.1 — Select files for XPREP input

NOTE: In this example, the integration process
has created two files:
ylid_example_Om.p4p containing the
final unit cell parameters from integration
and ylid.hkl containing the corrected
intensities. Typically, these are the files
to use for determining space groups, but
you can browse to choose other files.
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8_1 _1 Determ|n|ng Space Groups Current dataset: ylid.hkl Wavelength: 0.71073 Chiral: ?
X Criginal cell: 5.945 9.018 18.353 S0.00 90.00 90.00 Wol 984.6
1_ Lattlce type XPREP evaluates the data Esds: 0.000 0.000 0.000 0.00 0.00 0.00 Lattice: P
Current cell: 5.945 9.018 18.353 90.00 90.00 90.00 Wl 984.6

and looks at the mean intensities and the
mean int/sigma. Since these are large for
all groups except P, XPREP suggests that
the lattice is P (Figure 8.2). Press [Enter] to
accept.

+ XPREP - Reciprocal space exploration - Version 2005/2 for Windows +
+ COPYRIGHT(c| 2005 Bruker LXS 111 Rights Reserved +

Screen size: 1280 x 1024
Tindow size: 640 x 923
Font size: 8 x 16 ( 125 =x 178
Number of colors: 2586

When xprep is started without a filename on the comwand line, the filename
is prompted for and then the type of data (SHELX, SCALEPACK, XDS or XENGEN)
requested. To generate ideal data, & SHELE .ins or .res file, if necessary
made from a PDB file using SHELEPRO or XPRO, should be given.

'xprep name' reads a SHELX HELF 4 format file neme.hkl, then tries to find
neme.spin or name.pdp to extract the cell dimensions and their esds
'xprep nemel name2' reads namel.hkl and name2.pdp (or name2.spin)

-Ln on the command line allocates space for 1000000n data (default n=4).

11249 Reflections read from file vlid.hkl

Mean (I/sigma) = 20,49
Lattice exceptions: P I B c I F by Rev A1l
N (totall = 5634 5622 5620 5623 8438 7497 7501 11249

N (int>3sigma:
Mean intensity
Mean int/sigwa

o

0 5157 5089 5194 5096 7720 6834 5834 10243
0.0 2z4.9 214.3 211.3 225.4 216.9 223.9 224.6 220.3

.0 20,7 18.7 20.8 20.5 20.4 20.5 20.5 20.5

Lattice type [P, &, B, C, I, F, Ofobv.], R{rev. rhorbk. on hex. axes)]

select option [F]: I

Figure 8.2 — Lattice statistics

2. XPREP determines the reduced cell based
on the lattice entered above. Since the lat-
tice was primitive and the magnitudes of
the cell dimensions were proper (a <b < c),
the original and reduced cells are the same
(Figure 8.3). Press [Enter] to search for a
higher symmetry cell.

Matrix: 1.0000 0.0000 0.0000 0.0000 1.0000 0.0000 0.0000 0.0000 1.0000

[D] Read, modify or merge DATASETS [C] Define unit-cell CONTENTS
[P] Contour PATTERSCN sections [F] Set up shelxtl FILES

[H] Search for HIGHER metric symmetry [R] RECIPROCAL space displays
[5] Determine or input SPACE GROUF [U] UNIT-CELL transformations
[&] Absorption, powder, SIR, SAD, MAD etc. [T] Change TOLERANCES

[M] Test for MEROHEDRAL TWINNING [0] Self-rotation function
[L] Reset LATTICE type of original cell [Q] QUIT program

gelect opvion [H1: I
Figure 8.3 — Reduced cell

3. For the YLID, no higher symmetry cell is
found. The program has determined that
the YLID crystal has an orthorhombic prim-
itive lattice (Figure 8.4). Press [Enter] to
accept.

Determination of reduced (MNiggli) cell

Transformation from original cell (BKLF-matrix):

1.0000 0.0000 0.0000 0.0000 1.0000 0.0000 0.0000 0.0000 1.0000
Unitcell: 5.949 5.01s  18.353  90.00 90.00  S0.00
Wiggli form: a.a = 35.39 b.h = 81.32 c.o o= 336,82
b.c = o.00 a.c = 0.00 a.b = 0.o00

Search for higher METRIC symmetry
Identical indices and Friedel opposites combined before calculating R({sym

Option i: FOM = 0.000 deg.  ORTHORHOMBIC P-lattice R{sym) = 0.015 [ 3394
Cell: 5.949  9.018 18.353 90.00 90.00  §0.00 Volume: 954.57
Matrix: 1.0000 0.0000 0.0000 0.0000 1.0000 0.0000 0.0000 0.0000 1.0000

Option B retains original cell

gelect option [4]: ]

Figure 8.4 — Higher symmetry cells
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4. The next logical step is to determine the
space group. XPREP suggests this (Figure
8.5). Press [Enter] to determine the space

group.

Current dataset: ylid.hkl Wavelength: 0.71073 Chiral: 2

Original cell: 5.949 9.015 18.353 90.00 90.00 90.00 Wel 984.6
Esds: 0.000 0.000 0.000 0.00 0.o00 0.o00 Lattice: F
Current cell: 5.943 9.018 18.353 90,00 90.00 20.00 Vol 984.6

Marrix: 1.0000 0.0000 0.0000 0.0000 1.0000 0.0000 0.0000 0.0000 1.0000

Crystal system: Orthorhombic Lattice: P
[D] Read, modify or merge DATASETS [€] Define unit-cell CONTENTS
[F] Contour FATTERSON sections [F] $et up shelxtl FILES

[H] Search for HIGHER metric symmetry [R] RECIPROCAL space displays
[5] Determine or input SPACE GROUP [U] UNMIT-CELL tramsformations
[A] ipsorptien, povder, SIR, S4D, MAD ete. [T) Changs TOLERANCES

[] Test for MERCHEDRAL TWINNING [0] Self-rotation function
[L] Reset LATTICE type of original cell [Q] QUIT program

Select option [%]: ]

Figure 8.5 — Determine the space group

5. If the space group is known or if the com-
pound is known to be chiral, enter that
information (Figure 8.6). Generally, it is suf-
ficient to press [Enter] to start the space
group determination.

[5] Determine SPACE GROUP
[C] Must he CHIRAL (sample is optically active
[M] NOT NECESSARILY chiral (eg. may be racemate
[I] INPUT known space group

[E] EXIT to main menu or [Q] OUIT program

Select oprion [5]: ]

Figure 8.6 — Space Group options

6. XPREP has chosen the crystal system [O]
(Figure 8.7). Press [Enter] to accept.

[A] Triclinic, [M] Monoclinie, [0] Orthorhowbic, [T] Tetragonal,
[H] Trigonal/Hexagonal, [€] Cubiz or [E] EXIT

gelect oprion [0]: ]

Figure 8.7 — Choose the crystal system

7. XPREP has chosen the crystal lattice [P]
(Figure 8.8). Press [Enter] to accept.

Lattice exceptions: P I B c I F obv Rev a1l
N (total) = 0 5634 5622 5620 5623 8438 7497 7501 11249
N (int>3sigma) = 0 5157 5089 5194 5096 7720 6834 6834 10243
Mesn intensity = 0.0 224.9 214.3 211.3 225.4 216.8 223.8 224.6 220.3
Mean intfsigma = 0.0 20.7 19,7 20.8 20.5 20.4 20.5 20.5 20.5
Lattice type [P, &, B, C, I, F, O(obv.], R(rev. rhomb. on hex. axes)]

gelect oprion [F1: ]

Figure 8.8 — Choose the lattice

8. XPREP evaluates the data and looks at the
systematic absences for all possible glide
planes and screw axes (Figure 8.9). These
are displayed across the middle of the fig-
ure. By examining the number of reflections
with | > 3 sigma(l), the mean intensities,
and the mean int/sigma, which should all
be very small for a systematic absence,
XPREP derives a suggested space group,
P2(1)2(1)2(1). Press [Enter] to accept.
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8.1.2 Reflection Statistics

Mean |E¥E-1| = 0.687 [expected .968 centrosym and .736 non-centrosym

Systematic absence exceptions:

B--  ©-- m-- 21-- -¢= -a- -n- -Z1- --a —-h --n --21
n 457 455 460 16 360 374 358 19 233 230 z23 17
N I»3s 388 394 386 0 ze1  zs2 228 0 19z z03 171 ]
<I> 201.1 300.0 317.2 0.5 445.8 377.8 201.2 0.5 280.7 311.3 277.0 0.8
«Ifs» 22.1 22.6 23.6 0.4 23.9 21.5 1583 0.6 20.8 22.7 21.7 0.6

Identical indices and Friedel opposites combined before calculating R{sym,
Option Space Group No. Type Axes CSD Risym) Mieqg) Syst. Abs. CFOM
[4] Pzi1)z(1)2(1) # 18 chiral 1 5917 0.015 3394 0.6 / 15.9 0.89
Select option [A1: 0

Figure 8.9 — Systematic absences and a suggested space

group

1. XPREP returns to the general menu seen
previously (Figure 8.5). This time, D is cho-
sen to evaluate the data set. Press [Enter]
to accept.

2. There are multiple choices for data manipu-
lation (Figure 8.10). “S” chooses a display
of statistics.

Index # Data Filename or Source of Data

1 11249 vlid.hkl E5 Current dataset

[M] Sort-MERGE current data {no scaling) [€] Chamge CURRENT datasst
[L] LEAST-SOUARES scale and merge datasets  [U] WRITE dataset to file

[1] IMCLUDE Rfree flags from another file [R] READ in another dataset
[5] Display intensity STATISTICS [D] DELETE stored datasst

[F] FACE-indexed absorption corrections [F] PSI-scan sbsorption corr.
[T] Copy file, TRANSFORM hkl and cosines [4] MAD, SiD, SIR or SIRAS
[H] Apply HIGH/low resolution cutoffs [N] NORMALIZE/scale sigmas
[6] Generate simulated powder diagrams [U] Anisotropic scaling

[2] Expand data te triclinie [E] EXIT to main menu

[X] Parsons' Q values and Flack x parameter [Q] QUIT program

gelect oprion [3]: ]

Figure 8.10 — The data manipulation menu

3. The data can be merged in several ways.
Choose the “Merge ALL equivalents includ-
ing Friedel opposites” option [A] (Figure
8.11). Press [Enter] to accept.

NOTE: This merge will not average the reflec-
tions in the final data file. It is only for the
calculation of statistics.

ClUEreneldataseey ylid.nkl

[R] Define resolution ranges (currently selected automatically)
[P] Cutput R{pim] rather than R(sigma)

[N] Do NOT merge reflections

[I] Merges IDENTICAL indices only

[8] Merge SYMMETRY eguivalents (but not Friedel opposites)

[4] Merge ALL equivalents (including Friedel opposites)

[E] EXIT to merge datasets menu

[Q] QUIT program

select option [2]: I

Figure 8.11 — The merge data menu

4.  Atable of statistics appears (Figure 8.12).
Examine the data presented. Is the com-
pletion near 100%? Is the redundancy
good? Are Rjnt and Rgigma small and
increasing smoothly from top to bottom? In
particular, look at the last two lines which
compare all of the data with the high-reso-
lution data. The completion should be near
100% for both the high-resolution shell and
the complete data set. The redundancy and
Rint should be similar for the two. The Mean
Intensity and the Mean I/sigma(l) will usu-
ally be quite different. The Mean I/sigma(l)
for the high-resolution data should be
greater than 3.0.
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Resolution #Data #Theory iComplete Redundancy Meen I Mean I/s  Rint Reigma
Inf - 2.23 75 7 97.4 7.08 1377.5 103.56 0.0177 0.0085
2.23 - 1.73 7S 75 100.0 9.09 575.4 10z.60 0.0171 0.0084
1.73 - 1.47 78 78 100.0 9.28 447.7 105.41 0.0175 0.0084
1.47 - 1.32 61 a1 100.0 9.62 246.1 89.44 0.0191 0.0098
1.32 - 1.21 76 76 100.0 9.03 211.7  82.63 0.0z12 0.0104
1.21 - 1.14 77 7 100.0 9.08 227.8  78.60 0.0z24 0.0108
1.14 - 1.08 79 79 100.0 8.56 124.2  5§9.78 0.0284 0.0132
1.08 - 1.02 86 a6 100.0 7.77 98.5 53.04 0.0258 0.0159
1.0z - 0.98 78 w8 100.0 7.78 105.3  51.83 0.0321 0.0161
0.98 - 0.94 95 95 100.0 7.80 71.5 43.72 0.0374 0.0200
0.94 - 0.30 103 103 100.0 7.20 62.5 35.89 0.0402 0.0231
0.90 - 0.87 89 a9 100.0 6.63 46.5 30.32 0.0513 0.0289
0.87 - 0.84 99 EE) 100.0 6.74 38.5 27.15 0.0624 0.0327
0.8¢ - 0.82 89 a9 100.0 6.66 43.1  26.73 0.0569 0.0313
0.82 - 0.80 8z a2 100.0 6.40 30.6  21.75 0.0685 0.0412
0.80 - 0.78 93 93 100.0 6.23 30.8  21.51 0.0735 0.0418
0.78 - 0.76 100 100 100.0 6.14 27.1  18.60 0.0850 0.0488
0.76 - 0.74 26 z8 9z.9 4.18 28.3  15.58 0.0699 0.0560
0.84 - 0.74 425 427 93.5 6.24 33.2  22.11 0.0685 0.0401
Inf - 0.74 1462 1486 93.7 7.57 199.6 5z.87 0.0225 0.0120
Merged [4], lowest resolution = 9.15 ingstroms, 363 outliers downweighted

Enter <CR» to concinue]

Figure 8.12 — Intensity statistics

5. Press [Enter] to continue.

6. Press [Enter] again to exit to the main
XPREP menu.

8.1.3 Preparing an Output File

1.

In the general menu, choose [C] to define
the unit cell contents.

A window opens displaying the current for-
mula, Z, the density, and the atomic volume
(see Figure 8.13). In this example, the for-
mula is incorrect and Z has been set to six
to try to achieve a reasonable density and
atomic volume. Since this formula is incor-
rect, it must be modified now. The correct
chemical formula for the YLID crystal is

At “Select option”, do not accept the default
answer of E. Type in [F] to enter a new for-
mula.

In response to the question “Enter For-
mula,” type the correct formula [C11 H10
02 S1] and press [Enter].

Check that the information is correct.
Check that Z seems reasonable for the
space group, that the density is as
expected (1.1 to 1.4 for organic molecules,
higher for inorganic compounds), and that
the atomic volume is around 17 or 18. Sig-
nificant variation from the expected values
may indicate an incorrect molecular for-
mula or missing counter ions or solvates.
The values at the bottom of the window
look fine for the YLID. Press [Enter] to
accept.
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Current dataset: ylid manual_Om.hkl Wavelength: 0.71073 Chiral:

7

Original cell: 5.957 9.027 15.3686 90.00 50.00 90.00 Vol 987.7
Esds: 0.001 0,001 0.002 o.00 0.o00 0.o00 Lattice: P
Current cell: 5.957 9.027 18.366 S0.00 S0.00 90.00 Vel 587.7

Matrix: 1.0000 0.0000 0.0000 0.0000 1.0000 0.0000 0.0000 0.0000 1,0000

Crystal system: Orthorhombic Space growp: P2 {1)2(1)2(1] # 19 [chi] Laue

3

Formala: €11 HIO o2 81 Formula wet:  206.25
Z: 4.00 Demsity: 1.387 At.vel: 17.6 F(000): 432.00  Mu[mo-1] : 0.30
[D] Read, modify or merge DATASETS [C] Define unit-cell CONTENTS

[P] Contour PATTERSON sections [F] Set up shelxtl FILES

[H] Search for HIGHER metric symmetry [R] RECIPROCAL space displays

[5] Determine or input SPACE GROUP [U] UMIT-CELL transformations

[4] Absorption, powder, SIR, SAD, MAD eto. [T] Change TOLERANCES

[M] Test for MERCHEDRAL TWINNING [0] Self-rotation function

[L] Reset LATTICE type of original cell [@] QUIT program

gelect opuion [Q]: £

Output file name (vithout extension) [ylid manual oOn]: [
Figure 8.13 — Defining and checking the unit cell contents

5. The next default action for XPREP is to
write out the files necessary for the struc-
ture solution process (see Figure 8.14).
Press [Enter] to accept.

Current dataset: ylid manual Om.hkl Wavelength: 0.71073 Chiral

7

Original cell: 5.957 9.027 18.366 S0.00 90.00 S0.00  Wol 987.7
Esds: 0.001 0.001 0.002 0.00 0.00 0.00 Lattice: P
Current cell: 5.957 9.027 18.366 S0.00 90.00 S0.00  Wol 987.7

Matrix: 1.0000 0.0000 0.0000 0.0000 1.0000 0.0000 0.0000 0.0000 1.0000

Crystal system: Orthorhowbic Space group: Fz(1)z(1)2(1) # 19 [chi]  Laue:

3

Formula: ©11 H12 02 S1 Formula wt:  208.27
Z: 4.00 Denmsity: 1.401 Ac.wol: 17.6 F(000): 440.00  Mu[nee-1] : 0.30
[D] Read, modify or merge DATASETS [C] Define unit-cell CONTENTS

[P] Contour PATTERSCMN sections [F] Set up shelxtl FILES

[H] Search for HIGHER metric symmetry [R] RECIPROCAL space displays

[5] Determine or input SPACE GROUP [U] UNIT-CELL transformations

[4] Absorption, powder, SIR, SAD, MAD etc. [T] Change TOLERANCES

[M] Test for MEROHEDRAL TWINNING [0] Self-rotation function

[L] Reset LATTICE type of original cell [Q] QUIT program

select option [F1: ]

Figure 8.14 — Requesting output files

6. The program asks for an output file name.
Press [Enter] to accept.

Current dataset: ylid manual_Om. hkl Wavelength: 0.71073 Chiral: 2

Original cell: 5.957 9.027 18.366 90.00 90.00 90.00 Wol 987.7
Esds: OpOO1  0.001  0.002 0.00 0.00 o.00 Lattice: P

Current cell: 5§.957 9.027 18.366 ©0.00 90.00 90.00 Wol 987.7

Matrix: 1.0000 0.0000 0.0000 0.0000 1.0000 0.0000 0.0000 0.0000 1.0000

Crystal system: Orthorhowbic Space group: P2(1)2(1jz(1) # 19 [chi]  Laue: 3

Formula: C11 Hi2 0z S1 Formula wt: 208,27
2: 4.00 Demsity: 1.401 Be.wol: 17.6 F{000): 440.00  Mu[mo-1] : 0.30
[D] Read, modify or merge DATASETS [C] Define unit-cell CONTENTS

[F] Contour PATTERSCN sections [F] Set up shelxtl FILES

[H] Search for HIGHER metric symmetry [R] RECIPROCAL space displays

[5] Determine or input SPACE GROUP [U] UNIT-CELL transformations

[&] Apsorption, powder, SIR, SAD, HRD etc. [T] Change TOLERANCES

[M] Test for MEROHEDRAL TWINNING [0] Self-rotation function

[L] Reset LATTICE type of original cell [Q] QUIT progrem

Select option [F]:

Output file neame {without extensionj [ylid manual O] : ]

Figure 8.15 — Changing the file name

7.  After entering the file name or pressing
[Enter] to accept the default file name, an
input file for the structure solution module is
created and displayed on the screen, and
the program asks, “Do you wish to
(over)write the intensity data file
ylid_manual_Om.hkl?” Since the file name
has been changed, this question must be
answered with a “y” (see Figure 8.16).
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select option [F]:

Cutput file name {without extension) [ylid manual Om]: ylid manual Om

File ylid manual Om.ins set up as follows:

TITL ylid manual Om P2(1)2 [1)2(1)

CELL 0.71073  5.9573  9.0270 18.3664 90.000 90.000 90.000
ZERR  4.00 0.0005 0.0008 0.0013 0.000 0.000 0.000
LATT -1

SYMM 0.5-%, -¥, 0.5+%

SYMM -X, 0.5+¥, 0.5-%

STHM 0.5+%, 0.5-Y, -Z

SFAC C H O §

UNIT 44 48 8 4

TENP O

TREF

HELF 4

END

Do you wish to [over)write the intensity data file ylid menual Om? [N]: [

Figure 8.16 — The input file for structure solution and a final
question

8. Exit XPREP (see Figure 8.17). Press
[Enter] to exit the program.

[P] Read, modify or merge DATASETS [C] Define unit-cell CONTENTS
[P] Contour PATTERSCN sections [F] Set up shelxtl FILES

[H] Search for HIGHER metric symmetry [R] RECIPROCAL space displays
[5] Determine or input SPACE GROUF [U] UNIT-CELL transformations
[4] Absorption, powder, SIR, $iD, MAD etc. [T] Change TOLERANCES

[M] Test for MEROHEDRAL TWINNING [0] $elf-rotation function
[L] Reset LATTICE type of original cell [0] QUIT progrem

select oprion [Q]: ]

Figure 8.17 — Exit XPREP from the general menu

NOTE: There are many other features in
XPREP that can be accessed from the
general menu: resolution cutoff, recipro-
cal space plots, simulated powder pat-
terns, and a test for merohedral twinning
are very useful tools.

8.2 Simulated Precession Images

1. Under Examine in the task bar, click
Precession Images. The Precession

Images module provides an undistorted

view of layers of the reciprocal lattice.
APEX2 generates simulated precessio

n

images by finding the appropriate pixels in
a series of “.sfrm” images. You must specify

the images to examine and the zones to

calculate.

2. To open the File Selection window, click the
folder beside the file name. Choose the
sets of images that you want to use for the
calculation by clicking on the check boxes

(see Figure 8.18).

Ei python

Look in: IJ C:/Frames/guest/vlid_sxample/ LI a =

B @ matiix_01_0009.sfm | § Run
“Jwiork @malnxﬁﬂLUmDsfrm O matrix_01_fHH## (1 -12)

[

3abs =) matrix_01_0011 st (|| O matrix_02_ sttt 1-12)

matrix_01_0001 sfm @ matrix_01_0012 sfm a m.atrwjlﬁﬂﬂﬂ [1-12)

matrix_01_0002. sfrm _@ matrix_02_0007. sfrrn vlid_example_01_3#HE 1 - B4)
matlfx_[ﬁ_[ll][li} sfrm __@ matrix_02_0002. sfrm i:::::::zs:::gg:igﬁi F‘ i;}}]
matriz_01_0004. sfrm t@malnx_02_0003 sfm Jid_crample,_ D4_HH#E[1 - 719
t=] matric_01_0005 sfrm &) matrix_02_0004 5fm I - § :
matrix_01_000B sfrm atrizs_02_0005 sfrmn
matriz_01_0007 sfrm _ﬂ matiix_02_0008. sfrm
matri_01_0008. sfrm @ matrix_02_0007. sfrrn

i
Directory. I

File type: | Ditectaries d Cancel

Figure 8.18 — File Selection window with matrix runs
deselected
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3. Check the default input value. Modify as
needed and press Calculate.

Calculating more zones does not significantly
increase the calculation time. In the example,
1kl, h1l and hk1 have been added to the defaults
of Okl, hOl and hkO. Fractional values (e.g., 0.5kI)
are allowed. Reducing the resolution may speed
the calculations slightly. The thickness defines
the range of pixels above and below the
requested range. For example, if the Okl zone is
requested with a thickness of 0.1, then the simu-
lation is looking for all pixels that have -0.1 < h <
0.1, and any value (including fractional values)
for k and I.

Planes IDkI bl kk0 k1 Tk K11

Images from Iruc:.-"guest.-"_I,IIid_example.-"ylid_example @l

[1127 image files in 4 rung]

best resolution ID.??

Thickness  [0.10

Calculate |

Created files I LI

Figure 8.19 — Detail of the input section

4. A progress bar appears (Figure 8.20) and
after approximately 5-10 minutes (depend-
ing on the number of “.sfrm” files read) the
simulated precession image will appear on
the screen. Display other planes by clicking
on the calculated images to the bottom
right of the work area or by browsing as
usual with the View module.

Processing 1127 image files... %

2%

Figure 8.20 — Progress bar

5. Use the simulated patterns to check space
group symmetry (see Figure 8.21, Figure
8.22, and Figure 8.23) and to find signs of
twinning (Figure 8.24).
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P
-
.
.
a
L]
-

L

Tecmane

Figure 8.21 — The Okl plane for the test YLID Figure 8.22 — The hOl plane for the test YLID
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Figure 8.23 — The hkO plane for the test YLID Figure 8.24 — A plane from a rotationally twinned crystal

showing the two lattices
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9 Structure Solution and Refinement

9.1 Overview

You are now ready to solve and refine the crys-
tal structure. The various steps in solving and
refining the structure are carried out within the
APEX2 GUI. XPREP has prepared the input
files for a standard direct methods run. There
are two files: .ins and .hkl. In this example, the
two files are ylid_Om.ins and ylid_O0m.hkl.

These files are all that is required to begin the
structure solution and refinement process. The
various steps of solving and refining the struc-
ture are carried out using the Solve and Refine
functions of the APEX2 Suite.
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9.2 Solve the Structure

The process of obtaining an initial model of the
compound is started by clicking in the Task Bar
on Solve Structure and then on Structure
Solution. This opens the Structure Solution
module.

nstiuctions Y Listing Y Results " Stiuctuie View

Check that there is a reasonable formula in the
formula window.

1.

TITL ylid_Om in P2(1)2(1)2(1}
CELL 0.71073 5.9617  9.0391 18,3936 90.000 90.000 390.000
ZERR  4.00 0.0002 0.0003 0.0007 0.000 0.000 0.000

SYMM -X, 0.5+Y, 0.5-Z2
SYMM 0.5+%, 0.5-V, -Z
SFACCHOS

UNIT 44 40 8 4

TEMP 0

SIZE 0.30 0.30 0.30
TREF

HELF 4

END

If you have a correct formula in the formula
field, then you are ready to start a normal
direct methods run.

If the formula is incorrect, change it and
press [Enter]. The input file will be updated.

Base:  [id_Om =

Fomula [C17H10025
—Sitatistic

Fieflections: [8071  Unique EE
Rejected  [47  Observed: EC
Rint[%]  [232 %Observed  [35
o [rr R [e

~Mathod
& Direct 1 -
® [Duaispace 1 =]

I¥ Stucture Expansion

o Computing Effort (log scale] =+

Solve Stucture STOP

Resel | Exi |

Figure 9.1 — Default Solve Structure view
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3. Click Solve Structure to start the direct
methods calculations. The upper window
displays the Q-peaks of the initial model,
and the text area displays the progress of
the calculations.

{Tratructions Y Ting Y Fendis Y Toaan Ve Y

Figure 9.2 — Structure Solution output

9.2.1 Options for Direct Methods

Clicking on the arrow to the right of Direct 1 in
the Method box (Figure 9.3) gives three preset
choices for structure solution using direct meth-
ods.

—Method
& Direct 1 -

Is [ual Space 1

- I Fatterzon 1 l ¥ | Structure Expansion
- Computing Effort [log scale) +
i
|

Figure 9.3 — Method box

In most cases the default values will give a good
initial model, but several other options are avail-
able for more difficult problems. Chose the solu-
tion method by clicking the appropriate radio
button on the left in the Method box.

M86-E01078



Structure Solution and Refinement

APEX2 User Manual

Preset Description

Standard settings which should be appropriate
for a wide range of circumstances.

Direct 1
Sets up a default run with a simple TREF
instruction.

Brute force method with a higher number of
direct methods attempts.

Sets up an extended run with TREF 10000. By
adding 10000 to the TREF command, more
Direct2 | attempts are made to determine a solution.
This will take more time, but if you see a good
solution in the output window it is possible to
stop at that point by clicking on the STOP but-
ton. Good solutions typically have a CFOM of
0.06 or less.

Brute force method with even more direct
methods attempts.

Sets up an extreme run with two instructions:
ESEL 1.0 and TREF 100000. By adding ESEL
Direct 3 1.0, more reflections are used in the solution
process. Increasing the number of tries in the
TREF command to 100000 runs (until ended
by clicking on the STOP button) is particularly
useful for acentric triclinic structures and for
pseudo-symmetric structures.

Table 9.1 — Direct Methods presets

At the end of the direct methods runs, the output
display will look like Figure 9.2. Good figures of
merit are near 1.0 for Sigma-1 and M(abs) and
less than 0.06 for Ryjpn, and the CFOM. Struc-

tures can be solved with figures of merit that
deviate from these numbers, but they may
require more effort.

If the initial model looks reasonable, click OK in
the output display and Exit in the Structure
Solution module. APEX2 automatically switches
to the Display tab and displays the initial solu-
tion. The next step is structure refinement using
XShell (Section 9.3).

9.2.2 Options for Dual Space Methods

Two predefined options are available for the
Dual Space method.

Dual Space methods are good for larger organic
molecules and polypeptides.

More information on Dual Space methods and
their use within APEX2 is available from the
“What's This?” Help function.

9.2.3 Options for Patterson Methods

Two predefined options are available for Patter-
son methods.

Patterson methods are good for finding heavy-
atom positions. In general, Patterson methods
favor a small number of strong scatterers.

More information on Patterson methods and
their use within APEX2 is available from the
“What's This?” Help function.
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9.3 Refine the Structure with
XShell

The structure solution step produced statistics
indicating that a solution had been found. The
real proof, however, is in the initial model that is
produced. XShell provides the tools to view and
refine the model. A quick glance at the results of
the direct methods run is often all that is needed
to see that the results make chemical sense.

Control of the refinement process is quite
straightforward using XShell.

1.  Under Refine Structure in APEX2’s Task
Bar, click the Structure Refinement icon.

This opens the Structure Refinement mod-
ule, which contains tabbed sections for
viewing the instructions file, listing file,
results file, and a 3D model of the structure.

g APLEE A3 - Users (guest) - Sample: yld_esaniple - Temporary license (2 days remaining) - [Structure Refinement | =
%y Sengle [nstrument Windows E K] n
D HE o< ¥
Sehy
Evhiain
Colee! Dase: | =
Inbegaste
S
Eraans Dt
[ —
Feebrn Sisuchun
]
'J\L;I ’
T

Rl |

Instnrront

Figure 9.4 — Structure Refinement module initial view
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2. Click the Browse icon E' on the right-
hand side of the “Base:” field. A dialog
opens in which you can select the desired

.ins file.
G@thoose AFile...
Laok jru [\ Co/Frames/quest/id_sxample/viork/ =] & E ek [
.
] ylid_Om.res
File name: Iy\id_Um ins
File type: | RES and INS files [*res:"ins) 4| Cancel
#

Figure 9.5 — Open file dialog

3. Click Open. The contents of the .ins file
and any other files with the same base
name are displayed under their respective

tabs. Also, the six buttons in the lower right-

hand corner of the module become avail-
able.

Button Function

Refresh the tabs using the absolute lat-

Refresh Files est contents of all the files.

Copies the contents of the results file

Copy RES to INS into the instructions file.

Saves any changes you have made to

Save Files the files.

Refine with XL Refines the instruction file using XL.

Open in XP Opens XP for editing the results file.

Open in XShell Opens the selected file in XShell.

Table 9.2 — Structure Refinement module buttons
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4. Click Open in XShell. The XShell Main
Window appears.

File Refine Disorder Constrain Model Render Preferences Help

[ B BHEE S

Legend

Atom Mame t ¥ Z Height Bond

Bond Length

| SELECT ATOMS
Element Name Component:

Include !"‘
Exclude I

Murmnetic Component:

Include IU ko |999
Exclude ! to

Trailer Component

Include I* Select Components

Exclude ! Deselect Components

Clear Current Selection i
oF Cancel I

—Residual (Difference Fourier @ Peaks)

i Mo, of GPeaks 1 20

Figure 9.6 — Initial view of the YLID molecule
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5. Right-click in the background to open a

pop-up window with image display options. oo L Ao
PEAK HESGHT e L3 ¥ z HBRE | OHARGE | LEG
v vireframe s T :
Ball And Stick .HI 7500/ 0,505 03 068553 0| 0.05
Thermal Elipsaid :;mn :::‘ ‘"lmf ::j: ::: : ::
Pipes 1404700 ) :Inuulr -«:_q-: |: | ::-.
Select atoms uiu;_'« u;au: u.-_-.ul 0 o u:w
Hi Par(s) T T =
Show all Atoms i S L o] ki
Disassociate Atoms :‘:I ":: :lm:z : [ "n::
S oo~ oiisd o siles : e
T Hydrogen Labels » 059 o» ::3 0 n:c;
T Labels
Sort... — —
Grow
:a_*‘“ Figure 9.8 — Atom information screen
Tim
Zoor ot . . . . .
—————— At the bottom right of the main window is a slide
Restors Delsted Atoms bar which is used for deselecting peaks. The
e arrow can be moved by left-clicking and drag-
Information on All Atams . . . . .
ging the arrow or by left-clicking on either side of
Add Hydrogen atoms— »

the arrow. Left-clicking to the left of the arrow
(i.e., where the mouse cursor is pointed in Fig-
ure 9.9) removes peaks.

Figure 9.7 — XShell menu

6. Select the Information on All Atoms
option to open a window displaying a list of

—Residual (Difference Fourier G Peaks)

the peaks and their heights (see Figure
9.8). The drop in height between Q13 (the J
last real peak) and Q14 (the first noise R 'rio.'oéq'p;aés'kz'z' B

peak) is typical of a correct solution. Click

OK to close this window. Figure 9.9 — The Q-peak slider
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7. Slide the pointer down while watching the
molecular display. Change the number of
Q-peaks to 15. At 15 the molecule is much
cleaner, but there are still peaks that do not
make sense.

Figure 9.11 — Image with all noise peaks removed

8. Put the cursor over the bonds to check dis-
tance. The distance is displayed at the bot-
tom right.

Figure 9.10 — Image after the number of Q-peaks was
changed to 15

Click left on the slider until you find a reasonable
model.
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9.3.1 Label the Atoms

1. Label the atoms and set the atom types.
Left-click atoms to select them. Left-click
the peaks for the two oxygen atoms (Q2
and Q5 in this example).

Figure 9.12 — View of model with the probable oxygen peaks
selected

2. Ifitis difficult to see the color and labels,
change the color scheme with Preferences
> Background Color. Choose colors and
click Apply. Click Cancel to exit the back-
ground color mode. Note that the selected
peaks are blue in Figure 9.14.

Eircan L R
[ e —r (1] 1)

io:u:s, Freferences... Chied

1 Sokd

% Gradent

Figure 9.14 — New background color

SELLCT UACKGROUND COLOR. |

A 4

Apoky Lancel
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3.

Right-click to view a pop-up menu and
select Labelling.... The Atom Labelling box
opens.

Delete Atoms
Hide Atoms

Infarmation. ..

Set Pivat point
Sort...
Show All Labels
Show Hydrogen Labels

Zoom In

hange Parts
Plane

sieighted Plane

Associate Connected Atoms

Grow

Move to Symmetry Equivalent Sike
Pack. ..

Trim

Deselect all

Constrain Madel

Add hydrogen atoms

Figure 9.15 — Select Labelling

ATOM LABELLIMG IN ORDER OF SELECTION

Elerment IC LII

First Sequence # Il {* fscending

Sufix I "~ Descending

Relabel Cancel |

Figure 9.16 — Atom Labelling box

4. The two selected atoms need to be
changed to oxygen atoms. Do this one of
two ways:

e Click the Element field and type in the ele-
ment symbol (case does not matter).

*  Click the El button to the right of the Ele-
ment field to open a periodic table. Click the
appropriate element symbol to select it (the
periodic table will automatically close).

Canicel

Figure 9.17 — The periodic table for selecting atom types

5. Once the element type is set correctly, click
Relabel to number the peaks sequentially
in the order they were selected, starting
with the number in the First Sequence #
field.
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6. Seeing the color of atoms can be difficult in
the Wireframe view used so far. Right-click
in the background with no atoms selected
to get a slightly different action menu. In
this menu, highlight and left-click Pipes.
This makes the bonds thicker and makes it
obvious that there is an incorrectly labeled
atom. This will be corrected when the car-
bon atoms are labeled.

wireframe
Bl And Stick
Thermal Elipsoid

Select abbms
Hide Part(s)

Show all Atoms

Dissssntlate Atoris
it Cel

['v Hydrogen Laels

| v Labets

Sat..,

Grow
Pock...
Trim
Zeom Ot

Tongls Pan And Feoksts
Restore Deleted Atoms

Eind Duplicate Labels

Tnformation on All Atoms

Figure 9.18 — Select the pipes view

7.  Click on the remaining peaks in the order
that you want them labeled.

NOTE: If working on YLID test data, look at Fig-
ure 9.19 and click on the peaks to give
the same order as used here. Right-click
and select Labelling. Select Carbon and
apply the labels.

8. In the Labelling tool, change the element
type to C (carbon). The starting atom num-
ber changes to 1—the first available num-
ber for carbon atoms.

9. Click Relabel.

10. Click Cancel to close the window. The
labeled YLID molecule is now ready for
refinement.

Figure 9.19 — Correctly labeled model
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9.3.2 Refine the Model

1. Click the Refine button in the Tool Icon Bar
(the cursor is pointing to it in Figure 9.20),
type [Ctrl+R], or select Refine > Refine in
Xshell’'s Menu Bar. This opens the Refine
Box.

FIEEE

[~
4

Figure 9.20 — The Refine icon

2. Click Refine to launch XL (the least-
squares refinement program) using the
default parameters as given in Figure 9.21.

REFIME
Least squares opkions

v Full Matrix

™ Conjugate Gradient

% Refinement Cycles |4

Mumber of residual {ipeaks IZD
sigma Cutoff | nSigma |
Resolution Cutaff [~ 2 Theta I

[ Trevert struckure

—Late-stage refinement options
™ Refine all non-H atoms anisotropically

™ Use suggested weights

Squared Term IU-UUUUUU
Linear Term I

™ Refine extinction parameter

|

™ Generate ACTA[CIF] information file

Refine | Edit File: | Cancel |

Figure 9.21 — The Refine menu

After a few seconds, a Refine window will open

with output results for the calculation.

M86-E01078
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WRZ = 0.2816 before cycle 3 for 2445 data and 57/ 57 parameters B
GooF = S= 2496; Restrained GooF = 2496 for 0 restraints
Mean shift/esd = 0.686  Maximum = 2456 for y C11 at11:50:43
Max. shift = 0,015 A for C11  Max, duU =-0,001 for C2

Max. shift = 0.032 A for C11 Max. du —-0.008 for 2

WRZ = 0.2767 before cycle 4 for 2445 data and 57/ 57 parameters
Goof = § = . Restrained GooF = 2473 for O restraints
Mean shift/esd = 0.180  Maximum = -0.854 for y 02 at11:50:44
Max, shift = 0,004 A for 02 Maxz. dU = 0.000 for C4

WRZ = 0.2783 before cycle 5for 2445 dataand 2/ 57 patameters
Goof = S=  2470; Restrained GooF = 2470 for 0 restraints

Rl = 0.0879 for 2315 Fo > 4sig(Fo) and 0.0918 for all 2445 data

WRZ = 0.2783, GooF = 5= 2470, Restrained GooF =  2.470 for all data

#* Absalute structure probably wrong - invert and repeat refinerent **
R1= 00932 for 1440 unique reflections after merging for Fourier

Highest peak 1,18 at 0.2500 0.3356 02419 [ 051 Afrom S1]
Deepest hole -0.75 at 0.1606 0.2830 0.2403 [ 0.51 Afrom S1]

+ ylid_res75 finished at 11:50:44 Total CPU time: 0.3 secs +

| | 2

Figure 9.22 — Isotropic refinement output

In the output displayed above, note that the R1
value is 0.09. This is typical for a preliminary iso-
tropic refinement for an organic molecule with
data to a resolution of 0.75 and no hydrogen
atoms included. The refinement program also
indicates that the model needs to be inverted to
get the correct absolute structure.

NOTE: This indication of the absolute configura-
tion is usually reliable, but all assign-
ments of absolute structure should be
confirmed later in the refinement pro-
cess by including TWIN and BASF cards
in the instruction input.

3. Click OK to return to XShell. The molecule
display refreshes with the results of the
least-squares calculations.

Figure 9.23 — The model after isotropic refinement

The peaks in the diagram represent difference in
the electron density between the refinement
model and the experimental electron density as
defined by the measured data. Many of these
difference peaks are near the sulfur and oxygen
atoms. Refinement of all atoms anisotropically
should improve the model.
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4. In the refinement box, click Invert Struc-
ture and Refine All Non-H Atoms Aniso-
tropically as in Figure 9.24.

Mumber of residual (Q)peaks IZD
Signa Cutaff | ndigma [
Resalution Cukoff [ 2 Theta I

[V Inwert structure
Lake-stage refineka} optians
’]7 Refine all non-H atoms anisotropically
Figure 9.24 — Inverting and choosing anisotropic refinement

5. Click the Refine button to launch the least-
squares refinement program. The output
window opens and a summary of the
results of individual cycles of refinement
appears.

GooF =5 = 1487, éestralned GooF = 14387 far O raétra\nts
hean shiftiesd = 1.718  Maximum = 13.593 for U13 51 at 19:05:00
e, shift = 0009 & for C5 Max. dU = 0.003 for C5

whR2 = 01407 before cycle 3 for 2389 dataand 127 ¢ 127 parameters
GooF =5=1.184 Restrained GooF = 1.184 for  Orestraints
hean shiftfesd = 0422 Maximum = 2.423 for U11 C6 at 19:05:.00
e, shift = 0.004 & for C5 Max. dU = 0.002 for C6

whR2 = 01391 before cycle 4 for 2389 dataand 127 ¢ 127 parameters
GooF =5= 1167, FRestrained GooF = 1167 for  Orestraints
hean shiftiesd = 0101 Maximum = -0.638 for 13 C3 at 19:05:00
e, shift = 0002 & for C5 Max. dU = 0.000 for C5

wh2 = 01389 before cycle Sfor 2389 dataand 2/ 127 parameters
GooF =5= 1164, Restrained GooF = 1164 for  Orestraints
R1= 0.0450 for 2262 Fo = 4sig(Fo) and 00476 for all 2389 data

wh2= 01389, GooF === 1164, Restrained GooF = 1.164 for all data
R1= 00493 for 1415 unigue reflections after merging for Fourier

Highest peak 047 st 0.6147 09218 02317 [ 097 A from C10]
Deepest hole 027 ot 02028 05207 0.0249 [ 1.27 A from C6 |

+ ylid_0m  finished &t 19:05:00 Total elapsed time: 06 secs +

Figure 9.25 — Least-squares refinement summary

The value for R1, 0.0459, is typical for an initial
anisotropic refinement with no hydrogen atoms
included. Since the mean shift/esd is greater
than 0.1, the model is still changing. Since the
highest peak in the difference map has a height
of 0.47 and is 0.97A from C10, there are cer-
tainly some hydrogen atoms to be included.

Examination of the difference peaks in the
resulting difference electron density map shows
that the top difference peaks all correspond to
hydrogen atoms.

Figure 9.26 — Difference peaks correspond to expected
hydrogen atom positions
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9.3.3 View Atomic Displacement
Parameters (Thermal Ellipsoids)

It is generally good practice to examine the dis-
placement parameters at this point in structure
determination.

1. Remove difference peaks with the slider
tool.

—Residual (Difference Fourier G Peaks)

=
3

Mo, of QPeakz: 0 5

Figure 9.27 — Removing all Q-peaks with the slider bar

2. Right-click on the background and select
Thermal Ellipsoids.

‘Wireframe
Ball And Stick

Figure 9.28 — Selecting Thermal Ellipsoids

Figure 9.29 — Thermal Ellipsoid plot

Alternatively, a list of Ueq’s (equivalent isotropic
displacement parameters) can be generated by
requesting information on all of the atoms.
Examining these values for outliers is good
practice.

3. Right-click on the background and click
Information on All Atoms.

Find Duplicate Labels

Information on All Atoms

Add Hydrogen atoms — #

Figure 9.30 — Selecting Information on All Atoms

This produces the table in Figure 9.31.
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INFORMATION ON ALL ATOMS

LABEL PEAK HEIGHT THPE * i zZ HYERIC CHARGE |LEG
1 31 0.0000(5 0.8097 0.1515 0.2405|sp3 0 0,0353467
2 o1 0.0000| 0,3345 0,3026 0.1765|sp3 i} 0,04722
3 o2 0.0000) & 0.8432 0,590 0.1287|sp3 0 0,0483033
4+ =] 0.0000)C 0,3391 01141 0.527|sp3 0 0.03482
5 & 0.0000|C 0.1496 0.502 0.2258|sp3 i} 0,0549167
& 3 0.0000)C 0.6396 0.8 0.1251 |sp3 0 0,03449
7 1 0.0000)C 0.4329 0.1949 0,1500|sp3 0 0,0335967
g 9 0.0000|C 0.5093 0.24 0.673|sp3 i} 0,0371967
l =] 0.0000)C 0.6354 0.1245 0.1726/sp3 0 0,0332767
o |CF 0.0000)C 01756 0.1410 0.377|sp3 0 0,0462133
11 |C10 0.0000|C 0.8345 0,3779 0.2289 sp3 i} 0,046592
12 |5 0.0000)C 0,2975 0.620 0.378|sp3 0 0,0566333
13 |4 0.0000)C 0,486z 0.591 0.76|sp3 0 0,0486733
14 |C11 0.0000|C 0.6496 01775 0,3230|sp3 i} 0,0572667

Prink |

Figure 9.31 — List of parameters with Ueq to the right

Examining the values here is difficult because
the atoms are not in order.
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9.3.4 Sort Atoms

1. Right-click on the background and click
Sort... to sort the atoms into a sensible
order.

|7 Hydrogen Labels

|7 Labels

Grow

Pack,..

Figure 9.32 — Select the Sort option

An Atom List box appears to the right of the mol-
ecule display. Since S1, O1 and O2 are in a rea-
sonable order, only the carbon atoms need to be
ordered.

SORT ATOMS
Sort Bin Akaomn List

<Top of List=

Sork( Alpha-Mumeric )
Sork( Murmeric-alpha

Insert Selected After- =
Insert All After---=

<--Move Selected Atoms To Sork Bin
<--Move All Atoms To Sort Bi
o _Geneel |

Figure 9.33 — Selecting carbons for sorting

NOTE: Generally, it is easier to sort and number
atoms before adding hydrogen atoms.

2. Highlight the atoms to be sorted (i.e., left-

click and drag over the atoms) and move
them to the Sort Bin (i.e., click Move
Selected Atoms to Sort Bin).
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Sart Ein

Sorkl Alpha-Mumeric )r |

Figure 9.34 — Carbon atoms in Sort Bin

3. After the atoms are in the Sort Bin, click
Sort(Alpha-Numeric) to get them into a
normal order.

4. Highlight O2 and click Insert All After as in
Figure 9.35.

Sort Bin Akaomn List

Cl <Top of List=
z a1
3 o1

Sork( Alpha-Mumeric )
Sork( Murmeric-alpha

Insert Selected After- =

Insert Al After---i

Figure 9.35 — Sorted atoms with “insert after” atom (02)
selected.

5. Click OK to accept the sorting.

Ok

Figure 9.36 — OK button

The resulting list of atom information is easier to
examine.
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INFORMATION ON ALL ATOMS

B

|‘=|=‘|“|’|'-"
o =

HEHEE

=

o

c1 0.0000,C 0439 M nosmlms
=3 .0000(C DA OLIMS| 00723
c3 0.0000 ¢ D.EEH 0. 003

LABEL _[PEARPEIGHT  |TE  |x Iy Iz HYEAID | cHaReE [LEG

1 000005 [ L 2 [
1 0,0000 0 UTHG LR 01AS|sd
0.0000/0 0.0432 0030|0273

NLO3RITET
00549
4 0,0000/C D42 0890 0.76(53

DT
0.0000 & D397R 0.A30|  DATAjga 3

cs 0.0000/c 00498 0502 0.228%8
o.0000/c 0a7SE 0410 03Tl
0.0000C [ ol oah|  0ews
3 | 0,0000 | U u-ﬂ. [ Iu\:'.ﬁ'}
(=) | 10,0000 DUTHG o JJ..".". U.Zm.ﬂ'J
C11 | 10,0000 | QUL L o JZJJ.ﬁ'J
[ ot |

Figure 9.37 — Sorted atoms

The

Ueq values are reasonable if there are:

lower values for the sulfur atom and the five-
member ring

higher values for the terminal atoms —
methyls and carbonyls

sensible numbers for the six-member ring —
lower for C8 and C9, higher for C5 and C6,
and in between for C4 and C7.

9.3.5 Add Hydrogen Atoms

At this point, refine the hydrogen atoms either by
renaming the Q-peaks using the Labelling tool
as before and then including them in the refine-
ment, or include the hydrogen atoms in fixed
idealized positions riding on the atoms to which
they are attached.

In this User Manual we will illustrate the latter
fixed idealized method.

NOTE: In some cases (e.g., hydrogen atoms on
hetero atoms or on geometrically
strained carbon atoms), it is better to
refine the hydrogen atom positions. A
general rule is to refine if there is some
doubt about the position of the hydrogen
atom and there is difference electron
density present.

1. Using the slider tool, remove all of the Q-
peaks.
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Figure 9.38 — Refined model with difference peaks removed

2. Right-click on the background and click
Add Hydrogen atoms > Hybridize All.

Add Hydrogen stoms— »

Calculate Hydrogens

Figure 9.39 — Hybridize button

The colors of the atom labels change to indicate
the atom hybridization.

NOTE: If the atom hybridizations are hard to
see, right-click on the background and
open the Information on All Atoms win-
dow.

3. Right-click in the background and click Add

Hydrogen atoms > Calculate Hydrogens.

ANrormacion on M 4Coms

Add Hydrogen stoms— » Hybridize Al

Calculabe Hydrogens

Figure 9.40 — Calculate Hydrogens button

4. A warning appears indicating that the
hydrogen atoms have been provisionally
added and that the final addition with nam-
ing will take place when the least-squares
calculations are started (Figure 9.41). Click
OK.

! -|Notes Concerning Refinement: ﬂ

X¥SHELL haz only assigned atom types, Correct labels
will be generated during the next refinement cycle.

Figure 9.41 — Hydrogen atom warning
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5. Click the Refine button to launch the least-
squares refinement program. The output
window opens, and a summary of the
results of individual refinement cycles
appears.

GooF =5 = 0728 Restrained GooF = 0728 for O restraints
Mean shiftiesd = 0.693 Maximum = -3.775 for v C11 At 191645
Maz shift =0.013 A for H118  Meo:. dU = 0.000 for C4

wh2= 00341 before cycle 3 for 2389 dataand 1207 129 parameters
GooF =5= 0701, Restrained GooF = 0701 for O restraints
Mean shiftiesd = 0104 Madimum = -0 681 for LN3Ca at 19:16:48
Max. shift =0.003 & for 108 Maex, dU = 0,000 for C&

wR2= 00340 before cycle 4 for 2389 data and 1294 129 parameters
GooF =S= 0701, Restrgined GooF = 0701 for O restraints
Mean shiftiesd = 0.043  Maximum = 0263 for y C11 &t 19:16:48
Max. shift = 0.002 & for H112  Max. dld =0.000 for C4

wi2= 00340 before cycle 5for 2389 datasnd 24 128 parameters
GooF =5= 0700, Restrained GooF = 0700 for  Orestraints
R1= 00281 for 2262 Fo = 4sig(Fo) and 0.0296 for all 2330 data

w2 = 00340, GooF =5 = 0.700, Restrained GooF = 0.700 for all data
R1 = 00289 for 1418 unicue reflections after merging for Fourier

Highest peak 023 at 0.8218 0.5646 01540 [ 063 & fromC2]
Deepest hole -018 at 01876 05132 00223 [ 1.26 A from CB |

+ viid_Om finished st 19:16:48  Total elapsed time: 09secs +

Figure 9.43 — Refinement results

The value for R1, 0.0281, is typical for an aniso-
tropic refinement with riding hydrogen atoms
and a data set measured to 0.75A. Since the
mean shift/esd is less than 0.01, the model is
not changing significantly. Since the highest
peak and the deepest hole in the difference map
are similar, there are probably no missing
atoms.

The resulting difference electron density map
appears rather ugly. This is because the number
of difference peaks to be displayed has been left
at 20.

Figure 9.44 — Difference peaks in a well-refined model
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9.3.6 Final Refinement for Publication

Obtain a view that is much easier to interpret by
reducing the number of difference peaks in the
Refine menu (see Figure 9.45).

1. For the final cycles of refinement, reduce
the number of peaks to be displayed to five
and turn on “Use Suggested Weights” and
“Generate ACTA(CIF) Information File” as
shown in the next two figures.

NOTE: If the suggested weights vary signifi-
cantly from 0.06 and 0.00, then change
the values to 0.06 and 0.00.

Mumber of residual {ipeaks IS

I

Figure 9.45 — Reduce the number of difference peaks

—Late-stage refinement options
™ Refine all non-H atoms anisotropically

¥ Use suggested weights

Squared Term IU‘USSSUU
Linear Term ID‘DDDDDD

[~ Refine extinction parameter

¥ Generate ACTA[CIF] infarmation File

Refine | Edit. File I Cancel I

Figure 9.46 — Select weights and request ACTA output

Figure 9.47 shows a difference map with the
number of peaks set at five.

Figure 9.47 — Difference peaks

2. Click Edit File, choose *.INS and click OK
to open the instruction file for XL. This
allows you to add instructions that are not
directly available in the GUI.

Edit File [

©pen File for Editing

I ylid_reso67
#INS
| * 5T Cancel

Figure 9.48 — Open the .ins file for editing

3. Check that the temperature card is correct.
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4. |If torsion angles are of interest, add a
CONF (confirmation) card (see Figure
9.49).

TEMP 23

conf]

mpla 12 ¢l €2 €3 <4 <5 <6 <7 <8 ¢9 s1 ol o2 <10 <11
mpla 6 <4 <5 €6 ¢7 cB 8 ¢l €2 <3 ol o2 s1 <10 <11
mpla 5 <8 ¢9 ¢l ¢2 €3 ¢4 <5 ¢6 <7 ol o2 s1 <10 <11
mpla 10 ¢l €2 €3 <4 <5 <6 <F <8 ¢9 s1 ol o2 <10 <11

Figure 9.49 — Add instructions in the .ins file

5. If planarity and angles between planes are
of interest, add mpla cards.

9.3.7 Generate an Atomic Displacement

(Thermal Ellipsoid) Plot

Remove difference peaks with the slider
tool.

Right-click on the background and select
Thermal Ellipsoids.

Figure 9.50 — Thermal ellipsoids with large hydrogen atoms

3.

If the hydrogen atoms in Figure 9.50 are
large, change their sizes by going to Pref-
erences > Atom Preferences... in XShell’s
Menu Bar.

Figure 9.51 — Atom Preferences tool
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At the top of the box that is opened, there are
three values that can be changed to adjust the
size of atoms and the bonds to them.

ATOM PREFEREMNCES

Element  Atom Radius Bond Radius

PeriodicTable | IH_ ID.12 ID.22

Figure 9.52 — Default atom preferences

4. Change the hydrogen radius to 0.08 and

the bond radius to 0.15 to make the hydro-

gen atoms smaller. Click Apply.

% ATOM PREFEREMNCES

Element  Atom Radius Bond Radius

PeriodicTable | IH_ ID.DS ID.IS

Figure 9.53 — Modified atom preferences

Figure 9.54 — Thermal ellipsoid plot with smaller hydrogen
atoms

5. Position atom labels by right-clicking on the
atom and choosing Position Label.

Delete Atom

Hide Atom

Labelling. ..
Sek Pivok Paink
Hide Label

Change Part

Figure 9.55 — Position Label menu

Figure 9.56 — Positioned labels

6. Convert this image into a high-quality .jpg
file for inclusion into reports by clicking
Render in the Windows Tool Bar and
choosing Color > To High Quality JPEG
File.
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Figure 9.57 — Generate JPEG

NOTE: A message may appear that the font file
needs to be defined: “Please set your
font directory for the first time for opengl
rendering.” If this happens, click Prefer-
ences > OpenGL Preferences and click
on the TrueType font For.OpenGL.

Figure 9.58 — The final rendered thermal ellipsoid/atomic
displacement parameter plot

In Windows, browse to
C:\bn\xshell\fonts\

In Linux, navigate to /usr/local/bin/xshell/
fonts. Choose a font.
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RLATT is a very powerful tool for viewing the A.1  Open RLATT

harvested reflections in a reciprocal lattice. This ) )
1. Under Evaluate in APEX2’s Task Bar, click

Appendix covers only a few of its features. More ) . .
information on RLATT is available in M86- Reciprocal Lattice Viewer. RLATT (The

Exx045 RLATT User Manual. Reciprocal Lattice Viewer module) opens.
This example has over 3300 reflections. This is % T
not the typical case; generally only 300 or 400 . ,."I;H
reflections are examined. Using extra reflections L.

will make the examples easier to see. Reciprocal Lattice

Figure A.1 — RLATT icon

2. RLATT will automatically read in the reflec-
tions from the current project and display
them as a reciprocal space plot.
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Figure A.2 is a typical unoriented view after
import. The gray circles are more intense reflec-
tions, i.e., those with higher I/sigma(l). The black
dots represent less intense reflections. The
intensity key slider at the bottom of the window
can be used to change the selection criterion.

Figure A.2 — Unoriented RLATT view

Other tools can be accessed by right-clicking on
the background to give the “Quick Tools” menu
(Figure A.3) and by clicking on RLATT in the
menu bar (Figure A.4).

% Rotate  »
Select 3

Measure  *

Figure A.3 — Quick Tools menu

RLATT

Rotate

Edit

Orientation

Unit Cell Taol
Measure Distance
Measure Angle

YisLialization

Figure A.4 — Full menu tools
Additional context-sensitive information is avail-

able by left-clicking on the “What’s This” help
arrow in the menu bar.

O = 3 I8
Setup

Figure A.5 — The “What’s This“ help arrow

For example, clicking on the help arrow and then
clicking in the work area (the gray area to the
right of the lattice display) gives the display of
shortcuts shown in Figure A.6. Clicking on the
blue background gives the hints shown in Figure
A7.
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RLATT Keyhoard Commands

Rotate & Zoom: Orientations

TP/ DOWHN =rotate along = F1 =100 {along a™*)

LEFT / RIGHT =rotate along ¥ F2 =010 {along b™*)

M= DEL =rotate along = Fz =001 {along c*)

+/- =rzoom F4 = unoriented (identity matrix)

hold SHIFT =4z speed F5 = user-defined onentation 1

hold CTREL = 1/4 speed Fé& = uger-defined otientation 2

hold SHIFT + CTEL = 1éx speed F7 = user-defined onentation 3
F8 = user-defined orientation 4

Selection Tosls

SHIFT + left-click
CTEL + left-clhick =remove spots fFom current selection
TE, DOWH, LEFT, RIGHT =move selection tool

= add spots to current selection

SHIFT + F5 = store user-defined orientation 1
SHIFT + Fé = store user-defined ortentation 2
SHIFT + F7 = store user-defined orientation 3
SHIFT + F2 = store user-defined orientation 4

hold SHIFT =4y speed (during movetmnent otily)

hold CTEL = 1/4 speed (during movement only) | Distance Measurement:

hold SHIFT + CTRL = 16x speed (during movement only) + = add slice

+ = add slice (lattice tool only) - = remove Slice

- =remove Slice (lattice tool only) PGP = add Esxtension
PGP = add Estension (lattice tool only) PGDM = remove Extension
PGDN =remove Extension (lattice tool only) hold SHIFT =action z 10

ALT + left-click =lock onto spot (lattice tool only) ATT + left-click =lock onte spot

| & Measurement:

ATT+  =lock onto spot (locking onto all
left-click three caloulates the angle n 210

Ilisc:

= adjust intensity shder

= adjust intensity shder

= change axis modes

= change colorization method

= invert selection

= toggle Mull Eesolution Mode
= change 2D Projection Scale mode

(
]
&
z
I
M =toggle distance measurement during lattice selection tool
i)
2
T =toggle Uit Cell Tool

Figure A.6 — Shortcut keys and commands
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3D Reciprocal Lattice Yiew

I thiz window iz the three-dimentional dizplay of the reciprocal lattice uzing
OpenEL for hardware rendering.

Left-click and drag to rotate the view or use a selected feature.

Double-left click on a reflection to bring up a litle statistics window, Click on
the gtatigtics window to make it dizappear.

%Idle-click and drag to change the zoom ratio.
Spin the mouze wheel to adjust the reflection sizing.

Right-click to make a quick-menu of zpecial features available.

Figure A.7 — Help for the 3D display obtained by clicking the
“What's This” arrow on the blue display
background
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A.2 Orienting Views

Move the mouse to rotate the RLATT display. It
is possible to easily see rows and non-fitting
peaks (see Figure A.8).

Figure A.8 — RLATT display looking down layers of
reflections

By sliding the intensity key at the bottom of the
display, it is easy to deselect weak reflections. In
Figure A.9 the reflections between the layer
lines all go black when the intensity filter is
moved to the left.

lrkenialy Py

Figure A.9 — RLATT display looking down layers of
reflections. Weaker reflections, i.e., those with
smaller I/sigmay(l), are black because the
“Intensity Filter” slider (bottom left) has been
moved slightly to the left.
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With additional rotations, the layers of reflec-
tions can be further oriented so that stacks of
reflections become visible. Sometimes it is quite
useful to right-click on the background and
choose Z-rotations from the rotation options.
The 2D profiles on the top and to the left are a
valuable aid in this process. With practice, the

_.A‘LL.LﬂLlLILLllu....;...‘_..._

U geese e vee

v IewvevewewivussuUiLewe

B WV e R e ee e s s ses Ve e vy

Sre il veewee Pevwwwsrseswiuees

Imtenzity Filker Reflection Size Zoom

2D profiles can be organized into clusters. As
shown, the 2D profiles are counting intensity.
The counting mode can be changed to spot
count or turned off completely using the Visual-
ization menu (RLATT > Visualization) or by
pressing the [s] key to cycle through the count-
ing modes.

s (8]
& Reciprocal Space

" Ditact Spacs
 Laboratory
" Mone

~Colarization Methad (C)
& ByGroup

€ ByALCHS Flags
€ By Intensity

]

Light Direction and Calors

2D Pigjestion Seale (5]
(% By Intensity Count

" By Spot Count

 Hone %

Null Resalution [M] = DISABLED

[— r— i

Figure A.10 — An oriented lattice view. The Visualization
menu is to the right. The 2D profiles are to the
left and to the top.
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The distance between layers can be measured
by clicking on one of the clusters of lines in the
2D view and then dragging to the next cluster. If
you drag over three clusters, then the distance
as measured would need to be multiplied by
three.

17574
. T S N O N 1

5954 A

Figure A.11 — RLATT display with measured distances in the
2D views.

The Orientation menu allows easy orientation if
the cell is indexed. Press the [F1], [F2], or [F3]
key or click the appropriate button.
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r—Pre Designated Orientation:

100=along &°[F1]

01 0=along b [F2)

001 =along &7 [F3)

unoriented [F4]

—User Designated Orientations

Orientation & [F5) Load | Save |
Orientation B [FE) Load | Save |
Orientation C [F7) Load | Save |
Orientation D [F8] Load | Save |

i~ Layer

Layer Mode = DISABLED

Laper

—Wisible Fun Scan:

v Scan 1

|ntensity Filter Reflection Size Zoom

= 1 [

Figure A.12 — An aligned image with the Orientation menu to
the left
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3. Select reflections with the Lattice tool.

The Lattice tool is one of the most useful editing
tools. Activate it from the Edit menu or by click-
ing on the background and choosing Select >
Lattice. When initially activated, nothing
appears. Hold down the [Alt] key to lock on a
centroid and then left-click and hold on a spot.
Now drag the mouse and line up the line that is
tied to your spot on a row. Choose a longer row
and align carefully. Now, while still holding the
left mouse button, drag the second line to
another row as shown in Figure A.13. Let go of
the button. If you want to start over, click on
another spot and repeat the process. Using the
[Alt] key is optional, but it makes alignment of
the lines easier and more accurate (Linux users
may find that the [Alt] key has operating system
functions).
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Intensity Filter Reflection Size

ir

Zoom

r—Editing Tool:

 Box

% Lattice Overlap
£ Single Spot

" Cicle

T Naone [rotate]

—Selection Helper

Select Weak Reflections

Select Cunent Group

Irvert Selection

—Grouping T ool

Add To Current Group

Current Group I Group T T

Remave From Current Group

i Select Visible Groups

=
=]
=
@

Group 1
Group 2
Group 3
Group 4
Group 5
Group B
Group 7
Group 8

Group 3

Group 10
Group 11
Group 12

Group 13 a
|

PO A A A A R KA R R R KA K

[T

i~ Deletion Helper
Delete Selected  [finalized at save] I
Delete Mon-isible (finalized at save] |

Expot Visible Spots to P4F

Figure A.13 — Two lattice lines selected
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Press the [+] key to add lines between the two
you have marked. Press the [-] key to remove
lines.

—Editing T ool
 Box

" Lattice Overay
" Single Spot

¢ Circle

" Mone [ratate]

—Selection Helper

Select wiesk Riflsctions |

Select Current Group |

Invert Selecion |

Curtent Graup: I Gioup 1 'I

Add To Cunent Gioun |

Fiemave Fram Curtent Group |

[~ Select Visible Graups
v Hone -
v I Giroup 1
] Group 2
Group 3

Group 4
Group §
Group B
Group 7
Group 8
Group 3
Group 10
Group 11
Group 12

Group 13 -
i B

i Deletion Helper

PO KR R R AR R B KRN R

i

Delele Selecled [fnalized ot save) |

Delete Norsisble ffnalized ot savel |

Intensity Filtker Reflection Size Zoom Evport Visible Spots to P4F |
! L
J' | 1]

Figure A.14 — View with most of the lattice lines selected.
Lines to the top and bottom are not selected.
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Use the [Page Up] key to add lines to the out-
side of the previously selected lines (in this
example, the top and bottom). [Page Down]

removes lines from the outside. Now all visible
lines are selected. Note that the selected reflec-

tions are turquoise.

W

i

L

Intensity Filter

Reflection Size

Zoom

—Editing Tools
£ Box

& Lattice Overlay
= Single Spat
€ Circle

= Mone [rotate]

—Selection Helper

Select Weak Reflections

Select Cunent Group

Irvert Selection

—Grouping T ool

Current Group:

Add To Current Group

|_GIUUDT o

Remave From Current Group

—Select Visible Groups——————————————————

=
o
=
@

Group 1
Group 2
Group 3
Group 4
Group 5
Group &

Group 7
Group 8
Group 3
Group 10
Group 11
Group 12
Giroup 13

P R R A R AR R A R EAER AR

il

—Deletion Helper:

Delete Selected  [finalized at save]

Delete Man-isible (finalized at save] |

Export Visible Spots to P4P

+

oo

Figure A.15 — A view with all layers selected
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Click Invert Selection (in the “Editing Menu”
(RLATT > Edit) under “Selection Helpers”). All
of the spots that do not touch the layer lines are
now selected.

1

|

Intensity Filter Reflection Size Zoom
!

—Editing T ool

£ Box

% Lattice Dverlay
¢ Single Spot
" Cicle
 Mone [rotate]

—Selection Helper

SelectWeak Reflections |

Select Current Group |

Invert Selection |

i Grouping T ooks
Current Group:

I_GrouM ‘I

Add To Current Group |

Remave Fram Current Group |

=|
o
=]
a

Group 1
Group 2
Group 3
Group 4
Group 5
Group 6
Group 7
Group 8
Group 3

Group 10
Group 11 b
Group 12

Group 13 v
| »

PRIEEAE A LRI EARA KR EARAEARAEY

I

—Select @sihle Groups——————————————————————

i~ Deletion Helper

Delete Selected  (finalized at save) |

Delete MonYisible (finalized at save) |

Export Yisible Spots to P4P

jus|
=
L

Figure A.16 — The selected spots are now the little ones
between the layers. The spots in the layers
are grey and the selected spots are turquoise.
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Click Delete Selected (finalized at save) to
mark the selected reflections to be deleted (and
turned black). Alternatively, these selected
reflections can be added to a group and then
hidden using “Select Visible Groups.”

217

Intensity Filter Reflection Size

Zoom

" Box

—Editing Toal

% Lattice Dverlay
= Single Spot

£~ Circle

" Mone [rotate]

r—Selection Helper.

Select Weak Reflections I
Select Current Group |
Iresent Selection I

r—Grauping Taal
Current Group: Im
Add To Current Group I
Remave From Current Group I

—Select Vigible Groups

NI

v Mone
v [ Group 1

Group 2
Group 3
Group 4
Group 5
Group £
Group 7
Group 8

Group 3

Group 10
Group 11
Group 12

Group 13 X
| »

—Dieletion Helpers

Delete Selected (finalized at save] |

Delete Non-Visible [finalized at save] I

Erport Wisible Spots to PAP

{l: i

Figure A.17 — Selected reflections are blacked out

M86-E01078



APEX2 User Manual

RLATT

Save the file by clicking the disk icon (Figure
A.18) or use File > Save to remove the reflec-
tion from the reflection list. Hiding a group with
“Select Visible Groups” does not remove it from
the reflection list. Either way, the resulting
RLATT image is much cleaner and easier to
interpret (Figure A.19).

te Crystal

Figure A.18 — Save File icon

M86-E01078



RLATT

APEX2 User Manual

Enable the Unit Cell tool to put a colored box in
the view. This allows you to see if reflections are
actually falling on the corners of the box (see
Figure A.19 and Figure A.20). There are multi-
ple options in the Unit Cell tool. “Select a Visible
Plane” displays individual planes. “Select Plane

Mol \HJ\‘ L Ju sl il I. L

Size” determines the boundaries of the planes
and the number of unit cells displayed. Grid
Planes mode displays planes as grids with
spacings determined by the lattice.

Unit Cell Tool (U] = ENABLED

|H |\I|J |H|\|\L“J Ll

s,

1.l

Intensity Filter Reflection Size Zoom

Select Unit Cell Tool Style
€ Planes

€ Giid Planes
€ Single Box
 Layered Box

Select Plans Sizss——————————————————
v —_— —
o—_—

1 10 20

o

Link Sizes = DISABLED |

il [ 3
Figure A.19 — A view of the reciprocal lattice after the non-

fitting reflections were deleted and with the
Unit Cell tool enabled.
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Figure A.20 — A view that zooms in on the Unit Cell tool.
Almost all spots lie on the lines and planes
defined by the unit cell. To the left and right
are two weaker reflections (black dots) that do
not fit.

M86-E01078
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A.3 Defining Groups

Selected reflections can be grouped. This tool is
most useful for examining twinned, split, in-
grown and otherwise problematic crystals. For
Figure A.21, alternate rows were selected with
the Lattice Selection tool. In the Grouping Tools
section of the tool boxes to the right, the current
group was set to Group 1 (red). Click “Add to
Current Group” to turn these rows red. Then, the
other rows and Group 13 (white) were selected

LA B & & & & & & & & & & & & A & & & B & 4 B A A & & & & B & 2 & & B B Invert Selection |

T wvewveewveowewew

LA A & B B B 2 & 2 & & & & 2 2 2 & B 2 2 2 2 2 2 2 2 2 & 2 2 2 2 8 2 2 J

LA 2 B & 2 A 2 A A 2 2 & & 8 2 & B A 2 8 2 2 2 2 2 A 2 2 8 8 A 2 2 A N

Figure A.21 — Reflections selected for different groups

and added. The box tool was used to select the
reflection to the top left and these were put in
Group 3, the yellow group. Finally, some of the
reflections to the top and bottom were selected
and added to Group 5, the blue group. This
example of using the color groups generates a
flag-type display. For twinned crystals, etc., the
groups would be used to denote different com-
ponents (see Figure A.22).

—Selection Helper

Select weak Reflections |

Select Current Group |

r~Grouping T ook
Current Group: G5 T

5dd To Curent Group |

Flamave From Currant Gioup |

—Select Visible Groups

v [ INone
v [ Giroup |
v [ Group 2
v [ 1Gmoup3
v [ Giroup 4
I Group §
I Giroup €
Group 7
[ Group 8
Group 9
Group 10
Group 11
Group 12

v
v
v

Group 13
Group 14
Group 15

- Deeletion Helpers—————————————————

M86-E01078



APEX2 User Manual RLATT

el
Figure A.22 — A more practical use of the selection and color
groupings in RLATT. The two components of a
rotational twin are colored yellow and red.
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A.4 Measuring Distances and
Angles

Right-click on the background and choose Mea-
sure to get tools for measuring distances and
angles.

The Measure Distance tool gives two lines,
much like the lines in the Lattice Selection tool,
that can be oriented and dragged to get lattice
spacings (see Figure A.23). Use the [Alt] key to
lock on spot centers for easier orientation and
more accurate measuring.

R Y SRS R R R R R R R e

Figure A.23 — Using the Measure Distance tool
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With the Measure Angle tool, left-click, hold, and
drag a line on a lattice layer ending on the spot
that will become the vertex of the angle. When
the mouse is released, that point becomes the
pivot point for a new line. Moving the mouse with
no buttons depressed gives angle measure-
ments (see Figure A.24). As described, the
angle measurements will be done in 2D mode

- ww
-
- -

- -
-

- -

T wvwvTve T Teyw

eSSV e w v T T T TS S vVES POy
-

L & B B & & & 8 A & & & & & B B 8 8 & 8 A B & B 5 8 a5

(i.e., the angle between the two lines displayed).
To measure an angle in 3D mode, hold the [Alt]
key while selecting spots as above. The tool will
then lock on to spot centroids and the angle will
be calculated using spot coordinates. This elimi-
nates errors that might result from measuring
using the 2D projection of the current orienta-
tion.

- - -

L
-

'--v*ivr-w——wﬂ-ﬁhﬁtﬁbﬁﬂﬁvﬁt

-
TeSTeSPTeeeswe s Tl eesseeweseew
PP PP RSP SPEEee e
OSSP eSS YTTeYS RS RTESRY

L B B A B R B B & & & B 12 B 8 2 8 2k 2 2 8 8

b
- - R Y T T L T L R R

pr
- - TevewewTPewwwwwww

- L B B & B 8 B & & & & B 2 J
-

Te SRSl wseww
¥
FeewwTewvessww

Figure A.24 — Using the Measure Angle tool
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A.5 Writing a .p4p File

At the bottom of the Edit menu, there is a button
for exporting all visible reflections to a .p4p file.
The .p4p file is a text file of crystal, instrument,
and reflection information. If the cell and crystal
orientation is known, that information is included
also (otherwise, dummy values are included).
The sequence of cleaning up a set of reflections
using RLATT and then exporting the results for
input to CELL_NOW is a useful tool for dealing
with hard-to-index crystals.

M86-E01078



Appendix B Face Indexing

In order to correct intensity data for absorption B.1 Start the Crystal Faces Module
numerically, the crystal’s faces must be indexed.

This allows a very exact crystallographic
description of the crystal’s shape.

1. From the Scale category in APEX2’s Task
Bar, select Crystal Faces.

Once you have a unit cell for your crystal, the
Face Indexing module allows you to define faces
directly over images of the crystal. As you define
more and more faces, APEX2 automatically
determines the dimensions of the crystal.

The examples in this Appendix use a large crys-
tal for which the unit cell has already been deter-
mined.
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B.2 Collect a Video Zip Stream

To index the faces, first collect a video zip
stream, which is a series of images taken with
the video microscope as the crystal is rotated
through 360° about the phi axis.

NOTE: For the best results, make sure that light-
ing conditions are optimal for the crystal
you are viewing. If possible, try to illumi-
nate the crystal for optimum contrast
between the crystal and the background.
Also, it may desirable to use multiple
light sources to illuminate several faces
simultaneously.

hasave ¥ideo File [ 7]
Look in: |‘:_§j C: /Frames/guest/face_indexing_example/ j - 5 ’Ef_ =
B
|5 aligned
) woark

File name: [

Ra | Canicel |

i

File type: I Video Zip Stream [ vzs|

1. If no video zip stream has been collected
for this crystal, a dialog appears prompting
you to acquire a new video zip stream or
load an existing one.

G video Source HE

Specify zource of videa file.

Hieaquire New, LoadExist\ng..l Cancel ||

Figure B.1 — Video Source prompt

2. Because we have not yet taken a video zip
stream for this crystal, click Acquire New.
A save dialog box (defaulted to your current
project directory) appears.

Figure B.2 — Save Video File dialog

3. Click Save. If VIDEO is not open, it will
open with a progress bar showing the video
Zip stream collection. When the video zip
stream is fully collected, the Face Indexing
initial view will appear (Figure B.4).

= |
® ¢lm/E al2]

Acquining videa. ..
[ ] 15%

Figure B.3 — Progress bar
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B.3 Using the Face Indexing

Module

The Face Indexing module uses a dial at the
bottom of the screen to step through the images

of the crystal, and a tool called the T-tool to

define faces. The Face List, shown on the right,
displays the faces you have defined for the crys-
tal and their distance from the instrument center.

;EAPEXZ ¥2.1-RCT - User: {guest) - Sample: face_indexing_example - Licensed to Applications Lab at Bruker AXS - [Crystal Faces]

4 Sample Instrument Yideo Windows Help

lozallea x|

Setup

Evaluate

Collect

Irtegrate:

Scale

Examine Data

7 Show Tael

Man. Milet inder: 2 3

Solve Shucture

Fiefine Stiucture:

Report

Instiument

Mas autof plane angle [degl: [ 5
¥ Show possible face normals

I Snap to possible facs nomals

O Custal Face
= Miller [ndices -
-~ Distance [mm] om
Out-af-plane angle [deg)  0.70

Urit Celk
a=21.354, b=11624. c=H.A04

o=30.00", p=9E B1°, y=80.00" +
W=2205%, Monachinic C

Remove Invisible Faces

Closedt [Ho
Seefmn} foia

Figure B.4 — Face Indexing: Initial View
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ltem Description

Show and hide the T-tool for a better

Show T-tool view of the crystal faces.
Max. Miller The highest Miller index shown as face
index: normals in the overlay.
vy When the T-tool snaps to a face normal,
Nllaar)iéoaur: ?; the plane you define may differ from the
?de ): 9 specified index by a maximum of this
9): amount.

Show possible
face normals

APEX2 suggests face normals.

Snap to possi-
ble face normals

The T-tool snaps to the suggested face
normals.

Dial (or mouse
wheel)

Use the dial to rotate around 360° of
phi. The right-click menu lets you rotate
phi by 180° to define parallel faces.

Crystal face
information

Shows the Miller indices of a given face,
the face’s distance from the instrument
center, and the out-of-plane angle.

Table B.1 — Face indexing controls

ltem Description
Unit Cell Displays the unit cell that APEX2 uses to
display faces in the overlay.
HKL Miller indices of the normal to the specified
" face.
Distance The specified face’s distance to the center
(mm) of the instrument.
Eﬁg%{g Faces obscured by the body of the crystal
Faces are removed from the Face list.
Closed: Displays whether the faces you have
: defined encapsulate a closed volume.
. . Dimensions of the crystal, calculated
Size (mm): according to the defined faces.

Table B.2 — Face list

B.3.1

Depending on the color and reflectivity of the
crystal and background, you may want to adjust
the display colors.

Set View Options

1. Right-click in the image display area and
select Configure Overlay from the menu.
The Overlay Configuration menu appears
(Figure B.5).

:il:lverlay Configuration

 Crystal Edgy

Swfidth: |2 3:

I~ Show backside

—Crystal Facs

Fant size [pt]: [12 3:

I~ Show crystal faces

—Crystal Label

¥ Show crpstal labels

—Microzcop

* oenter [pixels] [297 3:
¥ center [pixelsk [161 3:

Tilt angle [T o =

Figure B.5 — Overlay Configuration menu
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B.3.2 Specify Crystal Faces

1.

Use the dial control at the bottom of the
screen (or use the mouse wheel) to rotate
the crystal until one of the faces is parallel
to the microscope axis as in Figure B.6.
Note that, because Show T-Tool and
Show possible face normals are
selected, APEX2 suggests possible faces
(whose indices are within the Max. Miller
Index parameter) with dotted lines.

Figure B.6 — Face parallel to microscope axis

2.

Move the mouse cursor to the dotted line
that is perpendicular to the face. The
mouse cursor snaps to the possible face
normal.

A line appears to show the possible face.
This line defines a plane along the micro-
scope axis, which should be parallel to the
crystal face. Use the mouse to move the
line until it touches the crystal face.

4. Click to fix the face. An entry appears in the
Face List showing the Miller Indices of the
crystal face, along with the face’s distance
from the instrument center.

Figure B.7 — Face normals

Figure B.8 — Fix the face
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5. Repeat all steps in this section to specify all
of the crystal’s visible faces. If APEX2 does
not suggest a face normal for a certain
face, you can increase the value in the
Max. Miller index field to show more sug-
gested normals.

6. As you define more faces, APEX2 will
begin to display its geometric model of the
crystal, superimposed over the video
images (Figure B.9). Continue until all
faces are defined.

Figure B.10 — All faces defined

Figure B.9 — Some, but not all, faces defined
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B.3.3 Editing the Face List

Consider Figure B.11. The face (1 3 -2) does not Uni Cel
appear to define a face correctly. Removing this DS.Z%‘D%??‘: vt j
face will give a more accurate model of the crys- |V=22|”5’5‘|' onorine I

H [K | L |Distance [mm]

tal.

oo o7
1 oos
1 0zl
1 niz
1 iz
1 o7
0 030
0 0zs
0 032

— B =T N TR )
Lo aloobso

Clear list

Figure B.12 — Face List right-click menu

Figure B.11 — Face (1 3 -2) is incorrect

1. Inthe Face List, select the HKL (1 3 -2).

2. Right-click and select Remove. The face is
removed from the list and the model is
improved (Figures B.13 and B.13).

NOTE: Alternatively, you can select Clear List
to start over, or Add and Edit to define :
your own faces and see where they Figure B.13 — Face (1 3 -2) removed
appear on the crystal.

¢
i
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B.4 Scaling With Face Indices

1.

When all faces are defined, APEX2 has
accurate crystal dimensions (as shown in
the bottom right-hand corner). At this point,
you can exit the Face Indexing module and
proceed with scaling.

In the Scaling module, be sure to select
Numerical Absorption Correction (From
Face Indices) under the Setup tab (see
Section 7.3.1).
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CELL_NOW is an extremely powerful tool for
determining unit cells for difficult crystals. It ana-
lyzes a list of reflections to find a cell and orien-
tation matrix despite the presence of several
twin domains or other problems.

In initial search mode, the program tries to find
sets of reciprocal lattice planes that pass close
to as many reflections as possible. The corre-
sponding real space vectors are sorted on a fig-
ure of merit (1.0 being a perfect fit). After the
vector list has been output, CELL_NOW
attempts to suggest a suitable cell. This will not
necessarily be the conventional cell, so it should
be checked using XPREP.

Once a cell is found, it may be rotated to locate
further twin domains iteratively using only the
reflections that have not yet been indexed.

If CELL_NOW fails to suggest a sensible cell,
either something is seriously wrong with

the reflection list (e.g., a wrong detector dis-
tance) or a cell axis is longer than the given
search range.

C.1  Running CELL_NOW

CELL_NOW must be run from the command
line. It requires a list of reflections exported from
the APEX software (a .p4p file).

1.  Open a Command Prompt window.

2. Change directories to the folder containing
the exported reflection list.

3. For Windows or Linux, enter the command:
cell_now

After the command is entered, the terminal will
print out an explanation of the program. Read

this as it has useful information about what the
program is doing:
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CELL_NOW analyses a list of reflections to find a cell and orientation matrix
despite the presence of several twin domains or other junk. In initial search
mode the program tries to find sets of reciprocal lattice planes that pass
close to as many reflections as possible. The corresponding real space vectors
are sorted on a figure of merit (1.0 would be a perfect fit). In the output
these are followed by the percentages of reflections that fit within 0.1, 0.2
and 0.3 times the interplanar separation, the components al, a2 and a3 of

the vector, the angles to previous vectors and a cross figure of merit to
previous vectors. The latter should be larger for reflections belonging to
the same twin component. Cosines of angles between vectors a and b can also
be calculated from the components by (al*bl+a2*b2+a3*b3)/(a*b).

After the vector list has been output, CELL_NOW attempts to suggest a suitable
cell. This will not necessarily be the conventional cell, so it should be
checked using XPREP (without an .hkl file) taking the lattice type found with
CELL_NOW into account. If necessary this conventional cell may be reinput in
"specified cell” search mode to find the orientation matrix. 1T CELL_NOW
fails to suggest a sensible cell, either something is seriously wrong with

the reflection list (e.g. a wrong detector distance) or a cell axis is longer
than the given search range.

In specified cell search mode the program tries to find the best cell within
the specified ranges. The reflections that fit this cell within a specified
fraction of all three interplanar spacings may be flagged as indexed, and a
new .p4p or .spin file written in which they have the "H" flag so that they
can be displayed in a different color with RLATT. Then the cell may be rotated
to locate further twin domains iteratively using only the reflections that
have not yet been indexed.

** WARNING: the exhaustive search employed in this program is VERY SLOW **
** s0 a CPU clock frequency of AT LEAST 3GHz is strongly recommended *x
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4. CELL_NOW requests the name of the input file and suggests a name for the output file. Enter the
name of the input file (For the output file, press [Enter] to accept the default).

Full name of .p4p, .spin or .drx file to read: example.p4p
999 reflections read in

Listing file [example._cn]:

514 reflections read in
Listing file [example._cn]:

5. Press [Enter] to start a general search.

Initial search (<Enter>) or specified cell search (S):

6. If the default superlattice threshold is suitable, press [Enter].

Superlattice threshold: an axis will be rejected if less than this percentage
of reflections has indices not equal to 2n or 3n resp. [10]:

7. If the default minimum and maximum distances are acceptable, press [Enter] again.

Minimum and maximum allowed values for cell edge [5 40]:

NOTE: Usually CELL_NOW is used to search generally for a cell, but if the cell is known, choose the
specified cell option and enter the cell dimensions. CELL_NOW will then search for a matching
cell.

After some period of time, a list of real space vectors sorted on a figure of merit (1.0 being a perfect fit)
will be output. These are followed by the percentages of reflections that fit within 0.1, 0.2 and 0.3 times
the interplanar separation, the components a1, a2 and a3 of the vector, the angles to previous vectors
and a cross figure of merit to previous vectors. The latter should be larger for reflections belonging to
the same twin component. Cosines of angles between vectors a and b can also be calculated from the
components by (a1*b1+a2*b2+a3*b3)/(a*b).

M86-E01078 C-3



Using CELL_NOW

APEX2 User Manual

Length, fom, #hits, %(0.1), %(0.2), %(0.3), components
Followed by angle/correlation to previous vectors:

12.692 0.902
11.016 0.891

90.0
0.798

16.802 0.836

139.0 131.0
0.754 0.755

16.805 0.819
139.1 49.1 81.9
0.749 0.739 0.688

27.693 0.741
23.4 66.6 162.4
0.675 0.657 0.638

27.701 0.736
156.6 66.6 64.4
0.687 0.659 0.620

25.428 0.722
119.9 150.1 19.1
0.651 0.674 0.638

18.381 0.688
89.3 127.1 67.3
0.596 0.605 0.556

6.329 0.686
179.9 90.1 40.9
0.574 0.573 0.532

14.648 0.684
89.1 90.3 90.5
0.591 0.603 0.556

30
20

24

25

19
115.7
0.616

43
17.5
0.645

45
101.0
0.600

35
113.8
0.544

4
41.0
0.524

18
90.9
0.539

94.493 99.999

99.098

93.793

90.189

80.379

78.477
133.2
0.569

77.376 98.497

143.3 83.5
0.557 0.533

99.698

99.398

99.498

93.692

92.091

99.999
99.899

99.698

99.899

98.898

97.296

99.598

72.271 86.285 91.791

103.2 104.5 58.9
0.480 0.484 0.487

65.465 65.465 65.465
156.7 23.5 60.0 90.7
0.459 0.469 0.465 0.426

73.873 85.484 91.090
89.3 90.9 90.2 36.8
0.475 0.477 0.490 0.539 0.424

-0.475
0.491

-0.011

0.953

-0.446

1.396

-0.496

-15.128

0.248

-14.633
91.1

5.493
-9.912

4.417

-15.402

1.111

-20.915

14.332

9.256

-2.729

-0.652

-11.

16.

=-27.

18.

20.

432

.782

211

.654

668

109

999

.827

.705

.025
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After the vector list has been output, CELL_NOW attempts to suggest a suitable cell. This will not nec-
essarily be the conventional cell, so it should be checked using XPREP (without an .hkl file) taking the
lattice type found with CELL_NOW into account. If necessary, this conventional cell may then be input
in 'specified cell' search mode to find the orientation matrix.

The following cells would appear to be plausible, but should be checked using

XPREP because they are not necessarily the conventional cells.

FOM, % within 0.2, a..gamma, volume and lattice type for potential unit-cells:
11.000 85.3 12.692 11.016 14.648 89.70 90.95 90.00 2047.7 P

Cell for domain 1: 12.692 11.016 14.648 89.70 90.95 90.00

Figure of merit: 0.619 %(0.1): 68.3 %(0.2): 85.3 %(0-3): 91.0

CELL_NOW has identified a domain that fits 85.3% of the data with a tolerance of 0.2.
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The output shows a suitable cell with its orientation matrix, figure of merit and the deviations of the input
reflections from integer indices. This deviation is used to determine which reflections fit this cell and
which are left for further searches for new domains.

Orientation matrix: 0.00164338 -0.00357404 -0.06816319
-0.03417112 0.08170117 -0.00385047
0.07098872 0.03940338 0.00098036

Maximum deviation from integer index [0.25]:

8. Enter the maximum deviation from integer index cutoff (Typically the default is reasonable). Press
[Enter].

Percentages of reflections in this domain not consistent with lattice types:
A: 50.1, B: 49.9, C: 45.0, 1I: 48.9, F: 72.5, 0O: 64.3 and R: 65.8%

Lattice information (given as % of relevant reflections that do not fit a particular lattice) should be used
in XPREP to determine the conventional cell. Typically, for a lattice to be present the % inconsistent
should be less than 10, but problem crystals can make the value higher.

Percentages of reflections in this domain that do not have:
h=2n: 36.3, k=2n: 49.8, 1I1=2n: 49.3, h=3n: 69.1, k=3n: 67.2, 1=3n: 66.4%

This percentage information is useful for identifying supercell problems. Typically, the percentages
should be 30% or higher for the 2n values and 50% or higher for the 3n values, but problem crystals or
crystals with heavy atoms in special positions can make the values lower. Low values for a particular
class of reflections can suggest that an axis is double (2n) or triple (3n) its correct length.

New cell from list (number), reorientate (R), accept (A) or quit (Q) [A]l: A
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9. Enter A orjust press [Enter] to accept this cell. The program asks for a name for a .p4p file. Enter
the name of the .p4p file for this solution (in this example, domain1.p4p).

-p4p or _spin file to write domain to: domainl.p4p

RLATT color-coding employed in file: domainl.p4p
White: indexed for first domain
Red: not yet indexed

877 reflections within 0.250 of an integer index assigned to domain 1,
877 of them exclusively; 122 reflections not yet assigned to a domain

122 reflections, approximately 1/10 of the data, have not yet been indexed (assigned to a domain). This
is more than might be expected for random noise peaks. A search for an additional domain makes
sense. The domain 1 cell will be rotated to locate further twin domains iteratively using only the reflec-
tions that have not yet been indexed.

Re-refine initial cell (R), search for next domain (S), quit (Q) or choose
new cell from list (enter number) [S]: S

10. Enter S to search for another orientation of the newly chosen cell.

Cell for domain 2: 12.692 11.016 14.648 89.70 90.95 90.00
Figure of merit: 0.643 %(0.1): 69.7 %(0.2): 97.5 %(0.3): 98.4

Orientation matrix: 0.00598966 0.00402327 0.06807401
-0.03367313 -0.08180340 0.00480114
0.07099302 -0.03914713 -0.00221035

Rotated from first domain by 179.7 degrees about
reciprocal axis 1.000 0.001 -0.032 and real axis 1.000 0.002 -0.010

Twin law to convert hkl from first to 0.999 0.004 -0.019
this domain (SHELXL TWIN matrix): 0.003 -1.000 -0.004
-0.064 0.006 -0.999
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CELL_NOW has identified an additional domain that fits 97.5% of the data with a tolerance of 0.2. The
relationship between this domain and the first domain and the SHELXL TWIN matrix are reported. This
example is for a rotational twin about the a* axis.

The output shows a suitable cell with its orientation matrix, figure of merit and the deviations of the input
reflections from integer indices. This deviation is used to determine which reflections fit this cell and
which are left for further searches for new domains.

11. Enter the maximum deviation from integer index cutoff (typically the default is reasonable).

Maximum deviation from integer index [0.25]:

12. Enter the name of the .p4p file for this solution (in this example domain2.p4p).

-p4p or _spin file to write domain to: domain2.p4p

RLATT color-coding employed in file: domain2.p4p
White: indexed for first domain

Green: current domain (but not in a previous domain)
Red: not yet indexed

691 reflections within 0.250 of an integer index assigned to domain 2,
119 of them exclusively; 3 reflections not yet assigned to a domain

Re-refine initial cell (R), search for next domain (S), quit (Q) or choose

new cell from list (enter number) [Q]

13. Enter <g> to exit CELL_NOW.
C:\struc\guest\twin>

NOTE: At this point CELL_NOW has indexed a two-component twin. The orientation matrices for the
two components are in the domain2.p4p file discussed below.
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C.2 CELL_NOW output

In this example, in addition to the terminal output described above and the example._cn listing file writ-
ten to disk, CELL_NOW has written two .p4p files, domain1.p4p and domain2.p4p. The second of these
is a multicomponent .p4p for a two-component twin. It is shown below.

The following entries appear twice: once for each domain.

CELL, ORT1, ORT2, ORT3, ZEROES, ADCOR
CELL2, ORT12, ORT22, ORT32, ZEROES2, ADCOR2

This will eventually trigger SAINT to treat this data set as a twin.

FILEID SAINT V6.43A 4.00 06/19/03 09:36:24 mraa
SITEID RufM Ruf

TITLE [RCpCrCI2.nTHF]n

CHEM  C40H58Cr2C1402

CELL 12.6918 11.0161 14.6480 89.7011 90.9494 90.0010 2047.695
CELLSD 0.0025 0.0022 0.0029 0.0300 0.0300 0.0300 1.024
ORT1 0.001643376 -0.003574040 -0.068163186

ORT2 -0.034171116 0.081701167 -0.003850471

ORT3 0.070988722 0.039403379 0.000980361

ZEROS  0.0000000 0.3249754 -0.0041494 0.0000 0.0000 0.0000

ADCOR 2.9302 -0.0047 0.0003 -0.8959 0.0123 0.0937
CELL2 12.6918 11.0161 14.6480 89.7011 90.9494 90.0010 2047.695
CELLSD2  0.0025 0.0022 0.0029 0.0300 0.0300 0.0300 1.024
ORT12 0.005989663 0.004023272 0.068074010

ORT22 -0.033673126 -0.081803404 0.004801138

ORT32 0.070993021 -0.039147127 -0.002210349

ZEROS2 0.0000000 0.3249754 -0.0041494 0.0000 0.0000 0.0000

ADCOR2 2.9302 -0.0047 0.0003 -0.8959 0.0123 0.0937
SOURCE Mo 0.71073 0.70930 0.71359 2.00000 50.00 40.0
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NOTE: SAINT+ users should be aware that APEX2 Version 2 can import .p4p files created with
CELL_NOW and the Integrate Images module will handle the multiple orientation matrices cor-
rectly. There is no longer a need to use the standalone SAINT+ program.
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The APEX2 Suite includes the ability to custom-
ize many features of the program. Most customi-
zations should be left to the site administrator,
but some introduction is appropriate. The exam-
ple below is a color-coded example of an actual
Python file. It gives an introduction to configur-
ing the program.

The following is a collection of examples of pos-
sible changes to the configuration files for
APEX2 and PROTEUM2. These files control the
look and feel of the GUI.

D.1  Gilobal, User, and Sample-spe-
cific Variables

Configuration variables the system administrator
wants to set globally for all users go into a file
called bn-config.py that resides in C:\ for Win-
dows or /usr/local/lib for Linux.

Individual users can set their own preferences
for most configuration variables in a file in their
home directory. This file is named bn-config.py
for Windows and .bn-config for Linux (Under
Windows, at a command prompt type echo

%UserProfile% to find out where the user ver-
sion of bn-config.py should be located.)

Additionally, configuration variables can be set
for a specific sample using a file in the sample
directory. This file is bn-config for Windows and
Linux.

These files are read in the order given above, so
values set globally are replaced by individual
values and global and individual values are
replaced by sample-specific values.

D.2 Python Code Examples

In the following text,

e Red denotes comments that result from #
comments.

e Green denotes comments between triple
quotes (IIIIII).

¢ Black denotes actual Python code.

# Examples of configuration changes-
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A few notes about Python comments.

Three quotation marks in a row on a line (““) start a comment section
The next three quotation marks (““) end the section

The text you have just read is in a comment section

#end of commenting out a section with triple "'s

# Pound or Number starts a simple comment. This can be anywhere on a line.

#

#

# The default color scheme for the image display:

#

colorramp="'Colored_SCD.ICM' # This is the typical BAXS orange display
#

The most frequently used other color choices are:

Black_On_White_SCD.ICM
White_On_Black_SCD.ICM
The_Blues_ANY.ICM

Other color ramps are in:

Windows: C:\bn\src\guilintensitycolormaps
Linux: /ust/local/bn/src/gui/intensitycolormaps

#
# This is how user positions can be defined:
#
userposi=
{'name':'Zero @dx60','type": 'n',

‘dx": 60.0,

‘theta': 0,

‘omega’: 0,

‘chi': 0,
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‘phi': +0.0 }
#
#If you want angles other than zero, the import projtls and del projtls must be used:
#
import projtls
userpos2=
{'name':'Chi45@dx90','type": 'n’,

'dx": 90.0,

'theta': -10.0*projtls.degrees,

‘omega': -5.0*projtls.degrees,

‘chi': 45.0*projtls.degrees,

'phi': 180.0*projtls.degrees }
del projtls
#
# Acceptable CCD temperature:
#
ccdtemperaturerange=(-65,-55)
#
# Auto connect to the instrument when needed:
# (This is a protected variable that is controlled by the System Administrator)
#
autoconnect=1
#
# The following five values define matrix runs:
#
perpendicular_matrix_runs_2theta=30
# Set the 2-theta for the matrix measurement:
perpendicular_matrix_runs_distance=41
# Set the detector distance for the matrix measurement:
perpendicular_matrix_runs_nr_sweeps=3
# Do three sweeps or runs:
perpendicular_matrix_runs_sweep=6
# Each run will be 6 degrees long.
perpendicular_matrix_runs_frametime=None
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# The frame time is left to be the default.
#

# Setup to get some debug messages for scans. This is useful if resume is failing.

#

#debug=('goniometer.scan',)

#debug=('expt.findresolution’,)

#

#

# Hardware profile used by the data collection strategy planner:
bishost='bruker-server'
hardwareprofile='Kappa-APEX-ll-euler.hrd'
#bishost='smart-apex'

#hardwareprofile="SMART-APEX-Il.hrd'

#

#

# IP address or DNS name of the file server used for storing images,
# followed by the name of a network shared folder on that server.

# Add additional path segments as comma-separated and quoted strings.

# To find out the DNS name:

# For Linux type:  hostname at the command prompt

# For Windows type:  echo %computername%  at the DOS prompt.
#

fileserver=('x8-client','frames')

# Supported file name protocols. Currently these are 'smb' for

# files that are accessed over a MS Windows network and 'file' for
# local files.

universalfnprotocols=('smb',file")

#
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Configuration of the APEX & PROTEUM programs

The appearance and working of this suite of programs

can be modified by a configuration file. The programs read the

a series of configuration files in following order. As described below, a
specification in a later file

overwrites a setting in an earlier file.

On unix these files are:
1 a file /usr/local/lib/bn-config.py
2 a file .bn-config in your home directory (Please note
the initial "." character, which renders this file invisible
for the normal "Is" command).
3 a file bn-config in your current directory.

On Windows these files are:
1 bn-config.py in the "SystemDrive" folder
2 bn-config.py in the "USERPROFILE" folder
3 bn-config in the current folder

IT none of these files is present (the situation when the program has
just been installed) all parameters are using built-in defaults. To
change a single configuration parameter, creates or edits

one of the three files and put in a value for the parameter

to be customized.

You should put a parameter in (1) if it should be the system default for
all users; put it in (2) if it is your own default, and other people might
want to use other values; put it in (3) if it is only required for a single
project.

The configuration files are read as "Python" programs, and therefore
syntax is very important. The best way to use it is to only use

variable assignments or function calls, as described below. If required,
you can comment out lines from your configuration file by preceding them
with a *#” character.
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Note:

- Leading space is significant. Start all assignments in the first column.
- Variable names are case sensitive.

Functionality groups

Sometimes a complete group of options need to be changed to get
a specific functionality. For these cases there are function calls
that change a number of variables at once.

Due to the "default-like" nature of these function calls, they should
probably be used only in the site-wide configuration files, and even
there only at the beginning [but this is not enforced].

The available functions are:

default_protein()
This switches from the default "small molecule' parameters to more
protein-like parameters. At this time, the following parameters are
set:
chiralonly=1
autochiralpointgroup=1
resomode=1
resolution=2_5
default_noprotein()
This sets the defaults back to small molecule values
The following variables, in alphabetic order, can be set in a configuration file.

* anglemargin, type=floating point, default=1.0
Do not change

* autochiralpointgroup, type=boolean, default=0
This selects whether point groups are preferably chiral. This can be useful in a
protein setting.
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* autoconnect, type=boolean, default=0
If this is set to 1, the connection to the BIS server will be created
automatically without user-intervention whenever required. This variable
can only be changed in the system-wide configuration file (see
”protectedvariables™)

* axcrit, type=floating point angle, default=0.2 degrees
This is the criterion used by the automatic cell reduction algorithm to decide
whether two axes coincide. Do not touch.

* badcolor, type=tuple of three integers, default=(255,190,190)
Color in the GUI that is associated with “bad” situations

* busycolor, type=tuple of three integers, default=(240,240,96)
Color in the GUI that is associated with “busy”’ situations

* bgdone, type=tuple of three integers, default=(96,240,96)
Color in the GUI that is associated with “done” situations

* bgerror, type=tuple of three integers, default=(240,96,96)
Color in the GUI that is associated with ’error’ situations

* bgimpossible, type=tuple of three integers, default=(240,240,96)
Color in the GUI that is associated with “impossible” situations

* bgpossible, type=tuple of three integers, default=(96,240,96)
Color in the GUI that is associated with “possible” situations

* bgtodo, type=tuple of three integers, default=(96,240,96)
Color in the GUI that is associated with *todo” situations

* bgwarning, type=tuple of three integers, default=(240,240,96)
Color in the GUI that is associated with “warning” situations

* bishost, type=string, default is not set
The name or IP address of the BIS server computer
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* ccdtemperaturerange, type=tuple of 2 integers, default=(-65,-35)
Acceptable range (minimal,maximal) of temperatures in deg C for the detector.
This is used only to indicate a red or a green status light for the CCD
temperature in the status window.

* chiralonly, type=boolean, default=0
IT set to 1, only chiral point groups will be used at any moment. Do not touch.

* colorramp, type=file name, default="Colored_SCD.ICM’
Default color ramp used by the image display tool

* communicationlog, type=file name, default="communication.log’
File name used for logging all communication between application and BIS. If not
set, no logfile will be kept.

* componentlcolor, type=string (color name), default="green”
The component#color variables are obsolete. Use groupcolors instead.

* component2color, type=string (color name), default="blue”’
The component#color variables are obsolete. Use groupcolors instead.

* component3color, type=string (color name), default="yellow”
The component#color variables are obsolete. Use groupcolors instead.

* datcoldx, type=floating point, default=35.0
Default sample-to-detector distance for data collections.

* dbtype, type=string, default="postgresql”’
Type of database engine used. Do not touch.

* dbhost, type=string, default="127.0.0.1"
Name or IP address of the server running the database. The default is to
run the database on the same host as the rest of the software, hence the
default that refers to the local host.
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* dbport, type=string, default="5432"
IP port to use to address the database. Normally dependent on database
installation.

* dbname, type=string, default="BAXSdb~
Name of the database. Do not touch.

* debug, type=tuple of strings, default=()
This is a list of all modules that are to be debugged. This should
not be touched except if a developer asks you to add something here to
help track a problem.

* defaulthardwaretype, type=integer, default=4
IT different hardware types are supported, this can be used to select which one
should be used. 4=BIS. Do not touch.

* detectorsizemargin, type=floating point, default=0.1
Do not touch.

* eventlogfile, type=file name, default="bn-event._log’
File in which important events are logged during program runs.

* fontsize, type=integer, default=None
GUI font size in points

* groupcolors, type=tuple of color names, default=("gray75’,
red’,’green’,’yellow’,”blue”, magenta’,’cyan’,’white”,
gray25”,”brown”,”forest green’,
khaki”,’midnight blue”,”violet”, turquoise’, ’gray50”)

* guicolor, type=tuple of three integers making a color, default=0xd4,0xd0,0xc8
Overall background color of user interface.

* guistyle, type=string, default="windows~
The style of the GUI. Do not touch.
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* hardwareprofile, type=file name, default=None
The hardware profile to be used by COSMO for strategy calculations.

* hashfilepattern, type=string, default="_## ####>
Do not touch

* headerdisplay, type=?, default=not set
If present, this variable defines the name of a file containing the default image
header items that should be displayed in the table underneath the image display.

* imageextension, type=string, default=".sfrm’
Do not touch

* imagemask, type=int,default=0
value of a mask used in viewing powder frames

* inhibitgc, type=boolean, default=0
Inhibit garbage collection. Do not touch.

* localfilemap, type=map, default=None
A map of network drives, translating local file names to equivalent network
names. On Windows machines, this is set automatically. On unix, this should
represent a copy of the relevant parts of the samba configuration.

* lowcurrent, type=floating point, default=5
Tube current in mA to set when an experiment finishes.

* lowvoltage, type=floating point, default=20
Tube voltage in kV to set when an experiment finishes.

* mailfrom, type=string, default=Not set
The "From" address of E-mails sent by the software (e.g. bug reports).

* mailfromdomain, type=string, default=Not set
The domain of the From address of E-mails sent by the software. This will only be
used if ““mailfrom”” is not set. The user name will be pre-pended.
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* matrixstrategy, type=list of scans, default=3 specific scans
The measurement strategy that is to be used to find a unit cell.

* minimalpowerfraction, type=floating point, default=0.5
The minimal generator power as fraction of the maximal power that will be
considered as sufficient to make a measurement

* mosaicity, type=floating point angle, default=0.4
Expected normal width of a reflection, in degrees.

* nominalpowerfraction, type=floating point, default=0.9
The normal generator power as fraction of the maximal power that the generator
should be set to before a measurement

* nominalvoltage, type=map, default={"MO”:60,>CU”:45,”AG”:60}
A definition of the nominal tube voltage in kV as a function of the
target element.

* orientdx, type=floating point, default=-5
The default crystal to detector distance for the “aligned images” module. IFf
given as a negative number, it is counted from the back of the dx-sled.

* orientdegreetime, type=floating point, default=10.0
Default scan time in seconds per degree for an aligned image.

* orientscanwidth, type=floating point, default=5.0
Default scan angle in degrees for an aligned image.

* overlapcolor, type=color string, default="red”
Color used for overlapping predicted spots

* overlaycolor, type=color string, default="green’
Color used for predicted spots

* peakradiusfactor, type=floating point, default=2.2
How many times the single-sigma-spot radius should be used as integration radius.
Do not touch.
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* planes, type=string, default="0kl hOl hkO~
List of precession planes that is suggested as default planes for the
calculations

* planethickness, type=floating point, default=0.1
Default thickness of precession images

* precessionmargin, type=integer, default=1
How many pixels at the outer edge of the detector that is to be ignored in
precession calculations

* prefereulerian, type=boolean, default=1
1 = prefer eulerian geometry over kappa geometry
0 = prefer kappa geometry over eulerian geometry
This should not be changed after installation.

* preferreddirection, type=integer, default=-1
(default rotation direction of axes)

* productline, type=string, default="ANY~
A selection of the features in the program suite based on the type of
application we’re running:
>ANY” or ”ALL” = all products,
”SCD” single crystal,
*XRD” powder,
>XRF” = Fluorescence

* protectedvariables, type=map, default={’protectedvariables”:1,”autoconnect”:1}
A selection of variable names and a limit to which configuration files can be
used to change them. This can be used to make sure users do not overwrite system
defaults, like is done by default for the autoconnect variable.

* resolution, type=floating point, default=0.77
Default resolution to go for in an experiment. 0.77 is reasonable for standard
small-molecule experiments.

D-12 M86-E01078



APEX2 User Manual Configuring APEX2

* scanrepr, type=integer, default=-1
Determines how scans are represented in text:
-1: scan angle from x to y length y-x
0: scan angle length y-x starting from X
1: scan angle from x to y

* scanwidthtolerance, type=floating point angle, default=0.003
Tolerance in degrees that determines whether two scans are equal. Do not touch.

* fileserver, type=tuple of strings, default=()
Where experiment data files should be stored by default. First element in the
tuple is the host name, second the share name, and the rest are successive
folder names inside the share.

* fileserverprotocol, type=string, default="smb”
The protocol that should be used to address the file server. Should be either
>file” (local file) or ”smb” (network drive)

* smbroot, type=string, default="/smb”
Unix only. Where samba will mount shares made available from other hosts.

* smtphost, type=string, default="localhost”
Host of a machine that can be addressed via SMTP to send E-mails.

* statuslines, type=integer, default=1000
Maximum number of lines displayed in status window

* temperaturerampspeed, type=integer, default=240
The speed to use for ramping the temperature of a low-temperature device, in K
per hour.

* universalfnprotocols, type=tuple of strings, default=Csmb”,’file”)
Allowed protocols to exchange files with the BIS. Should be
(C’smb”,”file”) when BIS is running on the same machine, and (’smb”,)
if BIS is running remotely.
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* userposl, type=scan, default=Not set
User-defined instrument axis position. See the example on page D-2.

* userpos2, type=scan, default=Not set
User-defined instrument axis position. See the example on page D-2.

* userpos3, type=scan, default=Not set
User-defined instrument axis position. See the example on page D-2.

* userpos4, type=scan, default=Not set
User-defined instrument axis position. See the example on page D-2.

* calibweaklevel, type=integer, default=10
Minimal 1/sigma for peaks to be used in calibration routines.
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